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SECTION I - INTRODUCTION TO BASIC JOB ESTIMATING

System Login

A\ System Login &3
User Name: [w]
Password:

|/| Save Password

o ] [cewe |

This is the First Dialog box you see when you enter the application. At this time you are required to enter an existing
User Name and Password to gain access to the program.

User Name

First time Users should login using Admin for both the user name and the password. This makes it easier to copy and
insert in the password field. Either Estl or Est2 can also be used, the password again being the EXACT SAME AS THE
USER NAME. The User Est2, is a power User with enhanced window set-ups.

NOTE: The User Names available may vary based on the estimating product you use.

Password
The Login window also requires a password. For your first login, your password is the same as your User name (Admin,

Estl, Est2, etc.) To change your password and/or to set up a new User, refer to Section Il, Security. Once the Password is
entered, click on the OK button.
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STEP 1-JOBS

Jobs Screen

Actve (12} | nacave (25

43 Joia (45) | Commercial (Y1)
Bd Stus

| eustrial 31 | Readantial (1) | Puskc wonks (1) | 2608 is) | 2008 (4 | 2010 (1)

WA
MCCORMICI(™—

Joo Name Badus ||BaTime || Setires || PrcePe Cead Eatratss
Sques F

CPreT T — N Adrm 2 .
Samgle Jab ABS Asmin
145 Yoent Bonlen Sorw aten = Procams 01152010 10 AM s s Adrmn
CAD Dem Al
Paterson Wansfactung Martn Larson
Thed Natens! Secirtes John Ebwgod
Feo Ly vhas 1AM 2 82261 Con hetaon
Behien be War R a s10.3¢ Dos Varrical
Grewr Powar Systers, e Lot 1 Q SN M D& Wclagherty
8 Sas Engneermy = Pracess Mary Jacketaon
Eksaom Catée Eysiens Martn Larsor
Captsl Supply Company Joe Creton <
Decrer Desige Cenlar Teos Jeteraon 6
Flemwning Vanufacteng John Ewaod 1w
Noore Oifice Complex Todd Jetterson 1]
Trage Caremurcal Offces Marmn Larsan "
Jabnsao Expreas won M $101,396 65 $128€ ES Jones 2
Carison Construction Lon Chernisk bl
weCman Sutng Syatere Mary Jacksbaen 2
Sucaard Sysiens e = Process 1™ $73537255 31479 B@ NcCagheny 23 DO
Deaz'y Uaderground Systems Joe e. 2¢ S«W
Fral Nalonsl Bark " R TN Y $1210 E —
PEPRTVPEPRIES . - s Close

The Jobs window opens itself when you start the application. If you need to open a job after the initial start-up of the
software, you can come back to the Jobs window via the Jobs tab and Jobs icon in the ribbon, or the Jobs toolbar button.
Initially, you select a job from the Active or All Jobs list, which appears on your screen by highlighting it with the mouse
or arrow keys, then click on the option you would like to perform. [Open, Details, Delete, Backup, Restore or Select a Tab
in the “Move Jobs to Tab” pull down]. Or begin an entirely new job by selecting New Job.

*For further details on the Job Screen, refer to Section 11, Jobs
NOTE: The Template Jobs and number of jobs available may vary based on the estimating product you use.

Job Detail Fields
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This is the Job Information window. Navigate through the Job Detail information using the tabs located at the bottom of

the form. There are several information boxes you need to pay attention to when adding a new job in the Jobs Information
window.

1. The field names that appear in the left hand column are default field names, and may be customized to fit any
field name or information you want. *See Set-up. The field names Job Name, Job #, Bid Date, Contractor Name,
and Contractor Telephone are proprietary and cannot be edited.

2. Fillin the fields on the right hand column with information pertaining to the current job. This information can
appear on various Reports & Forms throughout the program (i.e., “ Extension & Bid Summary reports”) if set-up
to do so by the program (Job Name, Bid Date, Contractor Name, and Contractor Telephone) or by the individual

User (merge fields in Export or Proposal). Otherwise, the data will remain here as a reference source for future
use.

Notes

This is the place to enter special notes about the job and/or contractor preferences, special instructions about the job, or

any other job specific information you want to keep handy. These notes appear in the first section of both Extension and
Bid Summary reports.

Jobs (contd.)
Users
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v e L — e 1 o

Use this screen to control ST which Users have access to the
current job. The Userthat = : started the job is automatically
assigned Lead Estimator e 52 status.

Available Users - (1) This Area in the upper left shows a list
of available Users to select \ s for the job. Before any User with a

security level other than =— N ous Administrator can perform takeoff
on a job, you must move ~ that User to the “Active Users on
Job” list on the right side of this window. If you need to add Users to the system, refer to Section Il, Security.

Lead Estimator — (2) Use the pull down arrow in the field on the upper right side of the window to change the Lead
Estimator for the job. Lead Estimator status is automatically assigned to the person who starts the job. The Lead
Estimator can be changed at any point during the job. For example, you might need to pass estimating responsibility from
one User to another during vacations or employee changes. However, this feature is security-limited to only the Users
who have Administrator security access, or the original Lead Estimator.

Active Users on Job - (3) This information box displays a list of Users who have access to the current job and/or have
performed takeoff.

Inactive Users on Job — (4) After a User has performed takeoff, you might want to inactivate the User to eliminate their
access to this particular job. Inactive Users are still part of the job in terms of their previous takeoff, but they are locked
out of current access to the job.

Directories

10
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The Directories tab doesn’t allow any editing. It simply shows where and how the program was originally installed. Very
handy when it comes time to do backups or otherwise manipulate your program.

4 Paste From Job :
Paste from Job ;

Paste From Tab: Paste From Job:
Active v | |Sample Job Electrical v

[_] Labels
v Labor Categories

Paste

[V Job-Specific Parts (Temps)
|__ Job Details
[ Takeoff and Drawings

[without Drawngs)  (With Diawings) Default
|v! Extension Reports
| Bid Summaries ]

[ Extension Data

Paste from Job makes it possible to keep several default jobs on your system as templates for new jobs, or allow pasting
from a past job that is similar to the one you are starting. When you start a new job, you can use one of these jobs as the
source of the takeoff labels, temporary database, etc. For example, maybe you would like the extension reports from the
Template Job & the Bid Summaries from a job you created last week. Simply select the job you would like to copy from,
choose which portion you want, and Click the Paste button.

Paste From Tab
This pull-down lets you choose from any of the Tabs you have setup in the Job Screen. The default is the Active tab, but
could be any Tab including Inactive. Some Users actually create a special Tab just for template jobs.

Jobs (contd.)

Paste From Job

This pull-down lets you select the job you’re going to paste FROM. Clicking on the arrow to the right of the field can
access a pull-down list of all available Jobs for the current Paste From Tab you are using. You can also sort through the
list by highlighting the field and typing in the job name you are looking for. Note that the process is very specific. You
must type the name exactly as it appears in the job list, including spaces and spelling, or it won’t be found. Each time you
start a new job, the Paste From Job: line will be the last job you pasted from.

Paste Labels

Select this option to paste Labels from the selected job. The takeoff labels organize the job into ‘systems’ of breakouts.
Jobs can be organized according to sheet numbers, floors, buildings, alternate bid packages or combinations of these.
There are as many ways to organize a job, as there are estimators. You can only paste Labels to your job before any
takeoff is performed.

11
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Paste Labor Categories*

Select this option to paste in Labor Categories from the selected job. These are multipliers that apply to the labor in the
permanent database based on task difficulty. You may only paste Labor Categories to your job before any takeoff is
performed.

Paste Job-Specific Parts*

Select this option to paste in Job-Specific Parts (also known as the ‘temporary database’) from the selected job. The
temporary database for a job contains items & assemblies that are unique to that job. The ‘temporaries’ may include a
simple fixture list, special materials that are used on certain kinds of jobs or assemblies that are used one time only. Some
people have been known to takeoff entire estimates from the temporary database only. You may only paste Job-Specific
Parts to your job before any actual takeoff is performed in that area of the job.

Paste Job Details
Select this option to paste in Job Details from the selected job. Please note this will also replace your current Job name.

Paste Takeoff and Drawings
Select this option to paste in Takeoff from the selected job. When pasting Takeoff, you have two options, to Append
(Without Drawings) to takeoff or Replace (With Drawings).

¢ If you have takeoff and want to keep it, select Append. This will ADD the takeoff from the selected job to the
takeoff you’ve already performed.

e Ifyou haven’t done any takeoff for a job, or you would like to overwrite the current takeoff select Replace (With
Drawings) and any Takeoff and Drawings will be put into the Job.

Paste Extension Reports*
Select this option to paste in Extension Reports from the selected job.

Paste Bid Summaries

Select this option to paste in Bid Summaries from the selected job. Pasting from an existing job will include any
numerical data, requiring extensive editing. It will have no extension data to back up the numbers, unless the original
extensions were Saved Edit Extensions and are also pasted to the current job.

Paste Extension Data
This function allows you to paste the Extension Data from the selected job.

Default
This option allows each User to choose his/her specific areas to paste for every new job. Once the choices are made, they
will come up marked on any subsequent new job they begin.

* Initial default selections when starting a new job. As a minimum, these should be pasted.

12
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STEP 2 - LABELS
Labels

Labels

[ atrrmst 1] Column 2 Celumn 3

In the example above if the left box of a Label is clicked, that Label may be moved up or down in the column. Labels may
be marked and deleted using the Delete button. Any Labels shown as blue have takeoff and cannot be deleted.
NOTE: The number of columns and labels per column available will vary based on the estimating product you use.

The Labels in the program allow breaking out parts of a job for taking off, extending, and printing out. The job can then
be organized into breakout modules, each can be estimated separately, and bid prices can be figured for various

13
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combinations of the breakouts. Different pricing levels can be developed for the same breakout based on different
conditions. Structuring the Labels before taking off does this. Labels can be accessed by the Takeoff tab and Labels icon
in the ribbon or the “(2) Labels” Toolbar button. In the example shown, the left column is normally used as the Bid
Package containing the Labels that represent pricing given a customer. Examples are Base Bid, additive and deductive
Alternates, and additive and deductive Change Orders. The additional columns show other ways of breaking the Job down
such as by Building, Floors, Systems, Sheets, etc.

Labels may be used to separate areas of the Job for the release of Material, tracking Labor, value added engineering, etc.

Labels can be as simple as Base Bid and a series of none, or as Labels similar to that shown above.

In the following example, there are three levels of labels. The illustration shows a typical job broken out into Floor 1 and
Floor 2. Floors 1 and 2 are each broken out into Lighting, Power, and Feeders.

NOTE: The “levels” broken down will vary based on the estimating product you use.

Main Job|
|
I l
Floor 1) [Floor 2]

= =l=—r [ 1
[Cighting) [Power] [Feeders) 'ighilng] ;r-e,L\e.».'-‘ [Feeders]

There can be many sets of labels that establish the degree of detail needed for a bid. Each column should contain a
separate level of labels. All labels for the same level of takeoff MUST be in the same column, allowing the User to
choose one label at a time from each level for takeoff.

Label Bar

Base Bd

The label bar allows you to easily see which Labelset you are currently doing takeoff in. Think of it as a Title Page for all
of your current takeoff. Quickly change from one Labelset to another by clicking on the pull down arrow to the right of
each label and selecting from the list of available labels for that column.

Label Bar Entries

McCormick WinSystems

What would you like to do?

'Add the label’ 'Parking'
‘Change the Name' of the current label to ‘Parking’.
Or 'Cancel' and make no changes.

1 Add the Label | Change the Name Cancel | |
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A label can be added or replaced by highlighting a label and typing in a new label name. You will be prompted to Add or
Change. Adding will place your new label at the bottom of the current list of labels, while changing a label will delete
the current label and place the new one over the top of it. You can access the full Labels window through the Extension

tab and Labels icon on the ribbon, or the <(2) Labels> toolbar button.

STEP 3 - TAKEOFF

Database

Item and Assembly Databases

-~
'

. e
Ié/ A‘:/ 1 :@

A

1. Choose the Item database, or
2. Choose the Assembly database

Items List

All Takeoff is accomplished by using either an Item or Assembly list. From here you may select and count off your
required materials. Labor and pricing information is saved with the individual parts and may be viewed or modified using

I

L cnppar wirn
4 el Mvhin mobd
= |14 TN CU SO0

5| 12 TH#Y CU 2000

7| 10 THAY CU 2000

3
"3 leu thhn stranded

10 | 14 THHN CU STRAKCED

1 12 TN NOED

[ 11w [Zsr] 2aa] Fee] P T Pemvices] JEP]
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the Review tab. You also have the ability to move to, or create Temporary job items. These may be reached by using one
of the following methods:

o Double right-click anywhere in the list with item names,
Click the “PJ” tab if it is showing,

e Choose the Takeoff tab and the Permanent/Job Specific icon in the Tabs section of the ribbon when the window
has focus.

The fundamental component of the database is an Item. An item is an individual unit of material used for estimating.
Everything in the database is composed of items. Even the assemblies are made from items, although they are called
ByProducts when used in an assembly. Your permanent item database can have up to 100,000 items.

It will help you to understand the database if you think of it as two parts:

e Item List — Contains price and labor specifications for individual items.
e Assembly List — Contains ByProducts (an item that is used as part of an assembly), prices and labor information
about assemblies.

NOTE: The databases and ability to edit will vary based on Security and the estimating product you use.
Tip: You may enter a lump sum into the manual entry box by simply typing in numbers while the takeoff window has

focus. You do not need to move the cursor into the entry box! Hitting return/enter will send the information to the Audit
Trail. (Keyboard Mapping must be applied to the current takeoff window(s) for this to work.)

Tip: You can also perform minor math function directly in the input window (adding, multiplying, subtracting and
division). You SHOULD NOT perform multiple math functions (such as adding and multiplying).

Assembly List

A Assemblies = = EX

AssmName -

2

3 |copper wire
4 cu thhn solid wire

5 | 14 THHN CU SOLID
§ | 12 THHN CU SOLID

7 | 10 THHN CU SOLID

]

% cu thhn stranded wire
10 | 14 THHN CU STRANDED
11 | 12 THHN CU STRANDED
12 | 10 THHN CU STRAMDED
13 | 8THHN CU STRANDED
14 | & THHN CU STRANDED
15| 4 THHNM CU STRANDED
16 | 3 THHM CU STRANDED:

tmasm [ M| Rev] F] %] Pemch | DEP

=
I9

All takeoff is accomplished using either an Item or Assembly list. From here you may select and count off your required
materials. Labor and pricing information is saved with the individual parts and may be viewed or modified using the
Review tab. You also have the ability to move to, or create Temporary job assemblies. These may be reached by using
one of the following methods:

16
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o Double right-click anywhere in the list with assembly names,
Click the “PJ” tab if it is showing,

e Choose the Takeoff tab and the Permanent/Job Specific icon in the Tabs section of the ribbon when the
window has focus.

Takeoff (contd.)

An Assembly is a collection of items (called ByProducts) that are frequently used together in the same fixed proportions.
Exactly which items constitute an assembly varies with the construction trade, differences in the practice of that trade,
variations in the building codes from area to area and your own preferences.

Everything in the database is either an Item or an Assembly. The advantage of using assemblies is that during the
estimating process, taking off one assembly results in taking off all of the items the assembly is made of. In other words,
assemblies group items together for takeoff, saving the time required to create an estimate item-by-item. Your assembly
list can hold up to 100,000 assemblies. Each assembly can hold up to 256 ByProducts.

NOTE: You CAN edit an assembly for ByProducts after it has been taken off. If it hasn’t been extended, it will read
the new ByProducts when extended. If it has already been extended, simply re-extend to read the new ByProducts.

Assembly Review ByProducts

Tip: You may enter a lump sum into the manual entry box by typing in numbers while the takeoff window has focus. You
do not need to move the cursor into the entry box! Hitting return/enter will send the information to the Audit Trail.
(Keyboard Mapping must be applied to the current takeoff window(s) for this to work.)

e e et
2004 39 ENT O

There are two different review screens for Assemblies (ByProducts and Specifications). You may toggle between the two
screens by clicking on the Review tab again. When you first select the Assembly Review tab you are brought to the
byproduct screen. From here you may view or edit the individual items that make up an assembly. To build an assembly,
open at least two takeoff windows. The first window must display the ByProducts for the assembly you’re building. In
the second window, you must select the item or assemblies you want to add to the assembly you’re building. Clicking the
AddMode button in the first window will cause a Transfer button to appear in the second.

17
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Tip: you can build assemblies with items or with other assemblies. To save time, consider starting a new assembly by
copying a similar assembly and editing it to meet your own needs.

NOTE: The ByProducts can be used as either a quantity (Qty) or a constant (Const). In the above example, each time
this assembly is taken off, the Qty of each ByProduct is multiplied by the takeoff amount. The constant remains the
same. For example, a 10-foot length of takeoff of this assembly would yield 30° of wire, 10’ of conduit, 1 coupling and
1.25 strap (based on a strap every 8’). It would also include just 2 connectors as they are being used as a constant and
3 feet of extra wire for makeup.

You will spend a lot of time in the Review screen for your item and assembly lists as you arrange items and assemblies in
their proper positions within your database. While in Review mode, you still retain all of the functionality of the original
takeoff list. (For example — You may still do takeoff using all of the different count methods.)

NOTE: You can change the name of the Assemblies in the list by choosing an assembly, holding down the CTRL key
and hitting INSERT or clicking TakeOff Edit enabled in the Takeoff ribbon and Toolbars Header. This will highlight
the entire list yellow. You can now change the name directly. In the Job Assembly list if you want to change the
Fixtures, Panels, or Feeders, if there are matching ByProducts, and you click Enter, you will also be prompted, if you
want to change these as well.

Takeoff Menu List
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WA

M Takeoff Menu [Items]

=] X3

Wire

Conduit

Boxes/Rings
Grounding

Lightning Protection
Devices

Equipment

Fire Stop

Controls

Industrial

Heavy Industrial

T-D Construction
Solar, Wind, Fuel Cell, CoGen
EV Charging Systems
HVAC

Special Systems
Voice/Data

Wiremold

Hardware
Underground systems
Anchors

Highway

Airport

Site/Parking

Fixtures

Lamps

Residential

18 Mat & 1 Hr Labor
Tools/Equipmant

Boxes - Large Industrial

Bus Duct

Cable

Cable Bus

Cable Tray

Composite Cable Tray Enduro FRP
Aluminum Cable Tray Cooper B-Lin
Steel Cable Tray Cooper B-Line
Generic Cable Tray

Cadweld

Conduit

Controls

Control Piping & Instrumentation
Equipment Rental

Explosion Proof

Fire Stop

Fuses

Generator

Hangers

Hardware

Heat Trace

Motors

Special Equipment

Stainless

Starters/Contactors
Switches/Breakers
Switchgear

Testing

Transformers

uPs

Wire

Wire Conn/Term

Wireway/Duct

B-Line Steel N1 Box

B-Line Steel N3R Boxes
Hoffman Control Panel Parts
Hoffman Fiberglass Boxes
Hoffman Panels

Hoffman Centinuous Hinge Boxes
Hoffman Steel N1 W/KO Boxes
Hoffman Steel N1 WO/KO Boxes
Hoffman Steel Flush N1 Boxes
Hoffman Steel N2R Boxes
Hoffman SS N4X Boxes
Hoffman SS N4X Concept Boxes
Hoffman Steel N12 LP Boxes
Juncticn Box Supperts

b-line nema 1 boxes

[ close When Found

Setup

Close

The Takeoff Menu is one of the easiest ways to find or select items or assemblies for takeoff. The left-most column of the
Menu lists the most general categories. The next columns break down the categories into sub-categories, and sub-sub-
categories. Moving from left to right allows you to select the category and sub-categories that represent the part you’re
looking for. Once you have reached the category in the farthest column to the right, highlight the final item. This will
take you to the actual part or header in the “selected” takeoff list.

Using the Close When Found feature in the lower left corner of the window will close the menu automatically when a
match is found in the database using the farthest right column. This will make your overall screen easier to work with,
since it will not appear so cluttered with windows you don’t need.

NOTE: The menu is “attached” to whatever window has the focus. So changing the window by moving to another
window will also change the menu. Resizing the window itself can expand the columns in the Menu.

| Name by item Name

j fem#

| DCI Code by DCI Code

| DCI Code by kem 2

| Catalog Number by fem &
| Manufacture by tem #

|| Close When Found

l' Setup |

' Close

M\ Takeoff Find/Sort [Iterns) £q 2R MTBKCU* Find/Sart [Assemblies]
What | | Active Find What |

| Name by Assembly Name
| Assembly 2

| | Close When Found

[ | Active Find
| |Headers Only |

Navigation

Find/Sort
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Use this screen to search the item and assembly databases that match the specified criteria. This is the quickest way to
search for an unknown part. Please note that the Title Bar Takeoff Find/Sort lets you know which list you are going to
be performing your search in (Items or Assemblies). To toggle between items or assemblies click on the tab of the current
Takeoff window.

It is permissible to use a wild card (asterisk) in the search. This will replace any characters before the description you are
looking for, including spaces. There are also a number of different methods to match your search:

1. Name by Item/Assembly # — Will find matches by number in the database.

Name by Item/Assembly Name — Will find matches alphabetically in the database.
Item/Assembly # - Will go directly to the item/assembly number listed in the What field.
DCI Code by DCI Code — Will find matches to DCI Codes numerically.

DCI Code by Item # - Will find matches by item number sorted by DCI Code.

Catalog Number by Item# - Will find matches by item number sorted by Catalog number.
Manufacture by Item # - Will find matches by item number sorted by Manufacturer.

Nookowd

NOTE: The Find/Sort menus available may vary based on the estimating product you use and are defined per user.

Takeoff (contd.) e o
Exchange — —

TH1AE fa eowents siibe deteca

TE4 fa mOWRrds sirate

TTAED e pheniam whinkd Sl catie
31034 faciory witmsle chesie 20,000 B
31953 factory wilvimsie clevin 36,400 B
T1170 Taatory witirnibe clewin 50,000 b
1755 T
17952 1 bomen

L352 fmadier # 12 paT W0
1023 fwecter § 12 pac 40 conat

1787 fewtor 4 A2 pve 0

TEL feetor t VI gripws
JE725 teaced tALE groies conme

5547 foacer t 14 puc 40
TIE1Y fwader § 14 pac 40 const

3758 fooder § 14 pvc 00

1521 feeder TN gretee
JET0T feednd T NS gropes cnsd

1512 feacer 3 10 pac &0
JIT feacer 3 10 pac 40 conat

5773 fweder 212 pvc 0

7353 feeder 2 12" grewe
SIL feater 2V groows conmt

FLEY Teated 2 pve m
1R fwmaar 2 pvc 4 conut

87 feadr 7 pve 30
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In conjunction with Find/Sort, another useful tool is the EXCHANGE feature. To use this feature, select a header (either
by scrolling or through find/sort), and then Click on the X or Exchng tab at the bottom of the window. This brings up an
alphabetical list of all the headers in the database. If you use Find/Sort in a general manner, this will make the Exchange
even easier and more desirable, since scrolling through an alphabetical list is easier than memorizing all the different
combinations of headers. Once the header you want is located, simply click on it to focus on it, then Click on the X or
Exchng tab again and you will return to the normal database window.

A Aszemblies = =] 23
C-Probe L-Probe

0 Count
N AszsmName -
4860 |3 #12 347 EMT VS
4533 |3 #12 34" EMT VS
4506 |3 #12 3/4" EMT VS
18f62 |3 #12 3/4” EMT DvS BL/MIN CONSTANTS
1 0 |3 #12 34" EMT VS CPNCRETE CONST
18526 |3 #12 3/4" EMT VS RACK CONSTANTS
18058 |3 #12 3/4" EMT VS STRAP CONSTANTS
4841 3#2 3M4TENT SIC
4514 |3 #12 34" EMT SIC
4B87 |3 #12 34" EMT SiC
4B60 |3 #12 3/4" EMT SIC
21p90 |3 #12 34" EMT SIC BE/MIN CONST
2119 |3 #12 3/4" EMT S/C CPNCRETE CONST =
21087 |3 #12 347 ENT S/C GONCRETE CONST

-

A4 7 £ i

It | Asm | Mru| Rev | F i | PermAlob | DEP

The same feature can be used effectively if you wish to sort the database by a

particular size or dimension. Simply find the defining size in actual Items or Assemblies (as above), then Click the X or
Exchng from the tabs below the window.

Toolbar Buttons
Default Toolbar Buttons

These are the first five Toolbar buttons. They are numbered 1 through 5 to indicate steps you take to move through the
estimating process from creating a new Job to printing Bid Summaries.

Tip: These buttons were created to show you the ease & power with which you may create your own work screens. You
will want to customize them as soon as possible to take advantage of your working style. We recommend you NOT
customize buttons 1, 2, 4, and 5.

Tip: Double Clicking on the gray border that surrounds the Toolbar/Label bar will cause it to disappear from your work
screen.
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MCCORMI|Cj(—

Custom Toolbar Buttons

Define new toolbar button \ Delete
Enter button caption 0K | Rename
! | Cancel | Snapshot
2 Macro
e Keyboard

Right Click on a toolbar button. If the button is blank, you will be asked for a name first (left). Otherwise you will be
presented with the menu on the right.

Delete
This will delete the button you just selected. ***There is no Undo for this option!!!

Rename
You will be prompted for the New Name of the button you just selected.

Snapshot
Snapshot will save your current screen configuration and apply it to the selected button.

Tip: Make sure everything is in place before doing a snapshot since this is how your workscreen will appear whenever
you access this button as this specific User.

Macro

You will be prompted to type in the series of keystrokes that you wish the program to repeat every time the button is
clicked. The only default macro is the Workspace toolbar button. Do NOT do a snapshot on this button as it will replace
the macro and change its function. The Workspaces macro is {F10} KKLW, the ”(2) Labels” macro is {F10}KKLB, and
the “(4) Extend” macro is {F10}NNSS.

Takeoff (contd.)

Keyboard
This feature is designed to emulate the Keyboard procedures that previous McCormick Systems DOS Users are familiar

with. After selecting Keyboard you will be asked which configuration you would like to map to the existing takeoff lists;
1, 2 or 3 window Keyboard Mapping. This only relates to the number of Takeoff lists you have on the screen (Example:
For 1 Item list & 1 Assembly list you would select “2 Window”).

Tip: Keyboard mapping only affects Takeoff lists, unless you specify otherwise, under <EDIT><KEYBOARD?> from the
pull down menu.

Tip: Keyboard mapping is also how Takeoff lists will allow automatic entering of input in the count field when you
select an individual item or assembly.
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]
MCCORMICK
Counting and Measuring
Power Probes
One Line / No Menu Bar
2% McCormick Systems Power Probes Advanced - NOPROBEPRESENT =N
@ count ] mecORmIcK g Lengn 0.00 > (1] (48] [+]
gc@v\' : (L] () (i
Two Line / Menu Bar . = "
2K Poors Frobes Advenced - ROFRCSEVR., | | 2 @
Coton: Pobes  Help = ) -
gl count ] ugc?ﬁu'x a1
NAY | AR
i Langth ) (.| M= <

Tip: Double click in the title block (McCormick logo) to turn the menu bar on or off. You can also close the probes
while in the program by using the “X” in the title bar.

Count
This window is where the results of using the Count Probe will show up as you use the probe.

Length
This window is where the results of using the Length Probe will show up as you use the probe. The results will be based
on the scale that is set.

Plus/Minus

This feature allows you to reverse the direction of takeoff for either probe from positive to negative. This can be very
useful if mistakes are made (and caught) while doing takeoff. It will NOT work after values are actually input to the
Audit Trail.

Takeoff (contd.)
Tip: Rolling off lengths can be accomplished with the Length Probe rolling either “forward” or “backward”. Tt will

always increase or decrease depending on the plus/minus button.

NOTE: Should you roll off a length in the wrong scale and realize it before you send it to the Audit Trail, you can
simply change the scale and it will calculate the correct length automatically. Once a count or length is entered into the
Audit Trail, starting a new count or length will “zero” the window and begin again. It is not necessary to clear the
window each time.

Calculators

7% Power Probes Calculator

140 () (=) (5] [=]
I Transfer Count [F3) ‘ ‘ Transfer Length [F4) | [Cancel lEsc]l l Clear (C) ’

'lo

=]
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There are two (2) Calculator icons on the power probes, one next to both Count and Length. This is designed to bring up
whatever value is currently showing in those windows, enabling the User to perform math functions on those values (i.e.,
figuring the number of couplings used for a specific length of conduit). Calculations can be sent to either the Count or
Length windows by using Transfer. Clear (C) works like any calculator.

Scale

There are a number of ways to use the scale in the Power Probes. All of the functions of ScaleMaster® are available
using the Power Probes, with the added ability to input the results directly into our program. The different options are
noted below:

o Typical — There is a list of typical scales available via the pull-down

e Custom — You can create custom scales as needed from engineers/architects or for large scale jobs anytime and
they are added to your pull down list

e Metric — This is a combination of both Custom and Typical in that you adjust existing engineer scales to read as
metric (i.e., 1=100 as meters instead of feet), then adjust the results to enter the Audit Trail as feet.

o Reduced Drawings — This is a very helpful feature. It allows you to calibrate your length probe to the actual
drawing, regardless of the original scale. The process is to set the scale to 1=1, roll off a known length, use the F2
key (the scale field will change to an equal sign), enter the known length with no space, and hit ENTER. Bring up
the scale list, click on the new scale and the length window should show the original known length. Your length
probe is now set to that scale for the rest of that drawing. Remember, you should do this for each sheet that
doesn’t match your original calibration, since you do not know what enlargement /reduction rate was used.

Takeoff (contd.)

Shortcuts

There are a few keyboard shortcuts built into the power probes that it would be helpful to know. To bring up the count
calculator, use F3. To bring up the length calculator, use F4. You can clear the count/length windows by using F5/F6
respectively. For example, if you have started counting or measuring and realize it’s the wrong takeoff, simply choose F5
or F6 and it will reset the count/length windows back to zero.

Metric

For the User doing metric jobs, there is only one basic difference with using our program...the database is in feet. The
takeoff is done the same, the scales can be set to metric, but the results will still be based on feet! Our method of dealing
with metric takeoff requires multiple steps to set-up.

1. SET the scale to the correct metric scale (use existing Engineer scales such as 1=10 or 1=100).

2. CLICK on the I/M button to change the perspective of the scale (i.e., Imperial looks at a scale as Inches=Feet,
Metric looks at a scale as Meters=Centimeters).

3. CLICK on Adj button to bring up the above window. Select the ADJUST box (this will give you a “tilde”
symbol (~) next to the length, indicating you are in an Adjust mode while doing takeoff) and change the *1 to
*3.2808 using the pull-down (this is the metric conversion factor).

4. CLOSE this window.

5. DO your takeoff. The results in power probes will be in meters and the Audit Trail will show the conversion to
feet.
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6. REVERSE the above steps (4-1) to return to Imperial takeoff.

Auditing and Editing

Audit Trail
M AT
* Name W oy Ada ML AdM  LF AdiLr User
o 34 ENT STRAP VS CONCRETE 2 A £ s 1 1 ! 40

tINENT S

F045 3$12 12" CA0 A 220 208

Piler: A1 Current Labels Summatize | Change Labelset | My Tokeoft | Notes [TINotes [T oer Comapsed

NOTE: The Audit Trail features will be available based on the estimating product you use.

The Audit Trail allows you to monitor what takeoff has been selected, where it is going, who did it and when. It also
gives you the ability (if your security level and estimating product permits) to modify this information in real-time for the
various adjustments. This will be the data that is sent to Extension. Think of the Audit Trail as a continuous record of
every Item and Assembly taken off and notes showing the Labelset and scale.

From left to right the Audit Trail shows:
# - Item or Assembly number (Numbers above 100,000 are Job Items or Assemblies).
Name - Item or Assembly name or a Note.
Pull down arrow that will show an Assemblies contents or go to an Items list.
I/A - “T” Ttem, “A” Assembly, or “N” Note.
Qty - Quantity of the Items or Assemblies taken off (cannot be adjusted).
AdjQ - Adjusted Quantity (this quantity goes to Extension).
Mul. - Multiplier used during Takeoff (cannot be adjusted).
AdjM - Adjusted Multiplier (the Multiplier may be adjusted here).
LF - Labor Factor uses during Takeoff (cannot be adjusted).
AdjLF - Adjusted Labor Factor (the Labor factor may be adjusted here by using the pull down arrow to the
right).
User - Who did this Takeoff.
e DateTime - Date and Time the Takeoff was done.
e The “P” in the column shows that the Takeoff was done using Design Estimating Pro and the “M” in the column
shows that manual takeoff was done.
e Clicking on the “Funnel with Lightning Bolt” in the last column shows the horizontal run and drops used in the
Design Estimating Pro Takeoff.
NOTE: Only Users with the proper security clearance can change the Adj. columns and the Design Estimating Pro
Takeoff cannot be adjusted.

Takeoff (contd.)
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Audit Trail (contd.)
Filter

v

e e R NS ~ o z 2
AL T wnned | Sameratios  (henge Cabminet | Wy Totoor | -~ | e ]

The Filter is a method of eliminating unwanted information from view in the Audit Trail to make it easier to use during
takeoff. As shown above, it consists of several levels of filtering depending on the specific needs. The default Filter is
ALL CURRENT LABELS. This filter will show only that takeoff done in the current labelset you are in. This will help
eliminate confusion over takeoff done in other labelsets and facilitate editing in some of the subsequent areas covered.
You can also change the filter, if your particular estimating product allows it, to your most commonly used choice and the
program will remember (by User) what that setting is for future takeoff.

Summarize

NOTE: The Audit Trail features will be available based on the estimating product you use.

No matter what Filter you are using, Summarize will collect all takeoff that is identical and compile the information
within the Audit Trail. It will perform any math that may be required by the Mul/AdjM (Multiplier/Adjusted Multiplier)
columns and reflect the proper Qty/AdjQ (Quantity/Adjusted Quantity) as determined by those columns. If similar
objects are taken off, but have different LF/AdjLF (Labor Factor/Adjusted Labor Factor), they will NOT summarize, as
they are NOT identical (they will combine and average when extended).

M Audit Trail = X:
[ o# Name VA Qty AdiQ LF  AdjLF DateTime -
» 100103 PANEL B S| A 1 | 1 1 L 1/232017 91734 AN
100102  PANEL A 2 A 1 1 1 1 | 12202017 9:17:33 AM
100101 PANEL MDP & A 1 1 1 1 < [ 1232017 8:17:31 AM
18012 3212 1/2" HR EMT D/S STRAP CONST S| A 125.3333 176.3333 1 [ 1/232017 9:04:57 AM
100201 FEEDER NDP-A 400A 2l A 24 6687 356867 1 1 o | 1232017 9:03:55 AM
16094 SP STD = A 1 1 1 1 o | 1/2372017 8:54:15 AM
16214 TELE-POWER POLE 2l A 6 8 1 1 | V232017 8:53:52 AM
Filter: NRPTETGE - | Summarize | Change Labelset My Takeoff v

The visual indicators that you are in Summarize are the missing section of the Audit Trail that would normally show the
Mul/AdjM columns and the Summarize button is highlighted. Notice the FEEDER MDP-A 400A 24.6667 shown in both
the example windows. In Summarize, both have been compiled to show the total quantity of 12. It is important to note a
couple of things here. You CAN continue to do takeoff while in the Summarize mode and it will “compile” your input as
you go. On the other hand, you CANNOT edit while in Summarize, as the program has no idea where in the Audit Trail
you wish to make your changes to the AdjQ, AdjM, or AdjLF.
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Change Labelset
First open the Audit Trail then click Change Labelset button to open the window shown below. Design Estimating Pro

must be closed before Change Labelset is used.

NOTE: You cannot use change labelset on Design Estimating Pro takeoff.

Filk R View Hep

[Bams il Bkl A, Flonn | Lighiag. Shret E2 =] GosCunet Labmbt | CopyNubphe [l =

- GRS 122 M

FOOURE © BRZMIIZRPM M

100 oaung v GVaNS1222PM M
10000t FOOURE A QACOSI2AFY P
ANI219FM P

ROURE 21

Stem Notes [

Y & e
| w5 e ] o o W o

Noree h a Wi AdNLF Used Dsta/Tem o)

10

Selecting Items and/or Assemblies
1. The labelset selected in the Audit Trail will be shown in the upper half of the Audit Trail Edit. To select an

individual item or assembly, click the small area to the left of the item or assembly where the reference arrow is
located. To select more than one item or assembly, hold down the CTRL key and continue selecting. To select
an entire block, highlight the first line in the desired block, scroll down to the last line in the intended block and
then click on the line while holding down the SHFT key.

Move and Copy —
2. To Move or Copy items or assemblies to a new labelset, first select the items and/or assemblies to be changed,

change the labelset in the “To Labelset:” area and then click either the Move or Copy button.

Takeoff (contd.)
Audit Trail (contd.)

Why Move and Copy?
When the Copy button is clicked, the labelsets for the selected items and/or assemblies will be added to the labelset in the

“To Labelset:” area, while the Move button will create a copy of the items and/or assemblies in the labelset in the “To
Labelser: ” as well as add another copy of each item and/or assembly selected with a negative count (resulting in a zero
quantity) for the original labelset the item or assembly is located in. *For further information on the “Change
Labelset”, refer to Section |1, Audit Trail
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NOTE: The Change Labelset availability will vary based on the estimating product you use.

My Takeoff

My Takeoff is another Filter. In this case it filters out everyone else’s takeoff that may be working in the current job. If
you are the only User on the job, this will have no effect, either enabled or disabled. But if others are also working, you
can see what they have been taking off (based on the actual Filter being used). This is true for both stand-alone systems
and networks. The difference will be that on the stand-alone system, the Users’ takeoff will be grouped, since only one
User may work at a time on the system. The network will allow you to monitor the stream of takeoff directly as it
happens.

Audit Trail Notes

M Audit Trail Note =

Common Notes:
Alow 2 weeks lead time to ship

|V |
Note Text: \
Allow 2 weeks lead time to ship

Add Common

Insert ( Cancel

If you want to add a note to an audit trail item, the note should be added prior to doing the takeoff since the note should
appear BEFORE the takeoff in the Audit Trail Report (but can be added at any time). Click on the takeoff item or
assembly at

the top of the Audit Trail, and then press the Note tab on the bottom of the Audit Trail. The Audit Trail Note window
opens to let you enter the note. Remember, the only filter that allows you to see the note is ALL TAKEOFF and must be
the active filter for both the on-screen Audit Trail as well as the report. Audit Trail Notes is an excellent way to make
notes about why you are making changes to the takeoff for future review of the job.

Common Notes
This area contains Notes that you have decided are Common. These are the memos you use on a daily basis or maybe just
complex notes you don’t want to type again and again. Click Update to update the note with any changes you have made.

Transfer Down — V
Use this button to move the selected note from Common into the Note field, and then choose Insert.

Note Text
Use this area to type in your note(s).
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Insert
After typing in your note, click here to insert the note into the Audit Trail. (Depending on whether you are adding a new
note or editing an existing one, this button may say “Update™.)

Add to Common
After typing in your note, you may add it to your list of reusable notes by clicking here.

Notes
The Notes check box allows the User to see notes that may have been inserted for the current filter being used. This is
helpful when in All Current Labels, as only those notes for the current labelset will appear.

Editing the Audit Trail

The main reason for the Audit Trail is the ability to edit the takeoff you’ve done directly, without having to re-do or
modify your takeoff. The Audit Trail consists of the Reference Number (#), the Description (Name), an ltem/Assembly
indicator (I/A), Quantity (Qty), Adjusted Quantity (AdjQ), Multiplier (Mul), and Adjusted Multiplier (AdjM), Labor
Factor (LF), Adjusted Labor Factor (AdjLF), User indicator, and a Date/Time stamp.

Tip: You can delete any line in the Audit Trail, depending on estimating product and security, by highlighting the line
you want to delete and pressing the delete key on the keyboard.

e # - The reference number is just that; the last used number location of the Item or Assembly that was taken off.

o Name — The name of the Item or Assembly that was taken off.

e |/A — Indicates whether the takeoff is an Item or Assembly (relates back to the reference number so you know
which database to look in).

e Qty—This is the ORIGINAL takeoff quantity.

o AdjQ — This is the same as the Qty unless you need to change it (this is the only place you can make changes to
guantity directly in the Audit Trail). Then it becomes the ACTUAL takeoff quantity. Any and all reports read the
adjusted columns ONLY.

e  Mul —Indicates the multiplier used during takeoff (set from <TAKEOFF><MULTIPLIER> in the pull-down).
We suggest using this feature if you are fairly certain there will be no changes to the takeoff. Otherwise, we
recommend you takeoff the quantities per label, then multiply the label in EXTENSION.

Takeoff (contd.)
Audit Trail (contd.)

¢ AdjM - This is the same as Mul unless you need to change it (this is the only place you can make changes to
multiplier directly in the Audit Trail), then it becomes the ACTUAL multiplier. The results of the multiplication
will be reflected when you Summarize.

e LF —This indicates the Labor Factor used during takeoff (can be set in the individual Takeoff windows using the
UTILITY MENU). This multiplier is applied to the labor in the database for each item taken off, whether used
alone or a byproduct of an assembly. Remember, this multiplier is based on task or difficulty.

o AdjLF — This will be the same as LF unless you need to change it (this is the only place you can make changes to
labor factor directly in the Audit Trail), then it becomes the ACTUAL labor factor. Since the Labor Factor is
selected from a list, the Adjusted Labor Factor must also be selected from a list, a pull down is provided for that
purpose. Remember, the program is only interested in the numerical value, not the description. ANY value you
want can be selected in the list, as long as it gives you the results you want.

e User — This is the User Name (assigned by the program when Users are created in SECURITY).

e Date Time — This indicates the Date and Time takeoff was done. Note it is tracked out to hundredths of a second.
This is so network Users can track multi-User takeoff immediately as it’s done.
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Assembly Review
The final feature of the Advance Audit Trail is the ability to review Assemblies that have been taken off for content.

L)
» Iy
e 21 A
544 81 A
2t £ A
Ve £ T A
114 L A
T RE T A
2 PAAE 21 A
AN A LA W — — — W N
PoIr: 2 Tales™t Summarize  Change Labolat [ My Takeolf 1 Notas
M CsEP 2ans = X M 3#121/2° HREMT . o X
£ Hame WA ary AdiG LF  AdiLF DateTime tem# Byproduct Name Gty | Conat |
m 3#12 172" HRENT OIS STRAP CONST £ A 58 188 1 1 11 1o lAdmn 12372017 9.05.09 AP ] 12 THHN CU STRANDED T
[18012 3#12 172" HRENT OVS STRAP CONST A 17 171 1 1 1 |Admh 1232017 20509 AN [P a7 172 EMT | 1 [
01| 0|
0 2]
0.125 0
T 012 0|
5805 | 1/4 FLAT STEEL WASHER | 0125 [
Dclete Close | Goto Assm. Goto ltem Close |

The ByProducts of the “3 #12 1/2" HR EMT D/S STRAP CONST” assembly with Goto

Assm. and Goto Items buttons is shown. Also the Design Estimating Pro Parts window showing the horizontal run and the
drops is shown by clicking on the Funnel with Lightning Bolt on the right. When the Design Estimating Pro Collapsed
check box is checked, the drop and horizontal run are shown combined. This is a report window and does not allow direct
changes but has options to allow review/editing of individual ByProducts as well as the total assembly. Reviewing while
in Takeoff allows you to select an individual byproduct and select GoTo Item. This will automatically open/change a
Takeoff window to Items and highlights the selected item. You can now review/edit that item. The same can be done for
the actual assembly by choosing GoTo Assm. This will automatically open/change a Takeoff window to Assemblies and
highlights the selected assembly. You then review or apply the steps for editing.

NOTE: The Assembly Review availability will vary based on the estimating product you use.

STEP 4 - EXTENSION

When Extension is opened, it shows you all of the material with the default report and labelsets checked as all/all
combined.

From there you can change the labelset combinations, change the reports, and make new extensions, all from the single
screen, instantly.

Work Flow with Extension

After you do your takeoff, launch extension. It will look something like this.
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L1
L — =
Pange O 2390 >
90 | Pick your extension report Total Price and Labor
| _tot ]
< - X
Cod < | set a3 Dttt Ragort [ (xtended Price SLILIL Untended Lator e
&l Add [
& Bpand/Tllapie Libiels S Bpand/Collagse Cort Codes | Whaterld Fiten <Nones -
acd [Ty =
CO1 - Add o el Byfvodiect]
<Chekto Add> , 4 M‘.. [temn Narme Gty Prced U ExtPrcel et Lo U Baitrxr | Clode SofftPicel Sofbeiteba
- ' | Labet Set: Combi Combined. Combined. Combiaed, Combss $1.392.31 “ 100% 100%
“ {Code: Branch Rough 100120 m R Ty
P S8BT ECK SUPPORTE-OUP CN 10020  $10332C $300.18 300 -300 <=
I List of Extenssons b 338324/5B0X 1-172° CEEF 10000 $61885C 51833 1000 C 1000 c»
" | P 25635 47550 MUDAING 12 DE 10000 $M2HC $34226 500 C 500 c=
' 4 CCode Tim DwicewPlates 122941 2500 FEEN SR
P 25229 1GIVPLAS DUBL RECR FLATE 10000 $415¢C 13415 S0 C 800 o
i p 25422 DUPLEX 154 RECP STANDARD  100.00 $HSEE C 59556 w000 C 2000 o
4 {Cods LugsTenmnabon Ground £ 00 pEEL 5 Leass
: P 2600B GROUND SCREW/S14 PIGTAL 10040  $301.22¢C $30122 £05C &0
—_— e — £
l pIEIRIN 80
L
= G #
l |:¢ Epur Sl Audie Trml

By default, it brings up the first report in your report list, and comes up combined ALL/ALL.

Extension (contd.)

Switch over to labels to pick what we want for Ext1.

e e it
b:—?_\m-:-

And this is what the result will look like.
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Each extension has its own labels and material tab. You can switch back and forth to immediately filter in or out desired
labelsets. Adjustments to multipliers and setting the column as separate or combined, is also immediate.

The tab across the top shows which extension report you are currently looking at.

Extension (contd.)
Home Ribbon

View Update Help

= e e # L L e

Open New Copy g Delete Setleck | Up-Link  Link Sendto Range

U T T S S G S S Sl S
FEE B B R

Open/close selected extension
Create new extension
Copy selected extension
Delete selected extension
Rename Selected extension
Set Lock state
a. Unlocked
b. Locked (can be unlocked by anyone)
c. Exclusively Locked (Only user who locked or Admin can unlock)

oakrwbdE
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7. Unlink from database — Prevent database changes and additional takeoff from entering the extension. Only used
when you have submitted the bid or don’t want changes to affect other extensions.

Extension @

. 'Surnrnary #2' has been Un-Linked.
J;\. This extension will not be automatically updated with quantity,labor, or
price changes.

8. Link back to the database — pull in quantities, prices, and labor if they are different.
9. Send totals to the Bid Summary

10. Range edit extension data. B == BRI
o lgld e (g 0% & 5 5%
o Wew Com - Oew SR Ueupk L SmEm e Range Emt o
S o T,{'"‘.' .-:' Fagiaca wiecond ol W wetwet s e
= frre ':",' x o t Cob Vatinir) B ! m

Range Edf alows changng a oel or graup M Tapiets Fon P e

mutipily, dende and ceplace formmulas

{
|
AR 1 Agd | of cellvalues using equal, plus, mnus

:
]
|
i
|
i
e
i Lt
!
1§
="“=!
-

EERESatiainaRszRasiiiz

.‘_

Wi

As shown above, to Range Edit, first select a Header, or (price, quantity, etc.), or a group of (prices, quantities, etc.) which
may be marked by using the control or shift keys. Then click Range Edit and select the type of editing and enter a value.

View Ribbon Fle  Home [ Updste  Help

b
Extension gj‘ o

- | Factor {100 = Show Report Groupil
M o Tiail | Assembli® L{ & % ERHPING
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Turn the main extension view, on or off.

This will show what assemblies contain the byproduct you have selected.

Zoom control controls the zoom of the Extension material.

Break out by report grouping.

a..If Show Report Grouping is checked / Label set to Combined, the report is only separated by Cost Codes.

b. If Show Report Grouping is checked / Label set to Separate, the report is separated by Cost Codes within each
Label.

c. If Show Report Grouping is unchecked / Label set to Combined, the report is sorted by Item number.

d. If Show Report Grouping is unchecked / Label set to Separate, the report is sorted by Item number within each
Label.

Moo E

Extension (contd.)
Update Ribbon

d‘ .l Ll U d f;'x E o t I ¢
: v' !_4 _H__ am £ -
uaptity

Update Update Overwnte Overwnte Revert Vendor Trade Update  Overwrite p,r,ce Labor Pnce Labor
3l

J
Price Lfr P:e Lzbor & Setup Sﬁe Ne&cer Quantity O : ! l

1. Pulls any updated prices from the database, sklps manually adjusted prices.
2. Pulls any updated labor from the database, skips manually adjusted labor.

Lipdare Prices [ + ]

| e the ssturize tu Updie Prices

| o Pame - 3o

Upzete Svcar crdy azpdet iz Ln Lisked bormom

Cancel

Update prices only shows unlinked extensions as linked extensions already show database prices.

3. Overwrite prices from , . the database, overwrites manually adjusted prices.
4. Overwrite labor from YRR the database, overwrites manually adjusted labor.

Lk the sdermeny fo Dverants Frose

Nl Nare

Ho  caigueg

| Overweite Prices epplici o Linkied sid Us-Uisked Sdzasicra
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Overwrite prices shows live and unlinked, it will replace manually edited prices.
5. Reverts selected cell in extension back to previous settings
6. Setup Vendors for the Vendor price update. As a User of McCormick, McCormick’s Technical support
department will assist a User in setting up Vendor price updating. Call 800-444-4890 for that help.
7. Launch the Trade Service price update interface
8. Launch the NetPricer Price update interface.

9. Pulls any updated Quantities from the database, skips manually adjusted Qtys.

10. Overwrites Quantities from the Database, overwrites manually adjusted Qtys.

11. Set Price column if there are multiple Price columns.

12. Set Labor column if there are multiple Labor columns.

13. Auto select lowest price in each Price column if there are multiple Price columns.
14. Auto select lowest labor in each Labor column if there are multiple Labor columns.
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Options 1, 2, 8, are only for unlinked extensions.

Extension (contd.)
Update Ribbon (contd.)

Extensions

L Posent ‘_—_—J - X
[l ‘l-;::ul-:a—‘ ":uu- Bt Laban by O 5 ] 710t 3¢ Owtnet Ropos Lutwoded Price ST 17741 Catonded Labar ‘e 'n]
[: Tag b BTN Lok B Togursd Callgris Cast Conben lA.u......xn.. “ s - v

T1wrwn amel By odun 14] fome

1!1 per Pare ogren J’-‘ ’j:: . o N ey J bt Prce fr > y Bt Low St Lode b of Dot Boca % of Bad Lo B0

e = A‘r' « --u-ni :”r—-tn sttt {omvire ‘,;—IT"' ‘ Oucts ? - s";:.z.[.'.“ o l‘l‘: IW‘..'_l 10%
1. The active tab extension you are working in is highlighted.
2. The type of report you are viewing, Items, Items and ByProducts, or assemblies.
3. A view option to expand or collapse the labels and/or Cost Codes.
4. The current extension report, you can change these. If you sent to bid summary, the extension report sent is

checked.
Filter to check for items that do not have either Price, Labor or marked as Quote.
6. Current Price and Labor totals for the shown extension.

o

Extensions List

Extensions v I
vy Name % =i
. IE-1 Power |]"” =

E-2 Lighting A

E-3 Voice/Data/Fire
<Click to Add>

Extension
lock status

Extension link status

Sentto Bid Summary status

This is the list of Extensions. On the left is the Lock symbol, you can lock down an entire extension from editing. It can
be unlocked, locked (unlockable by anyone), or exclusively locked (which can only be unlocked by an Admin, or the
person who locked it).

On the right is the database link symbol for each extension. The purpose of unlink is to freeze the extension. Unlinking
live data will prevent price, labor, quantity changes, or takeoff from flowing into the extension.

The send to summary is next to that, which indicates if the final numbers have been pushed into Bid Summary or not.
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Sending Extension Data to Bid Summary

Once you are satisfied with the modifications made to an extension, it’s time to send the Extended Price and Labor to Bid

Summary.

A

Extension Reports
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» 1873 Prce 2 8id Labee by CC becomes the defaull repont
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» 1891 3 Price2 NECA 1 the Extension Reports list is the default report

Extension (contd.)
Extension Main Body

Labelsets combined
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P 3ES0 BOX GUPPORTS.CUP ON 10005 B1S028C [ $5017¢C 5017 iwc 380
4 CCode Tm DecesPistes Luo a0 e ua s
P 14743 1GIV PLAT DUPLASCR BLATE 10000 $5139C 060 33083 ¢ 13983 100¢ 330
P 14004 DOSLER 154 NICE, SYANDAAD 10000 1145229 C 280 wairc faa? 00cC rt
4 OCode LugeTermmmation Guousd nen 0 dUN JFAIA N
P 16207 GROUND SCRIVAa14 MGTAL 10008 saalec os fisarsc fiears suc i R ‘”
. Lol Set Al 2 ASd Buiding A Flose L Pumer. Sheet £1 “wisn ] s (175 Amw
4 Clode Brasoh Aeogh L e [V7LS s
P 100N LZEWT 3038 $8243¢C 150 sea3c 2503 1%0¢ o8
1
T Epedabapelaben & Epacd Colis Cost Codes | Meterial Fter: <lnw® © |6ty [abels seperate and collapsed, you get a quick
B bt Byfonuctd 'overview of the material and labor.
| hene [rem Maese @ BogkPree. | U “
I Label Setiflase Bkl Muikding A Floor 1, Lighting, Sheet £1 $991913.88 001 % pRiAY
’ Label Sot: Bane Bid. Huskding A, Tose L Lightlag. Oftios Type A nana 00L% BN
; Label Sot: fanm Bk Busbding A Flocr 1, Lighting, Officn Type FTRI ¥l 0a2% [ETEY Collapsed
’ Labsel Set: Hase Bil Buskding A, Floor 1. Lighting. Otfkce Type C S196305 [FELY [P
Labels Label Set- Base Bid A Flooe 1, Powes. Sheet EL 2% 058
4 Label Set: Base Bal Suiiieg A Fooe L Power. Office Type A J‘ﬁ' 00L% 008s
” CCoge Branth Sough 12150
b AM2 1255L00MT 200 $123582C 1 0%
[P 1987 S0K APEORTE-CLE ON 20 518630 C $1080 0%0¢
P I 13 NCH0 200 mnc o4 430C
P B2ES 102 PuC MALE TERM 130 HL7aC soes CETY
P 25632 4/SHOXL-L/2° DEED 500 163142 6149 3800C
P 25635475 56 MUD FING L7708 100 §57043 C nra 1520¢
Sose Tiim i) s 120%
| Close Lugs/Temnsson Goune Y 17N 2%
b (Cose Banch e ean 030N JEN PSS
; Label Sot: Nase Bid Buleing A, foor 1 TOLm 5]
' u—-ml-luu-quux.iAnysecbon can be drilled down to see detail. E (T [XTE)
’ Label Set: Basa Bid Bulding A, Flaor 1, — [AIEE
; Label Set: Aane Bid Bubding A, Flcr 1, Vosce/Data, Office Type B T s2Ear "l Cost Code s
’ Labsel Set: Hane Bid Buibding A, Flaor L Vioke/Dita, Office Type € 23R A2 percentages wss.
' Label Set: Bane ik Buibding A Floar 2. Lightieg. Office Type A s1az241 T that make up the (VO
' Label Set) Base Bt Buibfing A Flaor 2. Lighting, Office Tyge 3 e Cus |labelset total 9.39%
’ Label Set; flase Wik Buskding A, Floce 2, Lightting, Office Type C FILINT Y um d oAIN
' Label Set: lawe Wid Bulsbng A Hoor 2, Power, Otfics Type A m m — 008n
’ Label Set; Hase Bid Bubrbeg A, Fosr 2, Power, Otfice Type $20151 RSl [XPEe
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WA

Collapsed Cost Codes

13 bxtembon Report: [FebiPeed B lob by Coode &
& Expandt/Collapse Loteh 2 Erpancl Collape Cont Codes

1Y St s Dntuidt Roport

U ARl U

Fook Poace

Pricel

Material iter: «Nones

i Q EnPrcel | Bty BefEarPrced Wl Bl Ear
4 el St Rave Ui, Diibging A, Fleor 1, Pamer, Sheet 11 28 ALN 84 %
] CCoce: Azt Rough 20 Lsae FIVIAS
| CCode Hzngenihschen L FITEY dus
[ CCode T DevicesPisres e P3SN P TEY
| CCoce {ugwTrmmng tion/ Growns F 87 Lisis AALS
4 Label Set: AR 1 - Adrl Bubding A Flocr 1, Power, Sheet £1 L8598 : mes wize
I CCode Sranch Pough 20608 U £2M8 LEN
] CCodte: Hangersibachon 10504 iR pl 1 aizs
| CCode: nm Devines Monee L0t |l 22 st
| CCode LugeTarmmation Grours {15876 £20 4% FraTLe
“ Labet Sen: A 2 - Adl Bulding A, Floor L Pawer, Sheet 1 | s 256%
| [Code Brznce Pough Friasg e [TTE PPy
| CCode Hangen/Aschon 218 ar LS s
I CCode Sroze  PEY &5 A A Y 8238
I CCode Thve Deviresiates 200 2N 4% 1329 %3
| OCeadn Luge/Tammnation Ground 250 agE 4% lus
1 CCode Srarut Wi $i264 “ .06 5 JEELLY
SL31820 g2
Base B
15 Lvernion Report: Edt Bace | B Laber by Com Code ® Y| et m Debucit Repor Material Hiter: < Noses  Extended Fri Extension (contd )
& Expunt/Cotazse Lebeh 2 Epare/Collipie Cost Codes . e
T Default view with
lem e Fon bane SookPice VU PAGL U Paeel | U EstPiced  Bdlly U SelbeEst  NofEstPrice] %olBdlivEe| i
8 T e 5 Combied, Comtined Contied Comtbed Comtied iy W labels combined
4 CCode Brench Rough Py m aLors RS
» 1001 12847 336 18243 C 100 se2s3 2503 20¢ Bl
»  L002 3a8aT $72 3 060 $3979C 879 M0¢ 039
$ 1034 1/2BMTOONN DS m wac 060 $18maC (18 H o
P 1035 JMEMTCONNDS 09 si0sadcC 440 084 C s s
» 1131 IMSMTCOPDS W0 SIE9EC 050 $6410C 5191 o0
» 13105 4/580K 1-1/7° DEEF 10530 SEIIT 080 $31300C 38223 00
P 15107 4355 MUORING 17 0F 0248 TR C 060 eToC M9 300 ¢ £
P 15100 45520 MU0 FING 1200 2 68472 450 fangc "2 S0 ST
4 CCode Mangeruthechon 0412 a3 pATEN j339
| /% 3830 30K SUFRGRTSCLF OM 104,30 3125 ¢C 060 53017 C §3a14 300C 313
4 CCooe Sope i ['+F} (713 a2
P 124D 372871 ROLESTR/SR 1z 16246 C LX) $4108 C i1 0w
P 1250 IMBMTIHOLEETRAR 196 Wisic 960 $5a8LC sLO8 206
4 iCCode T Devices/Pisres ups s 12438 48258
P JATAIL LGV RASSONTRSLATE Lae sdonar C LE1g s 103 o W
P 14743161V ILAS DUPL RECD PLATE 10000 15L30C L $3083C $3083 s00L £
P 14745 2GIN 218" PLAS POWER PLATE 200 TSI C 050 825083 C $5.01 600 ¢ 012
P 137ID 1G IV PLAS TELEPHOME FLATE 096 STIC 050 $4511C s0.8 30T s
§ 14514 OUREX 134 RICP. STANDAAD 10tae 115020 C 080 $%017 C L EH dwac 2000
P 14017 50 AMP REC STANDRRD 100 $52046 L 060 130624 C $613 3000¢ Ry
- CCode: Lugw/Tesouratom, Grownd flrasy [+ 3l4% s
P 10207 GROUND KREW LS FIGTAIL w3de fsa0c Q50 S8 70 C siTaas 6o0< ozl
4 |CCode Arenen Wow EVIAT Y (%7} FETLY ons
» 36 12 THHN CU SOUD 9520 $30044 M 060 $18423 M $1764 400 ]
LA 4
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Assemblies in Extension

Bane Bid
U] Labets | g Materist
% Extemion x«wu{ Assenmtdy Lint
& bpand/Colapse Labets & Tgand'Collape Cont Codes

v ] Set i Defauk Repant
Materal Hirer: <None> «

T PAnamblen]
Asun = Qty Rernarks
- Labwl Set: € bined, C ied, Combinad
b 1SAED NG 60X
& 15300 DURLEX D 10000
Anm ® Asam Nams QY Labor Facter VER/A | Labor Yalue
Label Set: <none>, cnone>, cnone>, coone>, <nomse>
- 15850 DUSLEX b2 E00.00 STANDARD - 100
Const

Rem Name Qty

Any assembly can
be drilled down to
see details about
the byproducts

— that make up that
assembly.

oD aoc

!

Assembly Unit Price Reports
All reports are customizable to contain whatever fields you want to see

" Base Bid

&2 Labels JTd Material |

{Zl Extension Report: Assembly Unit Price Conf 1 ~ | []Set as Default Report
\E/Expand,-"CDIIEpse Labels \erxpand,-"Collapse Cost Codes | Material Filter: <MNone> -
Mtems] = [Assemblies]
Asem Assm Mame Qty Unit Price 4 U | Ext U/Priced | ---Remarks--- | % of Ext U/Price 4
r Label Set: Combined, Combined, Combined, Combined, Combii 43.775.22 100 %
o 15,489 SINGLE RECP STD 100.00 $36.06 $3,605.72
o 15,490 DUPLEX STD 100.00 332,01 $3,201.02
15,491 DOUBLE DUPLEX STD 100.00 $41.48 §4,147.83
[» 15,492 DUPLEX 20 AMP STD 100.00 33232 £3,231.60
o 15,493 DOUBLE 20 AMP DUPLEX STD  100.00 $42.09 $4,209.00
o 15,494 30 AMP STD 100.00 340,18 $4.018.33
o 15,498 SINGLE FLOCR STD 100.00 $106.15 $£10,614.75
» 15,499 DUPLEX FLOOR STD 100.00 $107.47 $10,746.97
43,775.22




Standard Training Manual - Electrical WA

/7t 6 | — This report shows a few key fields in the math that
S Labels ) T Material | makes up the unit price. You can range edit the tax
I Exteminn Repart:  Acuambly Uni Prece Conf 2 = | [SemDefmhRepent | rate |abor rate, and the markup to give you control
& Bxpend/Collipie Labels S Espand/Cellapse Cest Codes Material Flter: <Neser ~ | over that final price.
7 Ascmbiies) T -
‘—:.I.-.V
D Aume Avum Nacrw Gy | MesTecMut | U | ibeRaeWE | U Masdupd | U | Unairced | U | BaUmviced | % o it Usrced
4 Labet Set: Combined. Combined. Combined. Combined, C d e 100%
} 15489 SNGLERECE $TD 100.00 1083 $2200 139 $36.06 $a808.02
» 15450 DUPLEX s 100.00 1083 $2200 123 $3201 $320L02
) 13 451 DOUBLE DUWLEX STD 10000 1083 $22.00 123 2143 $214783
» 15492 DUPLEX 20 AMP 5TD 10000 1083 $22.00 125 $3232 $3.23160
» 15493 DOUBLE 30 AN DUPLEX ST 10000 105% §22.00 125 38204 £4208.00
) 15494304M8 5D 100.00 1.08% $22.00 135 $40.45 $4015.33
b 15498 IVGLEROCR STO 100.00 1085 $22.00 135 $106.45 $10514.75
} 15499 DUPLEXFLOCR STD 100.00 1085 $22.00 125 $10747 $10.745.07
snR
T —_—— e
R _:_' pripro— . This report shows every field that is used in the calculation of Unit Price 4.

&ty ot v &Iyt ot e o | Mo AllOWING yOU to see and change every value.

" "';':’ T R L TR R S R e vn:—.-l bR N T s

mn
§ S SREED T T e (N 24t e i e
LT TRt m e 0 o em s [ Gaux
B el oomd Geus YU = (B . ia a Masts
b EEEE R T == e raw nen \ sanm
§ 1355 DOSULIT D DUSUIY ITD 30808 e ™™ Y= 2 Uraw
’ 20 waur w mn N3 > s
' FER faies M G LR . o n
' 3 1064 16is 11e4 Ao L3204 - 1 420 i o1
amung

Extension (contd.)
Print Options

42
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MCCORM | Cj(————

| Prnt Setup - 0
Sectiont ot Detein  Margim  Sheets | Diafault or breakout
Pagort Vew /
® [xtergion Peport W Yo
nouoge Jecyon Name Page Sceas Aftey

b Ovtail

el Notes

[erms and §yP rodkects] Summary

) torrs and ByProdocty

I Determing what sections wil I

| %]
M Laiels
%
%)

peirg out

Sel checks as defaut l

S aﬁ Tewet Defauk Ok Cancel

W.Y.S.LW.Y.G. What you see is what you get.

If you clicked on an arrow and expanded a section of two, but left the rest collapsed, it will print that way instead of the
default, which is all collapsed.

Set as default option is by job and extension report.

NOTE: Make any needed changes to your Template Job Extension Print Preview and paste the Template Jobs
Extension Reports to make the changes global.
Labels Section

ASE i Labels Report Prce | & Bl Lo by Cout Coce
Bat Puchacm bass " ’ A
. = * Comt . - T . ‘
o rsn e “
| Rae e 1k Wbt A 1k Pt 1 t SEe Laghtang 1Rl e
1 AN AM 1Y MM b v P 2 1 Lhiey I B e
AN A 1Bl Samteny ( El fhoat ¢ Femrer 1Bl Shestts
] A3 Deders I Bl mamegD El roms Ferders | Sheera
A A 'k e W ' Fooon § 5 Swrcbgen ' | ety
| Aans - Aam ' e U oot & 5 WS System ' | st is
] 01 A ' ] Commanem Mows ' Tomwrydin
07 A 1 B ety Sovvien 1B Cabde Teay 15 wma
] CO1-Ade | E e 1 Poor Dot | ] W
€04 A | ¢ Fhous Boars U 1 Wwmc
5 Deday Far Al
CON - Al | 1 teces OBl e Tese A
0T Ade Seomity I 5] ommerpeer
o8- Ade | Wetwws Comtrnd ' Bl OomasTeec
CON- A%e ' 1 Veeuts
] oW AM L
01 AM '
CO 1L e -
Gl o A
€0 14 - Ade ot
oo Pharee Page etoh Sher
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Items and ByProduct Summary

[Itams and ByProductz| Sammary

3
a1
ar
b
19284.05
= ety u}
to job Detmn Mgy Shees
Fagent
W Extars <p '
chide Zecton Mare Fage Tuak Ate
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Extension (contd.)
Items and ByProduct Section

o - L '
s Purrime 2w | iy
recn Nave BT B [ Iewns wad By Prodsen] Bepart Price 1 i B Labiaw by Ce

e v tem Narw Quavery Foce Lo Praw | o ilr ! Bt L Bt Code

Lt St Cormbunad Comvturwn Conburen Combwes, Comtas 961225 19105

CCade h R i i

T 0
‘ L 4 Lrrnss ! o
MT CONN (Z5F ] (TSIST am
¢ " o a4 L%
L} ‘ N i L UPFY Y ALY % i )
[ ¢t =6 154 30
' d DV Ll fram su (o]
‘ HoL i 1194 am
v { = K600 wn
A48 12 oy 2 LS " h
LM I LDOONUT 3 58 S A
C . ’ 10008 Y am
' LEFE ' 200 - )
¢ s 414 ' Ao
5 WALE TR . R et 0 ‘
4 4 g 404 L) “
" AT 5 ] '
4 ) " sy it s '
' am [+ o
’ [SET PR ) am
16 (Re T san % ]
e “ a0t (LR Y A
4w ' e sasd -
4 " 3 S8t (3131
¢ CRLET PR taram q - e Dtk Mogn  Ghosts
4 MO AR Famal
L v tTaAl # e
4 1 B 3 LA "
ek e Ma 4 hant 2N
& '..,.
v
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Appearance options

2l Print Setup — O X

Sections Job Details  Margins Sheets

lob Details
[[] Show Grid Lines
[ show Row Headers

Motes Details

[ Show Grid Lines

[] Show Row Headers

Labels

[ Show Grid Lines

[1 Show Row Headers

Extension(s)

[ Show Grid Lines [ show Borders
[1 Show Row Headers Show Color
[ Shadow Bold Edits

Set as Default Reset Default Ok Cancel

Exporting

1. Select file

2. Exportto
3. There will be a selection to export the extension to Excel, PDF, or Word.

46
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]
MCCORMICK
\5“] Extension
B vome  view TR b

; 3

2 -
@ Print : ‘ Export the Extension Data
f)@ Export to Excel
| I ‘_l‘ Export the Extension as an Excel file format.
Export To ’ = —
7 Export to Excel w/ Label Options

Export the Extension as an Excel file format with include
or exclude options.

4

]
Y

L
l

EXpOft to PDF
P . .
Summary #3 Export the Extension as a PDF file format,
test —w-—‘l Export to DOC
<Click to Add> [_l Export the Extension as a DOC file format.

STEP 5 - BID SUMMARY

P " W RSt 1T e T Fescaaianidne] o
wy | Sertigiuten  Tesi ordie Mty
e
.
C  itwcas
r YT ) ke 4 Tabeatt R i Cean () Senrazes e R

The bid summary summarizes all of the expenses required to complete a job. Bid summaries receive the total material
dollars and labor hours from either the extension process or by manually entering values into the Adj. Material and Adj.
Hours columns of the bottom left summary selection area.

Bid Summary Ribbon

Easily access bid summary features and customizable options through the Bid Summary Ribbon.

= " - .
L]
T b P Stve g Pelesiuge .- P -
@ i e 2 e
- -
- . - -
% - — o o | TR
e~ == & s =& =y =
- L . v X3 Mo € ot o N -O.'Ml
e e = E x mx e | Bl why
. | . L
" " o Db i
~e . | T oy
- wisal
i i
- S E =
N L L] » PRI ..;
—e L Pt 11 =xi
- [ ' - — - . N - i ol
Rl EEESsn— S SN S . SN S FESENE . e
- =8 = =3 [ErEn = =
X7 - - F 3 et
- e » * —tete
. - rald o n= om 4 ahaitehs
' - ww mx we nscw o = el
" . =3 w3 e 11—
- e wm= ur an s 108 VN -
.t '-.‘< t" “‘ - o R 2 ]
St [T . =i (= e = 2. e
- - s
- [ e
- " =
- " ™~ x
- [ v
' il &
- x . . =
- ury %
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Customizing the Bid Summary

1. What can a user view on the top sheet of bid summary and how can it be customized? Answer: All Job costs,
overhead, profit and tracking markers can be viewed. This can be viewed for many summaries at the same time,
even combining totals! A user can customize the top sheet by adding new columns to material price and labor
columns. An easier review of extension reports can be added along with new cost tabs.

a. Adding adjusted material price and adjusted hour’s column.
i. Adjusted Material lets you enter a value to bring the total material dollars to a desired level.

-~ McConmick Bi Summary - o IEN
Y Cyphowme P Toplhest ¢ OCiwlomiege . a ) Do o *
@ Lo loln § OneCoosNie >
Irepood  Schetun
@ Latxxbtan Yres!
fgheren G Toon = g P
3 e e [ - ek Roaen Y
TS [ [T [T | T g
¥ e %00 00 a0 w0 ooy | | RewContulTar WL 5
H
Sper s 0o T T o] oo | Overiet £x
S e e [T T 0o ooy || Pl wx
Dowct Job Expenee 0y o am 00 0 : ;T‘hl R
fowtet 0o 7T Y 00 o0, | | TewRdmy =h
| Pren wes
| i £x
Sabes Mony $ 3.1
At Dbt + v X 8 I o 0
Maflt - v LIS | ‘ | | PrcaSg T L3
‘ NSt i
5 Surmer ey 3 ’ A Ve y o 5 " Qamn Squoefet {14
(S 0| G i WAON WA ur wmeen WNTR o, i bl o] JobMedte
s ) 0 it SRy 11 o b

yEE Wan 0% v b

There are 3 ways to adjust material price, enter a new dollar amount in Adj. Material, adjust by
percentage (%), or by dollars ($).

ii. Adjusted Hours lets you enter a value to bring the total hours to a desired level. There are 3
ways to adjust total hours; enter total amount of hours in Adj. Hour, percentage (%), or dollars

($).

0T
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Bid Summary (contd.)

The
Button is
to

tabs per
on your

can be
summary
located

Ribbon).

- h—

—-—r

¢ Inoptions, place check in View Extension Fields for Bid Summary.

49
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Adding Tabs
easily accessible
quickly add new
individual job or
Template Job.
Extension reports
viewed in bid
(options button-
under
Configuration
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o View name of saved report next to each of the bid summary fields.

[V Y Wy y—

—s
= I’....-
TR
: = .: E'ﬂh.\ lm.l
| v P
L =
| S s
Y s
e L L
SRl s | Wornie iy o
e ~
[NEOT, -
& B
) S| K04 o'y 05 PR E
. . - pesntppotobensy | -
- ebes i ] [anae wr]e Ve 1o s
Sow Wt [T | G [ S | S8 [ s | ot | w0 |
Setting Up/Explaining Labor Groups
==
Groups | Burden |
Labor Groups Labor Class Hourly Rate Burden Addit. $ Total $ % Burden
¥ Phoenix Inside '® ind GFrmn Labor Burden1 [ s1322
Phoenix Outside Foreman $26.30 Labor Burden 1 v $13.10 $39.40 4581%
Trans & Dist Sub-Foreman | $25.80 Labor Burden1 || 512.98 53878 50.32%
J/Mn Tec $25.30 Labor Burden 1 I i $12.86 $38.16 50.84%
J/Mn Wir ' $25.30| Labor Burden 1 | v | $12.36 83816  50.84%
Appr 1 ' $13.12 Labor Burden2 |+ | $6.41 $1953)  48.88%
Appr2 ' $14.14| Labor Burden2 |+ | 26.65 $2079  47.06%
Appr3 ' §15.15 Labor Burden 1 | | $10.46 32561  69.06%
Appr 4 $16.17 Labor Burden1 v | $10.70 $2687  66.20%
Appr5 ' $17.18| Labor Burden 1 | v | $10.94 $2812 6370%
Appr 6 ' $18.20 Labor Burden1 || 511.18 $2938  61.45%
Appr 7 $19.21|Labor Burden 1 |+ | $11.42 $30.63 59.46%
Appr 8 $20.23 Labor Burden 1 v $11.66 $31.89 57.66%
Appr 9 ' $2124 Labor Burden1 v | $11.90 $3314  56.04%
Add || Delete |  Add | Delete
\ Close

Labor Groups (1) can be the Company’s Labor Group, a Davis Bacon Labor Group or a Local Union. Labor Class (2)

MCCORMI|Cj(—

can be as shown or even an Employee. The Hourly Rate (3) is the rate paid without Burden (4). And a Type of Burden

may be selected from the Burden page.

Labor Burden
Display only burden that is being used for top check boxes

50
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MCCORM | Cj(————

o If no value is entered into the burden on right side of screen, then the top screen cleans itself up and removes
anything with a zero or is empty

o Feature cleans up top of the screen saving user from scrolling through many burdens.

Bid Summary (contd.)

Copy Summaries
1. Copy labor, quotes, subs, DJE, equip rental and tax from one summary to many other summaries
2. Speeds up user - Complete only 1 summary and use the same options for all summaries
3. ltusually is a good procedure to enter the Labor, Tax, Overhead and Profit before copying Summaries. Then the
Other Costs (Quotes, Sub Contractors, Direct Job Expenses ‘DJE, Equipment Rental, etc.) may be added to each
of the Summaries.

McCormick Bid Summary
B Summarny
T CopySemmanes @ TopShest o, OtherCosicSingle 3 g % | OtherCostc &
i @ isborDoliars o, Othe Cosis Multi = 3
= Proposad  Schedele Fnny
@ zborHcurs Sheet
Bid Semeeary Grzphs Tocks Tzbs Sstup Prev
R Copy Summaries Ovethead §
== ]
b B Summary 10 Copy From Bad Summanies o Copy Te Tzblar=s
v 00
& | Too Shect O ==d an7 Sroft
e 5 » [TSebaewii
e 1-Add [ Jaxi-& - | Top Spest Misceliamenus
Subloctciors ST =
Hil-~%0 -
DirectdobBipers |y noae ]
Equperere Reniz Hi2-Add El
Ingirect 4t5- Acd o
C01-2dd 0
S | C() 2- Add [ ]
Lasilvetea = v 012 -
tcipsst Profi i CO4- 54 L1
C05-Dect | =ouC
= Somez  (COE-2dd [ ] 2 r
» P c07-a 107X - I
Vi 4xi-Add :3 "d: v L & Sarmanes b 1 &I Tabs 200
O Az / = - %
[ 43-Deduci 020
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Creating/Editing Bond/Tax

Bond Table

The Bond Table may be selected using the Bond Tab (5). The From amounts (1) will change based on To amounts
(2).The Bond Value (3) may be either dollars or percent based on the Format (4) selected. Bonding values may be added
(6) or deleted (7). Bonding may be selected by checking the Use Bond Table box on the Top Sheet.

Tax Table

The Tax Table may be accessed using the Tax Tab (5). Materials, Labor, and Other Costs (1) may be taxed. Other Costs
may be taxed by checking the Tax check box for that cost. If the Tax check box is checked and the Other Cost has a value,
that Taxable amount will be shown in the Taxable Amount column (2). The tax rate is shown as a percentage in the %
Tax Rate Column (3) and the Tax dollars are shown in the Tax $ column (4).
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Bid Summary (contd.)
Quotes

The check boxes (1) in the R (Reminder) column may be checked per Job or in the Template Job and Pasted. They are
used as a reminder that a cost may be needed and are unchecked when the final prices are added. When a box is checked
the red reminder appears on the Top Sheet and that Other Cost’s Reminder box is also checked on the Top Sheet. The
Name of the Other Cost (2) and the Supplier for that Other Cost (3) is shown. If an Other Cost is taxed the Tax check
box (4) should be checked for that Other Cost. The Tax check boxes may be checked in the Template Job and Pasted to
the other Jobs. The Unit Price (5) may be added for each Other Cost and the Multiplier (6) may be used to either select
that other cost or as a multiplier of that Unit Price (i.e. feet of saw cutting or trench, etc.). The Total Dollars (7) for an
Other Cost is shown. The Total Dollars (8) for all of that other Cost is shown.

Top Sheet
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> — » “ - 5 -~ *
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[ - p— — | I
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L1908 0 |

Bid Summaries may be combined by checking the boxes (1) and clicking the Combined button. Different Overhead and
Profit values (2) may be used for Material, Labor, and the Other Costs. Adding square feet (3) to a Summary gives a
Price per Square Feet (3) and Labor Hours per Square Feet (3). Adding Job Months (4) and based on Hours per
Week (4) will calculate Worker per Day (4) and Sales per Month (4), and Return per Month (4). Checking the
Markup Sales Tax (5) box takes the average profit percentage * the Tax and adds that value to the Profit. Checking the
Use Bond Table (6) box will add the Bond based on the Bond Table. Adding a Value to the Adjusted Sell (7) allows
entering the name of the person adjusting the price (7), and shows the Return Dollars (7) and Return Percentage (7)
based on the Raw Cost with Tax. If Details from the Bid Summary were added to the Job Details, they may be updated by

click the Update Job Details (8) button and following the instructions.

Bid Summary (contd.)
Printing

There are two different ways to print the Bid Summary.
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1. Select a single Bid Summary without checking the box at the beginning of the line and print. You will get a
report of just that Bid Summary.

2. Select multiple Bid Summaries by checking the boxes at the beginning of the lines; select the Combined button
in the lower left corner of the Bid Summary Top Sheet. This will immediately modify the Top Sheet to show all
the totals for the Bid Summaries you selected as a combined amount. When you print, you will get ONE report
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Select the Summary (1) and select Print (2).
Editing bid summary layout - Custom Print X
Available Bid Summary Layouts: Specs Page Break g
Print All Bid Summary Sections Preview Job Heading False
{ < Top Sheet False
Print Labor Hours False Sort Order
Mark-Ups False E 1T
Taxes False
Supplier Quotes False 4
SubContractors False
Direct Job Expense False Delete
Eguipment Rental False
New Copy Delete Cancel Restore Deleted Items Save Cancel

Bid Summaries may be Previewed or Printed (1). A New Bid Summary Layout may be created (2) or an existing Layout
may be Copied (4). Existing Bid Summary Layouts may be Edited (3) or Deleted (5). Page Breaks may be added by
selecting True under Page Break (8). The Bid Summary Spec order may be changed by selecting a Spec and using the

Sort Order arrows (7). Click cancel (6) if needed.
SECTION |1 Design Estimating Pro
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Design Estimating Pro Basics
Security

) Assign Security = 3
Scope: 1

Assign Users to Groups
(®) Group  Administrators ‘¢-
) User Admin o ‘Jser Maintenance

2

| Copy Defaults
resign Estimating Pro|
Al
Description 3 r Allow

Edit Design Estimating Pro _Iu::t Assembly Datal rl Z
Edit Design Estimating Pro Job tem Data \ Z
Edit Design Estimating Pro Layers \h [
Edit Design Estimating Pro On Sheet Assembly Data [

d

Edit Design Estimating Pro On Sheet kem Data
Edit Dezign Estimating Pro Perm Assembly Data
Edit Design Estimating Pro Perm tem Data
Launch Design Estimating Pro
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MCCORMIC——

& Assign Security 3
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Assign Users to Groups
(®) Group Estimators
O user Admin » 5 User Maintenance
J Copy Defaults
Area: Design Estimating Pro
Elements: AllD}NL\
Description 3 qllqu
Edit Design Esti Pro Job A bly Dialom [~]
Edit Design Estimating Pro Job tem Data \ [+
Edit Design Esti Pro Layers \ [
Edit Design Esti Pro On Sheet Azsembly Data Z
Edit Design Esti Pro On Sheet ttem Data Z
Edit Design Esti Pro Perm A bly Data :
¢ Edit Design Estimating Pro Perm tem Data E:]
Launch Design Esti Pro |
—
Close

Security for Design Estimating Pro is similar to security in the main app. The windows above show security settings for

both the Group Administrator and Estimator.

1. Choose the appropriate Group
2. Choose Design Estimating Pro in Area
3.

isn’t allowed to edit the Design Estimating P

Choose the desired functions. Administrator should always have access to everything. Note that the Estimator

ro specification in either of the permanent databases.
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1. To add or modify Layers, click on the Configuration Tab.

Click Design Estimating Pro Layers icon on the ribbon.

Layers may be added in the blank line with the * and another blank line with an * will be added or the existing
Layers may be changed.

4. When done click OK.

N

Design Estimating .
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Click on the Design Estimating Pro Specific tab. Beginning Item or Assembly should be marked.
Click Database Utility Icon or right click the (C-Probe, L-Probe, Count) area to bring up the
Brings up the Database Utility popup window.

Select the beginning and end of the range to be edited.

If your range crosses a header or blank line check the Skip Blank Names and/or Skip Headers.

If the range selected is correct, click OK button. To cancel, click Cancel button.

Modify the Style, Shape or Line, Width, etc. to match your needs.

Then Click the Apply button
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Design Estimating Pro (contd.)
Item and Assembly Databases

NOTE: It is highly recommend that a new user modify the Job Items and Assemblies in their Sample Job.

I‘?’— A{ 3 » Q . . e
A

1. Choose the Item database, or
2. Choose the Assembly database
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The Item and Assembly databases, both permanent and temporary, have a Design Estimating Pro Specific tab. They will
appear as described below:
1. Thisis the tab as it appears in both the Item and Assembly windows. It is the same for both the permanent and
temporary databases.
2. The specifics that can be edited for every item and/or assembly, as allowed by Security, include:
a. Name - This will reflect the Item or Assembly name and can be modified in Database review tab.
b. Style — Input can be None/Count/Length
c. Shape Style (Count)/Line Style (Length) — Choose the desired style from the pull-down. Shape Style
(Count) has many selections to choose from. This allows enough options to designate different device
types (i.e. switches vs. receptacles) and/or fixtures (i.e. fluorescent vs. incandescent). Line Style (Length)
offers three options; Solid Line, Dashed Line, or Dotted Line.
d. Color — Combine color with the above options and there are numerous variations.

e. Width (Count) — This is half of the size determination the icon will take when it appears on the drawing.
(Too small and it won’t be seen, too large will cover up too much.) The default of 12 should do the job,
but it can be changed as shown here.

f.  Height (Count) — This is the other half of determining the icon size. It usually matches the width, with a
default of 12, or can be changed as shown here.

g. Drop (Length) - This is the desired drop added to any length taken off. The default in the database is 8
feet, as shown circled here.

h. Thickness (Length) - This is the thickness of the line as it appears on the drawing. Two different
thicknesses allows you to vary Branch and Feeder if needed.

i. Opacity — This is how transparent the icon/line will appear.

j.  Orientation (Count) — This is how the icon will orient on the drawing. A triangle will have a horizontal
bottom line with the tip pointing to the top of the page. Changing the orientation will point the tip of the
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triangle in a different direction based on degrees, i.e. 180 degrees will change the tip to point to the
bottom of the page.

k. Text Overlay — This is a two part process. First is a field where text is entered. Icons will be somewhat
small and the text should fit, so use of abbreviations may need to be used. Second is the color of the
overlay text, which should be different than the icon color. The default black may be best choice in most
cases.

I. Layer — This is what layer the icon will appear in. The Assembly window shows Branch Rough. Other
choices are None and Devices as shown in Item window. This allows viewing the drawing with different
layers. The list is quite extensive and is hard coded by programming.

NOTE: These fields can be edited in the database using the Range Edit function the same way as the Main App.
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Design Estimating Pro (contd.)
Using Multiple Monitors

A dual monitor setup is ideal for Design Estimating Pro, as it allows for ease of use with existing item/assembly window
layouts.
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Click the Drawings tab on the initial Job Information page to bring in drawings.

TR SR 7 WO U J—— W 1

To import a drawing, click on Add Drawing.

Design Estimating Pro (contd.)
Add Drawings
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Browse to the location of the drawings.

Choose only the drawings needed by using either SHIFT to grab a block of multiple drawings, or CTRL to grab
specific drawings.

File name reflects the drawing chosen.

When all desired drawings are chosen, click Open.

Precussng File (2 of ) [76 - Phumbing Undeeground Plan P-101.pdf] Page 1
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1. As the drawings are being imported, Cancel Import is visible
2. The number of pages being processed are also in the dialog box

A Preview Daning
| Clove Prosiow "\ 1

| 1 imagey losded

Once the drawings are loaded, click any image to preview that drawing.

Enlarge the preview as needed by rolling the wheel on the mouse.

Because there is no pan capability, use the Scroll Bars to look closer at the drawing.
Click Close Preview to get back to MAIN Preview Drawing window.

HownpE

Design Estimating Pro (contd.)
Add Drawings (contd.)

Click on drawing
o preview

Select A

Clear All

Invert Selectbon

e
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1. This screen shows the total number of drawings loaded.
Select drawings manually by clicking the check box on each one, or

Choose Edit and Select All. Clear all will deselect all drawings and Invert Selection will reverse the selection of
the drawings, meaning those checked will become unchecked and those unchecked will become checked.

n

1. Once the drawings are selected, the user will get a new button for Import Selected. Click it.
Drawing Details
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1. Drawings are now listed. In the case of selecting a set of drawings, each one is individually numbered.

2. Note the original file date and time transferred are shown.

3. The State indicates if the drawing has had takeoff done in Design Estimating Pro. In this case, hone has been
done yet.

4. Drawings may be moved up or down in the list by clicking the up or down arrow for that drawing.

5. View details for a drawing by clicking in the row selector and Details button.

6. Copy or Delete chosen drawings with the notated buttons.

7. When done with this window, click Close to continue the initial job process.

Design Estimating Pro (contd.)
Drawing Details (contd.)

1. Details list.
a. Drawing — The name when originally imported. Name can be edited here.

66



Standard Training Manual - Electrical M

b. Scale — Sets when the drawing is opened.
c. State — There are five (5) states and can be chosen/edited here:
i. None — No state assigned (default).
ii. No Takeoff — No takeoff has been performed yet.
iii. Takeoff — Takeoff has been done (will auto change to this state during takeoff).
iv. Completed — Chosen when drawing is done
v. Locked — Nothing can be done to edit the drawing including doing takeoff (Admin or the original
user are the only ones able to unlock the drawing).
Default Drop Length Override — Edit here for this drawing as the default is O feet.
Imported By — User that imported the drawing. Cannot edit.
Imported On — Date the drawing was imported. Cannot edit.
Locked By —User that locked the drawing. Cannot edit directly, must change the state.
Locked On — If drawing is Locked, will show the date it was locked. Cannot edit directly, must change
the state.
Original Filename — Original filename and location the drawing came from. Cannot edit.
j.  Original Page # - Original page humber of the drawing. (Especially helpful when there were more
drawings supplied than what is needed.) Cannot edit.
k. Original File Date — Original date and time the drawing was transferred to the program. Cannot edit.
I.  Notes — Blank by default. Can be edited here, up to 166 characters.
2. These are the fields that can be edited by the user.
3. When satisfied with the chosen details, click to Close the Job Information Help window. Paste from Job window
will appear and can be edited (by pasting into) before going into the job itself.

S@ e o

Main App Toolbar

>

L o
I .

Launch the Design Estimating Pro from the main Takeoff ribbon. Unless otherwise set up, Design Estimating Pro will
appear on top of other windows. When using a single monitor it is best to open takeoff windows first.
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Design Estimating Pro (contd.)
Toolbar

Overview
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1. Open Design Estimating Pro and choose an UNLOCKED drawing from the pull-down.

2. Open the ROTATE window to rotate the drawing's orientation on the screen. The options are Rotate Clockwise
90°, Rotate Counter Clockwise 90°, or Rotate 180°. Once the drawing is oriented correctly, choose from the
following options; Reset to the original orientation, Cancel the entire operation, or Save the current orientation.
As long as there is no takeoff done on the drawing, the user can bring the Rotate window back up using the icon
on the Design Estimating Pro toolbar.

3. Setting the scale for the drawing will be explained in detail further on.
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This is the main file window, listing available options with Design Estimating Pro.

New
Allows users to open multiple drawings at the same time.

.
L] }

o

2

Opens a new nstance of Design Estimating Pro,
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"
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E
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Design Estimating Pro (contd.)
File (contd.)

1. Open another new drawing. The usual opening procedures will still be in place, i.e., rotate and set scale.

Note at the bottom of the drawing that it will be in Read Only state.

3. To change working between the different drawings, the user will Activate the desired drawing by choosing the
Activate Icon. If the icon is green, it is the active drawing. If it is black, the drawing is NOT active.

N

I New
I»| Export

Export Q] \
Expont kob
8 Print

Export the current sheet to the seiected file format.
Supported formats include PDF, PNG PG GIF EMP

Allows users to send drawings or Pretecences Bl a Select Area of a drawing to file
@ About
)

|Close)
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locations in PDF, PNG, JPG, GIP, BMP and TIF formats.

|||||||

1. Adrawing or a selected area of a drawing may be Exported.
2. Browse to find » the desired location.
3. Choose the format for the final Export.
4. Name the File and [_i_ New Save (not shown).
Design Estimating Pro [ oo (contd.)

File (contd.)

Export Job
Allows Users to select E Bt MExport the current sheet to the selected fle format. | SNEETS Within a Job and export them.
I Supported formats include PDF, PNG, JPG, GIF, BMP,
Preferences and TIF.
o Help
@ About
@ Exit

Close|
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Print

WA
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Allows the user to print a section of a drawing or the whole drawing including the Takeoff shown.

Add Print Scale

pmrin
[‘ New

m Export

ﬁ Export Job

o
N Sends the sheet (or current sheet selection) to the

e selected print device.

I '!!I Preferences

Help

You can add the scale to the printout with this option, Imperial only.

[ Print Preview - o

Print
o =
Cops
Print
Printer

HP Color Laser)et CPR0Q5 PCLE

Printer Propert

Settings
Portrait Onentation
Letter B3 1" ¥

Narrow Margine: 5
P, mtings

[s

V1 Adg Print Scale | Bottom, Center
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Design Estimating Pro (contd.)
File (contd.)

Preferences
Menu to set preferences in Design Estimating Pro, includes the following:

@ Export Job

= -

e Configure advanced application options
.l Preferences /'

0 -
@ About
b 4
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Display

™ Preterences

[ Jpve abetset Part Doy

Displey
General
Keyboard

Mouse

1. Display

|
Cpscty 0% ¢ E

Measurements

Ousplay Region Sae Al | S
/| Display Caiculated Value While Drawing Lengths o

Default Scale Unit: | Imperniat

Selected Area Totals

Selacted Area Affects Legerd To

tols  Ggr—
Selected Area Affects Filter Totals *—. D

'E]'|

Sheet Titke Fant Coloc

—ART T SQ@ MO0 T

Restore Defaults

Design Estimating Pro (contd.)
File (contd.)

! Use Status color for Sheet Font Caolor

lakeott Resize/Rotate

. Display kande for rescng/rotating tekeof i |h

I

MCCORMI|Cj(—

ll I —y  (festore Defeults) Close

76

Inactive LabelSet Part Display — Sets opacity on an inactive part (different LabelSet)
Measurements — Default Scale Unit: Imperial or Metric
Measurements — Display Region Size: Always, Never, or Selected
Measurements — Display Calculated VValue While Drawing Lengths
Selected Area Totals — Selected Area Affects Legend Totals
Selected Area Totals — Selected Area Affects Filter Totals

Sheet Title Font Color — Use Status color for Sheet Font Color
Takeoff Resize/Rotate — Display handle for resizing/rotating takeoff
Tooltips — Show Tooltips.

Warnings and Notifications — Warn on Default Part Style changes
Warnings and Notifications — Notify When Part Filter Changes.
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MCCORM | C—————
T Preferences O
Crsplay :Wd ‘;
-‘:n‘.": *-"?"J /| Enable Agtoscrol Siow :"'"_-; a l
Length Optioes .
Multipler Norw j!
Region Optioas
Aytomatically ces er Reg e ‘ _-d—J
Resobution / Detail
Low fact - e '
M —
t Battom Right D eSS ‘__l
e t Last Lo *_ g—J
Window
V| Ceen D ) Qe h |}
I t_-. Restore Detautts u:i
2. General
a. Autoscroll — Enables Autoscroll when checked; scroll speed may also be modified.
b. Length Options — Multiplier: None, Feet to Meters (0.3048), Custom, Meters to feet (3.28084)
NOTE: Multiplier Discrepancy shows if the Multiplier doesn’t match.
c. Round to the next — Rounds the horizontal run and the drops to the value selected.
d. Region Options — Automatically center Grid after Region resize
e. Resolution/Detail — Select High (slower) or Low (faster) resolution detail.
f.  Sheet — Initial Open Position: Top, Left — Top, Right — Center — Bottom, Left — Bottom, Right
g. Sheet — Subsequent Open Position: Last Position - Top, Left — Top, Right — Center — Bottom, Left —
Bottom, Right
Window — Keep Design Estimating Pro as the topmost window when checked.

Restore Defaults
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]
MCCORMICK
1 Preferences - O X
Display Orthagonal Lines (Snap to 907} =
Mouze Direction | Inverted + Hold %o disable snap ¢
Seund
[Sheriats ¥ . .
Actitn L Keyboard Shartca ‘
Add Drop to Both None « 8
Add Drop to End None 2o (%
Add Drop to Start None
Toggle Crosshai Ar
Toggle Drawing Pan A v
Toggle Drop Detalls ar D
Toggle Jump Ragion Control Al
Toggle Legend ax L
Toggle Magnifier At v e M
Toggle Takeotf/Select Buttons  None * « Space
Toggle Text Overlay an + 0
Toggle Zoom/Pan Control as - Z
Note: Crl-A, CarhC CirdeP, Ctrb V. Corlo X, CerleY, Ciol -2 are reserved Keyboard
Shortouts and cannot be 223 ‘_:"‘bl' a3 & custom shortout
['—l el Pstore Defautts C\:{;e
3. Keyboard
a. Orthogonal Lines (Snap to 90 degrees) — Keyboard Shortcut: Hold this key (Default — Alt), Control, or
Shift

b. Orthogonal Lines (Snap to 90 degrees) - While clicking this key (Default — Hold to enable snap), or
Inverted — Hold to disable snap is squared off.

Action — Select the Keyboard Shortcut

Keyboard Shortcut - Hold this key

Keyboard Shortcut - while Clicking this key

Restore Defaults

SO a0

Design Estimating Pro (contd.)
File (contd.)
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| [ Preferences

Acvon
Lrsply
e Drawing Zoom
Keyboard Horizomtal Deawing Scroll  Mau

Mouse 4B\I«|h-l Drawing Scroll

Sound

4. Mouse

Mause Whes! Scrpil -

Mause Wh

WA

MCCORMI|Cj(—

Shoetcut

|
— Pestore [-Juuuni; Close)

a. Drawing Zoom — Mouse Wheel Scroll + Alt, Control, None (Default), Shift

b. Horizontal

Drawing Scroll - Mouse

Wheel i - cE Scroll + Alt, None, Control
(Default), Display  pmiSounds S shift

c. Horizontal i:":;'d ® Defautt Sound Files 4——-[5 Drawing Scroll - Mouse
Wheel - sson o P - Scroll + Alt (Default),
Control, Sound pkmiy None, Shift

d. Restore Defaults

Pan - Hold Shift and
wheel down

Left button or hold scroll

[}
Restore Defaults|
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5. Sound

a. Sound Options - No Sound, Default Sound Files (McCormick’s), or Custom Sound Files

b. Sounds Used - Sounds needed in the program: Forward Count (adding), Reverse Count (removing),
Forward Length (adding), Reverse Length (removing).

c. Custom Sounds — File location of custom sounds

v p
C New
LI» Export
Design Estimating Pro @ Export Job . (contd.)
File (contd.) E
Print

H_E|Q Open the Help file for Design Estimating Pro

PrefereV
@

Help

@ About

XK | Et
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Help
Clicking Help or the F1 key allows access to Design Estimating Pro Help.

81



Standard Training Manual - Electrical

B Aoty e

T Mty Severw Brpocu
B hememtsy Faverw Specy
T Rewedty Somccamora
B e L

_‘5 o Bname Tonca

B b Spactcmers
Terganary swetly Lt
Targomary tows Lt
o Tred

Aadt Trad Bt

bt

0O
- ,f. T W
4 .
’
2

o TR

Design Estimating Pro
Design Estimating Pro
Job Screen - Add Drawings
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1. There is now 2 wb cu B wmdtal Job leftenation puge whes fie User it a oce
1ob that allows dhe User to being i drawags
1 The User sy chicks co ASS Draway

1. Help Menu - Default for this help is Design Estimating Pro.
2. Content Window - Showing the Design Estimating Pro help.

3. Maximize Window - Content is easier to read when the window is maximized.
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MCCORM | Cj(——

Design Estimating Pro (contd.)
File (contd.)
About

File FI

Ell_ New

w Export

@ Export Job |

E Print

N About Design Estimating Pre

Preferences

0 Help L

@ About

XK | Edit

=

About

Shows the version of Design Estimating Pro. May be needed when speaking to McCormick’s Tech Support.
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MCCORMI|Cj(—

=
C New 7]

m Export

@ Export Job
E Print

.l Preferences

Help Close

Ty

Exit the Application

Exit
Will exit the Design Estimating Pro application and Close will close the file window without performing any
operations.
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MCCORM | Cj(————
Design Estimating Pro (contd.)
Design Estimating Pro Perform Takeoff Ribbon
e 94 2800
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B OFFICE WAL POWER PLAN 157 FUN E&.1-01
B <R 3301 Nene [‘['
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B 5100 A LSHTING PLAN E23.01 None [alw
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D 51402 & POWER FLAN £3.3-00 None l‘lv
I 5HOP B <VAC POWER PLAN £ 440 Nene [a]w
B 5HOP B =VAC POWER PLAN £43.08 Nene A|'

1. Status Sheet: Choose a drawing using the pull-down that was added in the Job Details screen. As shown above,
the list of drawings can be customized once Design Estimating Pro is open.
a. Select drawing - Choose a drawing from the list by clicking the square in front it (square is black by
default).

b. Select Color - Choose a custom color from the pallet.
c. Edit Name - Rename the drawing if needed.
d. Drawing State - Drawing state can be None, No Takeoff, Takeoff, Completed, Locked, and Exclusive

Lock.
e. Drawing Order - Reorder drawings by using arrows.

Rotate Drawing
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Once a drawing is selected the rotate drawing window pops up. Drawing may be rotated 90 degrees Clockwise / Counter
Clockwise or 180 degrees. If the rotation does not need to be adjusted, click Cancel. If the rotation was rotated, click
Save. To return to original rotation click Reset.

@  Rotate Clockwise 90°
(8 Rotate 180°
{8 Rotate Counter Clockwise 90°

Resetl Cancel‘{Save‘
Scale

2. Scale — | (Imperial) or M (Metric)

3. Scale notes - The list of available scales will appear automatically as soon as the user chooses the drawing and
sets the rotation. This can be bypassed initially until the scale is actually known. A SCALE MUST BE SET TO
DO TAKEOFF! There will be a message with a STOP SIGN at the bottom center of the window if the user

doesn't choose/set a scale initially. A Hand Entered Custom Scale may be set or there are Architectural and
Engineering scales available.
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Design Estimating Pro (contd.)
Scale (contd.)

Set a custom scale (above): Select | (Imperial) or M (Metric), then Click on the scale drop-down.
Choose Set scale from known points.

Maneuver the two end points to determine what the scale is based on (above shows a doorway).
Default length is zero (0), but if there is a number shown, delete and type the known length.

Enter and the scale will be shown in the area underneath the Set scale from known points. For now, the
scale is determined by Engineering Scale.

akrwdPE

Drawing Selection
4. The Up/Down arrows scroll through drawings without using drop-down menu. The Bold arrow will default to the
last drawing use.

Edit
5. Options (use with Select Area):
a. Cut - Cut the selected area.
b. Copy - Copy the selected area.
c. Paste - Paste whatever has been cut or copied to a different location, including another drawing. The final
location is based on the upper left corner of what was cut/copied.
d. Delete - Delete the selected area.
e. Undo

NOTE: All the steps above (a. - e.) will be identified as tooltips when hovering over the icon.
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Sign
6. This choice will make takeoff either positive or negative.

Takeoff
7. At least one Label should be created before doing Takeoff. Choose an Item or Assembly to take off and click

Takeoff Icon if it’s not already selected. This will allow Count or Length takeoffs. The cursor will be a PENCIL
for takeoff that is counted, a CROSSHAIR for takeoff that is a length, or an enlarged CROSSHAIR surrounding
either icon that helps long connected takeoffs. The SPACE BAR allows toggling between Takeoff and Select.

Select
8. Click select icon to choose Counts, Lengths, Notes, Legends, Highlights, Jumps or Regions by clicking on or

boxing around them.
a. Click or boxing around: allows moving Counts, Lengths, Notes, Legends, Highlights, Jumps or Regions.
b. Click or boxing around and hitting Delete on the keyboard: will give a prompt to remove that specific
Count, Length, Note, Legend, Jump or Region
c. Click and Right Clicking : Edit Options —

i. For takeoff that is done by Count, these include; Cut, Copy, Paste, Delete, Select All, Bring to
Front, Bring to Back, Rotate Clockwise 45°, Rotate Clockwise 90°, Rotate Counterclockwise 45°,
Rotate Counterclockwise 90°, Replace All Matching Parts, Replace Selected Part(s), Add New
Part Near Selection, Properties.

Right Clicking Count \

® @& —— | kems or Assemblies

@R PP 0 XDBK

2
" &)
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Design Estimating Pro (contd.)
Select (contd.)

ii. For takeoff that is done by Length, these include; Cut, Copy, Paste, Delete, Select All, Bring to
Front, Bring to Back, Add Drop Value Here, Add Drop Value to Start, Add Drop Value to End,
and Add Drop Values to Start and End, Replace All Matching Parts, Replace Selected Part(s),
Add New Part Near Selection, Properties.

T

Right Clicking Length
ltems or Assemblies

Cut
Copy
Paste

Delete
Select All

Bring to Front
Send to Back

Add Drop Value Here
Add Drop Value to Start
Add Drop Value to End

Add Drop Values to Start and End

Replace All Matching Parts
Replace Selected Part(s)

Add New Part Near Selection

Properties

If you right click a region, you can takeoff that region’s area or perimeter.

NOTE: Be VERY cautious using Select All as it is exactly what it says. It will select ALL the takeoff done to that point,
if Delete is chosen as a next step, ALL the takeoff done to that point will be deleted.

Assembly #15768

Assembly #511

Cropis)
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d. Double click Count or Length and the Design Estimating Pro specifications for that Item or Assembly
will appear.

i. When changes are made to a symbol, it will not change the matching symbols already taken off
on the drawing.

ii. Click the Apply to matching parts check box to change all matching parts in that drawing.
iii. Click the Also apply to Main database to update the parts database also, but not the symbols
already taken off unless the Apply to matching parts on this sheet check box is also checked.

Erase

9. The Erase cursor is to remove specific take off. Click on the Erase icon, then an Item or Assembly symbol on the
drawing. A prompt will appear asking whether to delete that item or not. Choose the appropriate response.
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Design Estimating Pro (contd.)

Select Area
10. Click on the Select Area icon then click and drag the mouse to select an area. Once selected, the following can be

done:

a. Delete: Click Delete on the keyboard or in the Edit functions, it will bring up a prompt to delete all
takeoff in selected area.
Print - Open the Print function in the upper right corner of the screen to print selected area.
Paste - Click Copy in the Edit functions, switch to Select Items, then Click elsewhere in the drawing and
choose Paste. Whatever was selected will then be pasted in the new location based on the upper left
corner of the selection.

d. Paste - Click Cut in the Edit functions, switch to Select Items then Click elsewhere in the drawing and
choose Paste. Whatever was selected will then be moved to the new location.

e. Edit - Double Click to edit properties such as fill color, etc. if the selection is a Highlight, Region or
Jump.

Markers
11. There are nine markers, of varied colors available: three Highlighter (H), used to highlight different parts of a

drawing. Two Region (R), used to delineate a part of a drawing, and then using Select, cut/copy/paste to a
different location on the same drawing and/or other drawings. Lastly, one Jump (J), which will appear on top of
the drawing in the upper right corner if the proper icon is chosen (see 17 below). When many drawings are being
used, using the Jump feature will go directly to a location. There are also three Grid markers and additional
regions may be added.

NOTE: The “Marker Setup” ribbon will be covered in the next section.

Line Options
12. The choices for doing length takeoffs are:

a. Single-line - Click starts the line, another click stops it. Single-line amounts accumulate until moving off
the Item/Assembly, which then commits it to the Audit Trail.

b. Connected-line - Click starts the line, click at any point to change the direction, then a double click at the
end stops the line and commits the run to the Audit Trail.

Drops
13. Override/Auto Start/Auto End
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a. Override — used to enter a drop other than what the current Item/Assembly Design Estimating Pro Spec
(shown as 1land 2 below) is set for. Check and enter the desired override amount (i.e., 12, 15, etc.)

b. Auto Start/Auto End - if checked will enter the Item/Assembly drop Design Estimating Pro Spec is set for
at the beginning and/or end of any length takeoff.

c. All Options - All three options can be used in combination and can be seen if Drop Details checked.

A Assemblies = [=] £3
C-Probe L-Probe 12 THHM CU SOLID
0 Count Style |Length ~
No: AssmMName - Line Style: |—— Solid Line -
1 Electrical Database =
2 Color:
3 copper wire p
4 cu thhn solid wire .
—
5| 14 THHN CU SOLID Thickn A 01
7| 10 THHN CU SOLID pacity ———— —
3 c
9 cu thhn stranded wire 2 verlay: -
10 | 14 THHN CU STRANDED
11| 12 THHN CU STRANDED Layer: |Branch Rough |~

12 | 10 THHN CU STRANDED
13 | & THHN CU STRANDED
14 | 6 THHN CU STRANDED
15 | 4 THHN CU STRANDED
16 | 3 THHN CU STRANDED
17 | 2 THHN CU STRANDED

18 | 1 THHN CU STRANDED 1
19 | 1/0 THHN CU STRANDED
20 | 2/0 THHN CU STRANDED =
T 4 \ I »

Itern Assembly] I e Heview] Fnd.-"Srt] ExchngJ Permdlob DEP

-n - o A 5 S ' " =5 v;-.
m - ol R BBl - s wrn G D A
= - g Tow \:o q
i ¥
Drop Details

14. If checked, displays the drop lengths on the screen (as seen above - note it is the same as the Design Estimating
Pro Specific, 8)
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Design Estimating Pro (contd.)

Text Overlay
15. Option can be on or off.

a. Text Overly - Displays overlay specified in the Item/Assembly of Design Estimating Pro Information.
b. Display On —Shows as part of the image used in the drawing. In this example, it is fixture “A” and “3 #12
THHN % EMT”.

=
 BEAaraiisaly miras=tis

Filter
16. Turn off options to drill down. The example below shows three Assemblies, one Highlight, one Region, one
Jump, and one layer. The layer is determined by the Design Estimating Pro Specifics for the Assemblies taken off
(Fixtures). Unchecking turns off display of that filter. Default Filters include:

- p e

Filter continued from the previous page
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Notes

Assemblies

Items

Job Assemblies

Job Items

Highlights

Regions

Jumps

Layers

All Labels Checkbox

o Se@ o a0 o

NOTE: Selecting the filter also highlights that element on the drawing

17. Listed below as left to right, top to bottom as seen on the toolbar.

a. Measure

1. Click Measure Tool.

2. When the tool appears, move the two points to the beginning and ending of what is to be measured
(straight line).

3. It will show the length based on the scale being used.

4. The +/- will add or remove a point of ending for multipoint measurement.
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Design Estimating Pro (contd.)

Tools (contd.)

b. Zoom/Pan

1.

ok wd

The Zoom tool is on by default.

It creates the inset window that shows what is on the screen relative to the drawing.

The bordered area can be dragged within the area of the drawing.

The pull-down turns the inset portion of the window on or off.

The slide-bar increases or decreases the size of what's on the screen relative to the drawing.
Shows the zoom as a percentage.

NOTE: Rolling the mouse wheel or clicking the Zoom + or - will also zoom in or out.

110 —) X
r@Aale
B eT
&= @~

1
‘4
(]

z|
i
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c. Rotate

1. If there is no takeoff currently on this drawing, this feature will rotate the drawing on the screen
as shown earlier.

» B

™

d. Cursor

1. Click Cursor icon
2. Cursor becomes long crosshair surrounding the pencil (not shown) for count takeoff and small
crosshair for length takeoff. The effect is similar to tracking on a plotter.

DU =00

Design Estimating Pro (contd.)
Tools (contd.)

e. Magnifier
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1. Click the Magnifier icon to create a movable zoom window.
2. Function tracks similar to a crosshair, but zooms what it passes over.

f. Note

1. This icon will let the user add a note to the drawing Click Note icon and Click at the desired location

on the drawing.
2. The toolbar will automatically switch to Select.
3. Type note text. The window may be resized or moved. Enter to start a new line, right click and choose

delete to delete text or choose Properties to modify the text type.
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g. Symbol Designer

1. Click symbol designer icon

2. When the designer window opens select file, new symbol.

3. On the left side of the window will be a list of symbols currently created/recognized by the
program. Select the new symbol you have made and rename it.

4. Existing Symbols may be copied and modified and moved up and down in the list.

Do 2800
A clole
O Te
o=y (]

h. Symbol Designer toolbar

;J 2 3 4& 5[ (~3|
LA A &

Line |[Rectangle] |Ellipse| | Custom Text Select

Fill: [v/] Im IStrokeSIze 15]
A T

1. Line function allows to freestyle draw straight lines for the symbol.

2. Rectangle function allows for the drawing of either a rectangle or a rectangular outline through the
added use of the fill and stroke options.

3. Same as the rectangle but for a circle or circular shapes.

4. Same as the rectangle and circle but for triangle shapes.

5. Text adds text to the symbol.

6. Selection of clipart/wingdings that can be used in the symbol.

7. Fill function allows for the different shapes to be filled in as opaque.

8. Stroke function allows for the shapes to be outlines instead of completely filled in.

9. Stroke size/thickness for the lines and shape outlines can be adjusted. Must be adjusted before
beginning to draw the line or shape.

-

98



Standard Training Manual - Electrical M

Design Estimating Pro (contd.)
Tools (contd.)

i. Jump Regions

1. Click Jump Regions icon.

2. This brings up the popup for accessing the Jump Regions.

3. The down arrow will minimize the list.

4. The bold arrow will return the user to the last jump.

5. The list will let the user choose a jump directly.

6. Highlighters, Regions or Jump properties may be viewed and modified by double clicking in
their areas.

7. Or by Clicking Properties.

j. Legend

1. Click Legend icon

2. It will bring up what takeoff has been done, including the symbol, count/length, and name. The
default location will be the upper left corner of the drawing.

3. By using Select, it creates a box around the current Legend, it can now be positioned it on the
drawing. Any further takeoff will automatically size itself to fit within this Legend box.

4. The Legend only lists the takeoff shown in the drawing. Takeoff not shown because it is not
checked in the Filter will not be listed in the Legend.

._
B

AR -
L Y .

¥

k. Pan
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1. Choosing the Pan icon will bring up the familiar pointing hand icon (not shown) that allows the
drawing to be clicked and dragged to a desired view. This is dependent on the level of zoom being
used. Panning may also be done by depressing the mouse wheel.

o X
H 2a800

o

(= Rl
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C—b@-e

v &
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I. Hotlist

A list of previously used assemblies and items for takeoff on the drawing can be selected in the list and
used again elsewhere in the drawing or on other drawings in the same job and same window.

1. Select which drawing to show the list of assemblies/items from.

2. Sort them in various ways. (Entry time, part name, items-assemblies, quantity.)
3. List of assemblies/items is shown here.

Design Estimating Pro (contd.)
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Zoom
18. Drawing Zoom control, plus [+] zooms in, minus [-] zooms out directly in the drawing. Rolling the mouse scroll

wheel will also zoom in and out.

Activate
19. Activates one window to work in when multiple drawings are open at the same time. The Green icon is active,

the Black icon is inactive.

Refresh
20. Refreshes an inactive drawing and show the takeoff done by another user.

Export
21. Exports the current drawing, or a selected area of the drawing, to another location using browsing tools.

Print
22. Prints whatever is showing of the drawing, or a selected area, like a print screen (this can be helpful if the drawing

is zoomed in).

Help
23. Opens Design Estimating Pro Help.

About
24. Shows the version of Design Estimating Pro.

22 24
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Marker Setup Ribbon
Highlight Toolbar
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Design Estimating Pro (contd.)
Region/Jump Toolbar

The Region, Jump, and Grid Properties are shown below.
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The Marker Setup toolbars are for creating and/or editing the marker features, including Highlights, Regions and Jumps.
As shown above, both toolbars are very similar. The user is only allowed up to eighteen (18) user-defined preset
markers, meaning each user can have their own presets. Definitions are below.
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Presets

1. This s the list of presets the user will also see on the Perform Takeoff toolbar. Hovering over them will show
what has been setup for each one, depending on if it is a Highlight or Region/Jump. This can expand to a total of

18 presets or minimize to a minimum of 3. This will include areas [3 above], [4 above], and [5 above], which will
be defined later.

Type
2. Choose between Highlight [2a above] and Region/Jump [2b above].

Shapes
3. Choose between 3 basic shapes, Custom (hand drawn by User), Rectangle, and Ellipse. These are the shapes the

marker will take on the drawing. That means the user may want to have a Highlight, for example, that is an ellipse
with a different color as an optional choice.

Design Estimating Pro (contd.)

Style
4. Fill and Stroke Colors
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a. Style - Fill Color/Opacity - This is common to the Highlight, Region/Jump, and Grid. Click on the drop-
down for a color palette with any number of colors. The Opacity slide bar controls how well the drawing
is seen through the marker. Practice is needed to get the optimum effect.

b. Style - Stroke Color/Stroke Size - This option is unique to Region/Jump markers. Stroke Color is the
color of the border when applied to the drawing. Click on the drop-down for an additional color palette
to choose different color options. Stroke Size is the width of the border when applied to the drawing. This
can be edited using the up/down arrows.

Grid
5. Can define characteristics of the grid before drawing. Such as width, height, color, the thickness, opacity, and
orientation.
Settings

6. Once the marker has been created/edited Click Save Preset to save the marker.

Select
7. These were defined in the previous section Perform Takeoff.

Tools
8. These were defined in the previous section Perform Takeoff.

Zoom
9. These were defined in the previous section Perform Takeoff.

Data
10. This option is also unigue to Region/Jump and Grid markers.

a. Show Data on Shape - Checking this box will show the ascending number for the Region/Jump or Grid
when applied to the drawing, as well as the A=/P=. [A=] indicates the volume of the area where the
Region/Jump or Grid is located on the drawing, and [P=] is the perimeter of that area.

b. Title - Enter either the Region, Jump or grid in this field. That is what will appear if Show Data on Shape
is checked.

c. Auto Suffix - Check this box to add the auto-ascending number to Title if Show Data on Shape is
checked.

d. Jump - Three options here; None, Sheet, or Global. This choice determines if the Region/Jump will be
shown in the Region/Jump window, should the user show it on the drawing [8g, defined in Perform
Takeoff].

i. Areatitles will not show in the list at all. None will not show in the list.
ii. Sheet will show in the list, but only when on that Sheet/Drawing.
iii. Global will show in the list and will go to that location from any Sheet/Drawing.
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Compare Drawings Ribbon

MolLormick

yesa

If a revised drawing must be used, go back to Job Details, and bring in the revised drawing as done originally. Once that

is done, follow the steps as shown below.
1. Select the original drawing using the Perform Takeoff ribbon, then click Compare Drawings ribbon in the Design

Estimating Pro tool bar.
2. Choose the revised or overlay drawing in the Overlay field.
3. Note and/or edit the Colorize Stroke for the original drawing using the color palette.

Design Estimating Pro (contd.)

4. Note and/or edit the Colorize Stroke for the revised drawing using the color palette (it's strongly suggested to use
a contrasting color).
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5. There may or may not be a new supplemental legend for this drawing.

Drag the overlay drawing so it matches up with the original.

7. Sometimes the overlay will be a different orientation than the original drawing. Even if the revised drawing is
saved in a rotated orientation, the overlay drawing will appear in its original form. The gray dot will allow the
User to rotate the overlay drawing to the same position as the original.

8. Any new changes are shown in the Colorize Stroke color chosen in steps 3 and 4. Any of the original takeoff
removed will be shown in the original drawings Colorize Stroke (Step 3). Any takeoff added will be shown in the
revised drawings Colorize Stroke (Step 4). Revise your takeoff in the drawings as needed. You may delete any
old takeoff that is now obsolete and do any new takeoff the overlay requires.

o

Auto Count Ribbon
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Define Search Location
1. Two methods to Define the Search location are:

a. Rectangle — Draw a rectangle by clicking one corner and dragging to the opposite corner of the search area.
b. Custom — Start at a corner and draw the line to mark an area. Clicking allows changing direction and double
clicking stops the line. The drawing above shows a custom area.

Search Criteria
2. Steps:
a. Marking an outlet for the search criteria in the drawing above.
b. Pull down arrow showing the search criteria list.
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c. Clicking the Paint Brush allows refining the image.
i. Select the eraser size.
ii. Select the pen color.

d. Clear Criteria
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Sensitivity
3. Match Rate can be set. A higher match rate shortens the search time. A user will obtain a feel for the match rate
needed after using it.
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Search
4. To begin Search:
a. Click Search icon.
b. Click Results icon to bring up the Search Results.

i. Exclude items with takeoff: will ignore any takeoff already completed when the box is checked.
The box is already checked as the default.

ii. Check All: checks or unchecks everything in the list.

iii. Check Selected: checks the boxes for anything selected. An item in the list may be selected by
clicking on it or multiple items in the list may be selected by holding the control key for
individual selection or shift key for selecting a consecutive group.

iv. Delete Takeoff: deletes search takeoff shown when the Exclude items with takeoff: box is
unchecked.

v. Accept Takeoff: will takeoff any of the Items checked.

vi. Remove From List: removes any Items in the list that are checked.

vii. Clicking an Item in the list selects it and checking the box marks it for takeoff.
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Takeoff and Select
5. Icons as shown previously.

Tools
6. Asshown previously.

Zoom
7. Asshown previously.

SECTION Il Additional Job Estimating Information
Help
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MCCORM | C—————
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9‘& yrio wirfhock Ihe lollowing Help Tophos see svallalne ) . .
:§i.j"...:::'~. Login The basic Help screen, as shown at left, is the typical menu style that most of
3 e 1 ot us are familiar with from other Windows programs. Access by using the
) Sl s Help tab and Help Contents icon in the ribbon. This style requires you to
§ R know where the information is contained that you are looking for. The
i : the:2 W breakdown is pretty self-explanatory and shouldn’t create any problems, but
: we have provided a much more User friendly method of using Help.

MPPS j s | g Assenmbly Ust
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: This alternative method is what we call context sensitive. In other
8. e words, it goes where you are in the program (this example is an
I Assembly takeoff window). To use this feature, put focus on the

v area in question; i.e., a takeoff window, menu, Audit Trail, etc.

: Then hit the F1 key on your keyboard. It will bring up the help

FE—— window for that area. You will notice it also has the accompanying

S text describing the help topic and the green highlights that will lead

to related information.
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The note at the top of the window directs you to “Click on the Area you would like Help With”. Moving the cursor
around the image will produce a pointing finger. Point to the area you have a question on and do a single Click, such as
Menu. This will then prompt the help screen to go to that area as shown below.
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You can continue this process up to the point that a link to the actual database is necessary, at which point you will get a
final text box with help information. The below example shows clicking in one of the menu columns. Because it isn’t
able to actually go there in the database, you get a pop-up window that describes what the action is.

TR e SR A
o vex Gs i

=Tk

Takeoff Menu List

ek ot 1hn 2as pous wndd ik Halp Wi

To get out of help, hit Back until you’re where you want or just close the window. You can always print any information
on the screen and make your own reference manual for those areas you use frequently.

Additional Job T aem = o |/ . Estimating
Information (contd.)
Menu Set-up EEN CTEE R T
ResesRoge | Cabe 4 18-t R0kE
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NOTE: The Takeoff Menu Setup remains the same for any estimating product you use.

This screen allows you to add or customize the categories & sub-categories that make up the Menu window (right side),
allowing you to set-up new menu lists. To change any existing entry, first click on the Setup (1) button in the lower right
corner. Double clicking in a column will shift the focus to that column. You can add, rename or edit the entry in the box
above the list. To add a new category or actual part, click on the AddMode (2) button.

AddMode
Once you enter AddMode any takeoff lists you have open will now show a Transfer (3) button located just above the tab
bar along the bottom of the Takeoff window. To transfer parts or headers into your menu system follow these steps:

e Select the column where you would like the part or header to appear in the Takeoff Menu.
e Highlight the part or header in the takeoff list and click on transfer.
e You can keep transferring headers or parts until your menu lists are complete.

NOTE: You are allowed to create one more level to the Menu window by selecting the Open Level button. If used, this
column HAS to be a “link” back to the actual database.

Tip: Once you have made a Transfer of an Item/Assembly or Header that stops the path. You cannot create a sub-link in
the next column.

CAUTION!!! Although there is a Security check that by default is unchecked to limit how many Menu Items are
Deleted, be careful using the Delete button.

Workspace Listing

NOTE: The Workspace Listing will vary based on the estimating product you use.

The Workspace window in McCormick’s Win Product offers you an easy way to select items or assemblies that you
frequently use together. The software comes loaded with a large number of pre-defined workspaces or you can set up
your own unique workspaces.

Shens . " . Shorcuts :
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Tip: While the takeoff menu offers a convenient way to select a part in one takeoff window, workspaces allows you to
select parts in many takeoff windows at the same time.

Workspace Pages
Shows the list of workspace pages that are available. To open, click on any workspace page in the list on the left side.

Close When Found
This option causes the selected screen to close once a match or action is performed. This is useful when you know you
will only be using the selected screen minimally.

Additional Job Estimating Information (contd.)
Workspace Buttons

e Click on any workspace page in the list on the left side to access the page of available shortcuts. Choose a button
to open the shortcut to the items and assemblies that are included in that workspace button.

e To define a new workspace button, set-up the Takeoff windows and Audit Trail you want to save as the new
workspace, and then open the Workspace Listing window. Select a page and right-click on the button you want to
save the workspace to. Select Snapshot Plus, and then enter the name for the new workspace button. Saving the
new workspace will take a snapshot of the configuration of Items and/or Assemblies windows that were open at
the time the workspace was saved, including the Audit Trail (using the option Snapshot will NOT include the
Audit Trail in the shortcut).

Deete
Farare

Seapadet -
Define Workspace Button Seapaset P
Enter new Workspace Button Name L 0K | asdaneid
. —— et
I Cancel ] - %
/ b
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Tip: Snapshot only saves the Takeoff windows open at the time the button was defined. Snapshot Plus will save both the
Takeoff Windows and the Audit Trail. A toolbar button snapshot saves all the windows open at that time, including the
Audit Trail.

M,
Taare Dt e
e . New Workspace Page
o fopes : Enter new Workspace Page Name oK

/ Cancel I

New Workspace Page

Choose Set-up from the Workspace window to get the above left window. In this window, choose New to get the New
Workspace Page window on the right. Entering a new name will give you a new, clean page to customize any workspace
buttons you need.

New Workspace Name
Choose the current Workspace page name from the list on the right and choose the Rename button. Just enter the new
name you want for the workspace page.

M Labor Categories : = R
Labor Categories: / [
N i, | -

Labor Categories

[

SUSPENDED CEILING X 1.0 il =

SLA&B x07 0.7 Move
STANDARD Cat.
TRENCH CONDUIT__ X06 | 08N\, [ 1 |
METALSTUD X1.25 1.25
MASONRY X 20 2
2 PARALLEL RUN WIRES X 0.90 0.3 E
4 PARALLEL RUN WIRES X 0.85 0.85

6 PARALLEL RUN WIRES X 0.80 0.8
BPARALLEL RUNWIRES X075 |  0.75v

Close

NOTE: The Labor Categories will vary based on the estimating product you use.
This screen is used to create or modify the settings that are available for use with a Takeoff list or Audit Trail. Since
Labor Categories are Job specific, you may use the Paste From screen to save you from having to recreate new categories
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for each job. If you choose not to paste in new settings from a previous job or template, the above settings are reduced to
Default Labor (X 1), Easy Labor (X .05) and Difficult Labor (X 1.5).

Labor Category Name
This box contains the name of the labor category. McCormick comes loaded with several standard labor categories,
which can be used as is or customized with your own identifying names.

Tip: If you include the Factor as part of the Name, it will show up as part of the takeoff window during takeoff without
having to constantly use the pull-down or refer to the Audit Trail.

There is a blank line at the bottom of the labor category list where you can enter additional labor categories. There is
virtually no limit to the number of labor categories you enter, however you are limited to 32 characters for the labor
category name.

Labor Category Factor

This box lets you enter an adjusting factor to the labor category. For example, you might want to include a factor of 1.5
for difficult installations, or 0.5 for easier installations (assuming 1 is a typical installation.) This factor is used in
Extension to adjust the labor unit associated with any line item of takeoff.

Tip: Once you create or edit a Labor Category, you can move it up or down in the list using the buttons on the right.

Additional Job Estimating Information (contd.)
Price Updating

To
sisair Lpdats
5 “Upcain Cirvgea sty | Updl!;
an
Hatrrad Freng Serves  Tanada | £
s Lo W 3 | Hew
Delete

Close

Price Updating allows you to update your current database with the latest price and labor specifications provided by third
party sources (Pricing Services, Suppliers, etc.). If you have already run a successful update, select the UPDATE option.
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hcCormick WinSystems 3

& | "CAUsers\Public\Documents\McCormick

This operation will modify your parts database,

Systerns\WinProducts\DataSales\MWPPARTS,MDB"
Are you sure you want to do this?

\ .

WA
MCCORMICI(™—

Now you will be prompted for your “printing preferences”. Select the options you want (usually No) and continue on.

McCormick WinSysterns

\.Oj\ Would you like to print the price changes report?

23 tcCormick WinSystermns

D

MNo

[O) Would you like to print the deleted items report?

| 23

MNo

You have one last chance to cancel the operation.

kcCormick WinSystems | 23

“ = ) This is your last chance to stop the update,
QY Continue with update?

Yes MNo

| |

R Pl

You may begin your other program's price
~ update procedure...
(Double Click on the plug if you wish to
cancel)...

When you receive the message Start your update application now, start your third party application as you normally
would (notice you will be unable to minimize McCormick). Once your third party application has started its update,
monitoring will be returned to the McCormick.
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Before updating the database prices, read the bulletin that the pricing service sends with each price update disk. The
bulletin contains information on changes in vendor number (UPC/EDP/DCI code), prices, new items, discounted items,
etc. McCormick Systems supports many different Price Updating services with more being added all the time.

Tip: If you would like a specific vendor added to the list of supported formats, contact your vendor and let them know.
We will be happy to work with them directly. Just have them call us.

Additional Job Estimating Information (contd.)
Pricing Configuration

< Database Update Edit X
Update Configuration Close
Trade Service Tra-Ser for Windows - USA [w] —

Database Information | Delete
Update Specification
Book Price [+ ] [V] Update the ‘Last Run' Column [ New CU
Compare Specification System data path
DCIC : i : [ New UPD

ode [+] CiUsers\Public\Documents\McCormick

Service Information ! The specification

Format with in the
- AR database that you

Trade Service for Windows ]
Price want updated.
Column3Price E]
Unit
Unit v}
Update Path and File Suggested Block Size 128
%SYSDATAPATH%\trade.dat [ 28

If this is the first time you are run the price updating function, you will need to create a new Update Configuration. To do
this, select the format that your data is in from the previous screen and select EDIT from the buttons to the right.

This screen allows you to define the parameters of a new or current Update Configuration. Keep in mind that you will
only need to create a new CU or UPD file the first time you run an update for each vendor.

rcCormick WinSystems 23

Is your Tra-Ser or Epic update program installed on your local

computer?

S T
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A

"

MecCormick WinSystems MecCormick WinSystermns @

Please edit this file and path if not correct: Please enter the Industry Code to be placed in the
CU file:
Cancel l Cancel ]

tdcCormick @
Please enter the file name for the new UPD file:
Cancel I
INEODO:LIPD

MCCORMI|Cj(—

Year-Month, one prior ]

McCormick @
Please enter the issue for the UPD file:

Cancel ‘

e

NOTE: Most third party vendors may be emulated by modifying the data on these screens. If you have any questions
on the information needed by your vendor, please contact Technical Support.

If you are performing this process as the result of a failed update, you will be prompted that the file already exists and

would you like to overwrite? Your response would be Yes.

tcCormick WinSystems

4% The file "CA\Users\Public\Documents\McCormick

you like to Overwrite?

" o / Systems\WinProducts\DataSales\WING000.UPD" already exists would

Yes

| | Mo
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Additional Job Estimating Information (contd.)

Setting up McCormick for use with Tra-Ser SX

HownpE

Open any job, go to the Jobs tab and Update icon in the ribbon
You will no longer be using the top selection Trade Service Tra-Ser for Windows after this.
Click New, add Tra-Ser SX as the Description

Select Tra-Ser SX Internet Transfer from the Update Format pull-down.

A

Lact Fun

'.;An [

5. This will open up the Configuration dialog.

x|

This should be the Default, even
if you don’t have NECA

Update Modud

The Price update logs can be
placed local or on a network so
other Users may access them.

Parts Dataace

T ‘ LogRapon Locason

Tre Sér S Aot oum

Tre Sér X Panamind

Last Issue Processed starts out
blank. This will give you the last
5 years of updates. Once an
update is successful, it will auto
fill with the date. This field
cannot be modified.

e

Windswe Accoud

Fe e
Selact Doe parte dutebiase, orte the Tea-Ser S0 Logn infarmbtion, muteh e (ks ard
St e Bold match casbpurdtian You cas les perfam o 2oce wpdale tom
= Vst Price snd NECA Lavst
Uiptutn NECA Labyar Orly

Lo Issim Pazessed 19-2)
/'Emu- statterdyd ipdate ¥ Oy of Wask [Mooday

Upden Pacw Orly
Viaktats LOCOC! Coden

INEPARTS MO8

C Pricelpdatalogs

Fofam Pece
Uprdate Now
]
Fomay G ccomchi s s com

Price Podte Cody 5025
Ltsos Last Lpdated On | |

| Tem fvo0 #u—=

Do Fasswud

WCamek Pl lame

Tea-See SX Fait towrrm
Coluns 3 Price
o] UFC

=| MECAT Mamal Laasr Fste

=| MECA2 Dveatt Labor Ryse

=1 MECAD Vary Dot Labar Rate

You can use this button to begin
the update, BUT we would rather
you closed this window and hit
the button on the previous screen.
This will kick out all the other
Users and begin the update.

This is only used if you have
multiple databases attached to
the same program.

If the User fills out the
unattended update section with a
valid windows account, it will
start the update at the designated
time.

'5:;‘;:-:_1’.:' Hebash T-:";;o‘;i's: Custom i Rapcst Files 1
A
The McCormick fields need to be )\l 1Zt \

matched to Tra-Ser SX fields.
This example shows the most
common scenario. You can
update multiple price columns at
the same time if the User has the
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Save Update
Configuration saves
your changes.
Refresh Tra-Ser SX
will refresh any
change Tra-ser files.

Security &t

prs to Groups

I

MCCORMI|Cj(—

Reports are not printed by
default, they are stored. If you
hit the View Report Files button,
you will have access to the
report archive. You can then
print any past successful reports.

ob-specifc o | =
6 Allow All
escr

s

Alow

Ji<ie|<|]€l]lells

i o User Mai
3 (
5 Copy Defaults
m.a/,u[ 2py Daina

-

Close

NOTE: Access to Security will vary based on Security setup and the estimating product you use.
The software also allows for creating individual Users with specific levels of security. This function is limited to those
with ADMINISTRATOR level of security in general or only those that have been assigned the authority. Access using

the Configuration tab and Security icon in the ribbon.

The Security window allows you access to the different areas of security. It is broken into two main sections or SCOPE.
The GROUP selection (1) allows the Administrator to make general changes to an entire group at the same time. The
USER selection (2) allows the Administrator to define the security to an individual User, regardless of the group
assignment. This will allow very exact functions using the AREA (3) and ELEMENTS (4) within that particular area.

| x| M

M User Maintenance

Select User: | v

User Maintenance

Enter User: Iiichael Carison

Enter Password:

New Password:
Confirm Password:

Auto Log Off

When idie for minutes, Apply to All Users

Cancel

Auto Log Off

When idie for 120

minutes. Apply to All Users

Cancel

OK

The first step or option is to go to USER MAINTENANCE (5). This area will allow you to do one of two operations.
Assign either NEW PASSWORDS as shown on the left, or create a NEW USER as shown on the right.

NOTE: The User Name is used on reports and the sign-in list. Therefore “cute” nicknames such as Bubba, Buffy,

and Slick are not recommended.

Once the New User is assigned a name and password, the next step is to assign the DEFAULT settings (6).
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MCCORMI|Cj(—

Additional Job Estimating Information (contd.)
Security (cont’d.)

f‘ Copy Defaults =) 82| A Keyboard Admenistration

rom one user to another

P L Toook” 3l
orkspace _l

4 4
Close FJ J | o -L&;

Default settings provide KEYBOARD MAPPING (1) for utilizing the same keyboard commands that were used in the
original DOS application and the automatic input of takeoff. This is also used to copy default TOOLBAR buttons (2) and
the WORKSPACES (3) the User will work with inside the program. The new User is the DESTINATION (1) in the
above right window. Choose an existing User that has the defaults needed for the new User as the SOURCE and
highlight the first default in the list (2). Use the right pointing arrow between the two windows (3) to transfer the desired
defaults to the new User. The list will automatically advance to the next choice and continue to transfer as you click on

the right pointing arrow. It will also notify you if everything has been sent or a duplicate exists. When done with each
default, click CLOSE (4).

NOTE: All three types of defaults MUST be created for every User, regardless of final level of security assigned to the
User.

M Security Group Membership o R
User: v

Available Groups! Member Of:

| Estimators |
Guests >
Senior Estimator

L M Security Group Membership o R
User: Michael Carison W

Member Of:

[ Estimators
Estimators p—
Guests Bl
Senior Estimator
< |
2] 0
7 %
Groups Close Groups
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The next step in the procedure for creating a new User is to assign the User to a GROUP. We have three (3) levels of
security already in the program. Each level of security has its own distinct capabilities as follows:

GUEST - Has no rights. All new Users automatically get this level of security. It is a look but don’t touch function.

ESTIMATOR — Has limited rights within the program. There are two very specific restrictions on an Estimator that need
to be considered when assigning this level;

1. An Estimator is NOT ALLOWED TO EDIT THE PERMANENT DATABASE! This is probably the single most
important restriction on the Estimator level of security. This is critical to maintaining the pricing and labor
correctly and not compromising the integrity of the database.

2. An Estimator CANNOT enter another job unless the Lead Estimator on that job has assigned them to it. An
Estimator CAN start a job of their own and see it through to completion.

SENIOR ESTIMATOR - Has rights specifically devoted to Edit Extension. This User would only have rights to make
changes to existing saved Edit Extensions on a job. If the Senior Estimator is doing actual estimating, either Estimator or
Administrator would make the better choice.

ADMINISTRATOR — This is the highest level of security in the system. Has unlimited rights to any and all areas of the
program, unless previously curtailed by a designated “SYSTEM ADMINISTRATOR?” that has overall control of security.
In those situations, the System Administrator will disable certain functions of security per group or User, and also prevent
any other User, regardless of level of security, from accessing SECURITY at all.

NOTE: Only one level of security should be chosen for any User. Multiple selections of security will cause a conflict
in certain areas of the program, resulting in the program opting for the LESSER of the securities.

It is possible to create new GROUPS of security with customized functions, but that is an advanced function and should
be discussed with a qualified tech at McCormick Systems Inc. before attempting.

Additional Job Estimating Information (contd.)
Job Backup/Restore

A by R
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Backing up a job is a matter of telling the program where and how you want to back it up. As the window
above indicates, you can give the job a name by typing it in the File Name field. Job names can be whatever
you choose. The entire path will be shown in the File Name field when the window appears.

You can also choose the destination of the backup using the Save in field. One option might be to create a
folder for old jobs on your hard drive, or folders for each of your Users. You can also back the job up to any
media your system recognizes using the pull-down, giving you a list of available media (disc, USB drive, etc.).

Save v | L) M Doouvend . (i3 23

Ny aiocks

49 Ares Mo

My Recend Zirey vaures
Doosrents - et Forn F

©,

Do

Ny Cocunents

'.&g

My Compatm

W)  reowe T -] |
] =

My Histed J v ot g » 3] Cawed |

Restore is the exact opposite of a backup. Select the media you backed up on (or the folder you backed up to), select the
archive file, and click OK.

B dub Aschive Infoimation

— D ata found in Archi

dobrMame  Advancacd Training
Job Databaze Marme:  CAADVTRMEADATAMO000004. MDE
Archive: TATEMPRADVTRNG ZIP
Dacksd up by Admin
Backed up on:  12/1/93 B:31:34 AM

— Select Restore Option:
T Ragtore To Same Job Advanced Training-[lob 4]

1 doh Salectad andob Seean Advancead Training-[ob 4]

® Create Mew Job From Backup

|_cancel |

Once you have chosen your archive file, the program will process the restore and bring up the above window. Note that it
contains all the backup information from when the file was created in the top portion.
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Select the Restore Option you wish. You probably will NOT see the first option most of the time since it only comes up
if you are restoring the exact same job to the exact same computer it was backed up on. The default choice is to Create

I

New Job From Backup. This is the logical choice for a first time restore on another system, since it will likely be

another job number entirely.

If you work in this job and decide to back it up and take it back to the original source, it is recommended that you

highlight the original job in the job list, select Restore from the Job Screen, go through the restore process and then select
Job Selected on Job Screen from this window. This will overwrite the old job with the new job containing the additional
work. You can, of course, choose to restore the backup job back to the original system as a new job, but remember you

will then have two jobs with the same name, but different job numbers (the higher the number, the newer the job).

Additional Job Estimating Information (contd.)
Backup — System

Uses naone
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NOTE: The number of system backups available for each company may vary based on the estimating product you

use. —
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This utility will also be automatically accessed the next time you open the program, should you exit our estimating
program improperly (shutting off the computer in the middle of the job, either on purpose or by accident for example). In
which case you would select REPAIR & COMPACT and select those areas you wish to fix. If it is a job, you should
choose the job you were in and all three of the databases (System, Application and Parts), but the Parts as a minimum.

Also, it’s not a bad idea to run the

File  Help

REPAIR & COMPACT on
. Databaze Path

everything at least Copyright @ 2011 e b DacunetMeCamick Syt Dt once a week. Use the
backup utility A VAN McGomck Spvms . (FRsrs whenever you are
doing any kind of Mccormick 'R e s major database
management. Use it PRSI — as frequently as

H — Lockad By Locked On 17412013 957:2227 |
possible to save your N work.

! — T A1
Backup [ Fepsvdénd Cc 4 - Automatic 5' Lock Syst .J,,
Database # Type Selected  Locked — J Lock Achions.
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! Urlock System
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Additional Job Estimating Information (contd.)
Backup — System (contd.)

The Lock System (1) tab allows you to set a system message (2) and lock the System Database (3). The system logs who
it’s locked by (4) and the checkbox (5) indicates it is locked. Any Users will get a system message that the database will
be locked and gives them a logout now button, if the User is not at their desk it will log them out safely after 5 minutes.
They will get the following message if they try to log back in, until the Systems Database is unlocked.

[ Microsoft Access ‘

Logins are currently disabled due to Prevent unauthorized backups/restores,

You CAN backup the parts database by itself and copy it to any other install of our software (i.e., on a laptop or another
system in the office). There are a number of reasons you would not want to copy the System database to any other system
than its original, mainly because the backup may have old information on Users and job names.

NOTE: Use the Database Types and Select Actions to make pre-set choices as indicated. (Such as selecting all the jobs
at once)

Graphs

Graphs are available for Bid Summary by selecting the Bid Summary ribbon and Top Sheet in the Graphs area. These
Graphs automatically come up as pie charts.

- e -
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You have the same options as the Extension graphs, with the added ability to “Drill Down” on any slice by selecting

DRILL DOWN in the
lower right ™™ Bid Summary . @ B corner.
Proposal i = T ot LTS
Opening L S T TV e s Proposal
| ) 10] 5200803 ! Ovarhiend mesn
NOTE: the 5T - ron 2333 14 Proposal
N f t Thistun § 858 s€3 07 d t t
information T ih and conten
may vary prea $o41 403 11 based on the
Es_timating = = :L. M‘::‘f product you are
using. :::‘“ = 'w : : ob Mere 70 Sekadont wmn
[ — vwx;. Al Watensl oy v Al Yours 40,005 RS o
| $000 | Ssessr | | oo emsan Waress/Day ¢ ta) Pricafq %0
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Rt 300 ol

The Proposal feature integrates Microsoft Windows® Word ™ directly into the McCormick estimating program to use
existing templates and/or create new templates from scratch or by importing from existing documents outside the
program. Initializing the Proposal feature can be accomplished a number of different ways.

1. The first, as shown above, is to open Bid Summary for a job;

2. Click on the Proposal tab along the bottom of the window.
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MCCORM | C—————
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1. The second method is to Click the Bid Summary tab in the ribbon;
2. Then Click the Proposal Sheet icon under Tools.
Additional Job Estimating Information (contd.)
Opening Proposal (contd.)
A - NAcCarmevck WinSxstoms (v R - " IER
w - ' 7 * € L Ry L F
¢ ! \*l
1. Or, Click the Tools tab in the ribbon;
2. Then Click the Proposal Sheet icon under Tools.
J- son A
Aa Title 0 Titie Title
@ Open Othey Documents — p—
Title ::’-':I'I .L .:'-.:v.': . 9

1. At this point the program will launch Word.
2. To begin, Click the Blank document as shown.
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1. It will open a Word ribbon;
2. And a blank document.
3. To start our Proposal process, the User must Click on the McCormick tab in the ribbon.

- %)

IR o i S AR AN Sk

GRS

1. This will bring up the McCormick ribbon for Proposal;
2. And the User will still have the blank document.
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1. Once in the McCormick Proposal ribbon, Click Open;
2. Choose the location of the proposal you would like, such as System Template shown;
3. This will present a list of existing System Template proposals. Click the one you want.

Additional Job Estimating Information (contd.)
Editing Proposal
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1. If the document has information that needs to be changed, highlight it;
2. Click the pull-down for the Job Field;
3. Choose and Click on a field from the list you want to use.

NOTE: The choices in this list are from whatever the User has already setup in Job Details.
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1. The field will then replace what was previously highlighted.

Additional Job Estimating Information (contd.)
Editing Proposal (contd.)
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3) Frenching

It's also possible to create fields for specific information from the job. In this instance, the User wants to be able to pull
the Sell Price directly from the Bid Summary for this job. To begin, locate where on the document you want the data (in
this case we highlighted an existing field).

1. Click the pull-down for Summary and choose the appropriate Summary to be used;

2. Click the pull-down for Section to choose where in the Summary you want to get the data;
3. Click on the pull-down for Field and Click on the specific field containing the data;

4. The correct field will then be put at the previously selected location.

Merging/Displaying/Saving Proposal
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1. Once all the fields are created, the User may want to see/check the results;
2. Todo this, Click on the blue Merge button.

NOTE: If Merge to New is NOT checked, the merge document created will be the final document and will have to be
saved as such; i.e., a Word document or a System/Job Attachment (see below). If Merge to New IS checked, the User
will be able to close the merge document created and return to the original document being edited.

Additional Job Estimating Information (contd.)
Merging/Displaying/Saving Proposal (contd.)
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1. The resulting merge document will be presented as a Word document with the Word ribbon;
2. The previous merge fields will now be populated with the data they were assigned to retrieve;

136



Standard Training Manual - Electrical M

nfo
Protect Docurnen Braperties
rsp
8 Tomern
Save As
@ 2L SOmpe
r: Compaites :?v.;m_‘
o+ Add s Place /
8 - =
— ¥ . i. Locate where the document is to be saved;
i ii. Name the document;
== e ] iii. Click and Save the document.

Additional Job Estimating Information (contd.)
Merging/Displaying/Saving Proposal (contd.)

3. Click File and use the standard Word functions to save the document as shown in the above three images;
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Microsoft Word

1 Want to save your changg#s to\Document3?

If you click "Don’'t Savef, a recenycopy of this file will be temporarily available,
Learn more

Ve Cancel

4. Click the X to close the document if needed. The choices are as shown above. The Save will do the same as the
previous steps or can be used to save the document permanently to this job as a Job Attachment. The Don't Save
will simply close the document.

i =T

1. Click on the McCormick tab in the Word ribbon to bring up the McCormick Proposal ribbon;
2. Click on Save As;
3. Click on Job Attachment.

Coiles Tilengine u

o w raeva b2t 13 | e o%
2 /-z.u‘
- 1 l

I Preccen v Nercar 11518 / -J

1. Name the document with a unique name so it can be identified within the job;
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1. Inthe future, if the User needs to open this document, go to Proposal (as described earlier), Click on Open;
2. Clicking on Job Attachment will show the documents saved and the actual path to find them.

Additional Job Estimating Information (contd.)
Importing Proposals
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1. Open Proposal as previously described, it will bring up Word,;
2. Click and open Blank document.
f AsbCrDy  AaBbhTche B Aatﬂ Aabt Aafivrly  Aclblce AsBbCcy  Asabicn ,'f.

1. Click FILE from the Word ribbon;
2. The User still has the blank document.
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1. The Open screen opens up;
2. Find documents by clicking on Recent Documents;
3. The User does a Click on the document to be imported.

Additional Job Estimating Information (contd.)
Importing Proposal (contd.)
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1. The User can also Click on Computer;
2. Choose from the options, such as Browse, to find any document and Click to import.

- k|
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1. Outside documents can also be imported from the McCormick Proposal by doing a Click on the FILE tab and
following the same steps as outlined above. Once the document is imported,;

2. The Useris
still in the Word
ribbon;

3. Click on the

McCormick tab.

Additional Job Estimating Information (contd.)
Importing Proposal (contd.)
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1. Highlight any text to be replaced;

2. Click the Job Field to find the appropriate replacement field;
3. Click on the field to replace the text.
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Notice the inserted field replaces the text and the following line is moved to the immediate right of the field. Enter to
move the text to its correct position on the next line.

Additional Job Estimating Information (contd.)
Importing Proposal (contd.)
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1. Replace all text with appropriate merge fields;

2. Click to Save As;
3. Choose how the new document is to be saved, such as a System Template if it is to be used for future jobs, or a

Job Template if it's to be used for just this job.
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1. Give the document a name;
2. Click OK button.

iy 142015

In the future, the User can Click on Open;

Click on System Template;

Hover over the template in the list;

Information concerning that template, such as who created it and when, will be displayed.

HowndE

Additional Job Estimating Information (contd.)
_Importing Proposal (contd.)
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Return to the Word ribbon;

Click Insert tab;

Click to choose what is desired to be inserted in the document, such as Pictures;
Browse to the location of the desired pictures, etc.;

Click on the choice

Name the choice;

Click Insert.

NookrwbdE
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The image will be inserted into the document at whatever location previously chosen and can be edit as to size and
placement using Word functions.

APPENDIX I EXERCISES/TECHNICAL SUPPORT INFO
Job 1
1. Start a New Job called Job 1

Paste the 3 Defaults + Bid Summary

2. Create Labels for Takeoff:
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Build Labels:  Bid Package Column 2 Column 3 Column 4 Column 5
Base Bid <none> <none> <none> <none>

3. Takeoff the following Assemblies:
100 3#12 1/2" EMT DI/S STRAP
50 DUPLEX STD
4. Extend:
Change “Summary #1” to “Base Bid” if not already done.
Chang the Extension Report to “Edit Price 1 & Bid Labor by Cost Code”
Set the Material Filter to “<none>”
Click the “Send to Summary” icon.
5. Bid Summary:
Base Bid
Labor Hours
Journeyman/Wireman | 100% |
Taxes
Materials | 6.5% |
Overhead — All | 10% |
Profit — All | 10% |
Mark-up Tax | Yes |
Job 2
1. Start a New Job called Job 2
Paste the 3 Defaults + Bid Summary
2. Create Labels for Takeoff:
Build Labels: Bid Package  Column 2 Column 3 Column 4 Column 5
Base Bid <none> <none> <none> <none>
3. Takeoff the following Assemblies:
2000 2#12 1/2" EMT DJ/S STRAP
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100 DUPLEX STD
50 3w STD
10 TEL, WALL 3/4” RISER

4, Extend:

Change “Summary #1” to “Base Bid” if not already done.

Chang the Extension Report to “Edit Price 1 & Bid Labor by Cost Code”
Set the Material Filter to “<none>”

Click the “Send to Summary” icon.

5. Bid Summary: Base Bid
Labor Hours

Journeyman/Wireman | 100% |
Taxes

Materials | 6.5% |
Overhead — All | 10% |
Profit — All | 10% |
Mark-up Tax | Yes |
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Job 3
1. Start a New Job called Job 3
Paste the 3 Defaults + Bid Summary
2. Create Labels for Takeoff:
Build Labels: Bid Package  Column 2 Column 3 Column 4 Column 5
Base Bid <none> <none> <none> <none>
Alt1- Add
3. Takeoff the following Assemblies:
Base Bid Alt1 - Add
3000 2 #12 1/2" EMT D/S STRAP 2000 3#12 1/2" EMT DI/S STRAP
200 DUPLEX STD 20 GFI STD
150 SP STD 20 3wW STD
10 TEL, WALL 3/4“ RISER 10 TELE-POWER POLE
4, Extend:
Change “Summary #1” to Base Bid, the Extension Report to “Edit Price 1 & Bid Labor by Cost Code”
and the Material Filter to “<none>”, if not already done, then click the “Send to “Summary” icon.
Change “Summary #2” to Alt 1 — Add, the Extension Report to “Edit Price 1 & Bid Labor by Cost
Code” and the Material Filter to “<none>”, if not already done, then click the “Send to “Summary”
icon.
5. Bid Summary:
| Base Bid | Alt1- Add |
Labor Hours
Journeyman/Wireman | 100% | 100% |
Taxes
Materials | 6.5% | 6.5% |
Overhead — All | 10% | 10% |
Profit — All | 10% | 10% |
Mark-up Tax | Yes | Yes |
Job 4
1. Start a New Job called Job 4
Paste the 3 Defaults + Bid Summary
2. Create Labels for Takeoff:
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Build Labels: Bid Package = Column 2 Column 3 Column 4 Column 5
Base Bid <none> <none> <none> <none>
CO1-Add
3. Takeoff the following Assemblies:
Base Bid
3000 3#12 1/2" EMT D/S STRAP
30 DUPLEX STD
12 SP STD
8 TEL, WALL 3/4“ RISER
5 TELE-POWER POLE
CO1-Add
750 3#12 1/2" EMT D/S STRAP
20 DUPLEX STD
2 GFI STD
5 SP STD
6 3W STD
4, Extend:

Change “Summary #1” to Base Bid, the Extension Report to “Edit Price 1 & Bid Labor by Cost Code”
and the Material Filter to “<none>”, if not already done, then click the “Send to “Summary” icon.

Change “Summary #2” to CO 1 — Add — Change the Extension Report to “Price 3 and NECA 3” and
the Material Filter to “<none>”, if not already done, then click the “Send to “Summary” icon.

5. Bid Summary:

| Base Bid | CO1-Add |

Labor Hours
Journeyman/Wireman 100%

Foreman 100%
Taxes

Materials | 6.5% | 6.5% |
Overhead — All | 15% | 15% |
Profit — All | 25% | 25% |
Mark-up Tax | Yes | Yes |
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Create a new job: Build Assemblies

Paste the 3 Defaults + Bid Summary
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Build Labels:  Bid Package Areas Column 3 Column 4 Column 5
Base Bid Offices <none> <none> <none>
Alt. 1 - Add Conf/Emerg
Alt. 2 - Add Service
CO1-Add Panel/Feeders
CO2-Add

Modify the “FIXTURE A” Job Assembly to have the following ByProducts:
1-“FIXTURE A” Job Item
1 - %“2X4 TROFFER 3 LAMP” assembly

Build a “FIXTURE 1-A” Job Assembly at line 100080 using 1 — “FIXTURE A” Job Assembly:
Modify the quantities of the following ByProducts as shown: 1 — “4/S BOX 1-1/2"' DEEP”,
1 -“4/S BLANK COVER”, and 1 — “MISC. BOX HANGER”.

Build a “FIXTURE 2-A” Job Assembly at line 100081 using 2 —“FIXTURE A” Job Assemblies:
Modify the quantities of the following ByProducts as shown: 1 — “4/S BOX 1-1/2" DEEP”,
1 -“4/S BLANK COVER”, and 1 — “MISC. BOX HANGER”.

Build a “FIXTURE 3-A” Job Assembly at line 100082 using 3 — “FIXTURE A” Job Assemblies:
Modify the quantities of the following ByProducts as shown: 1 — “4/S BOX 1-1/2" DEEP”,
1 -“4/S BLANK COVER”, and 1 — “MISC. BOX HANGER”.

Build a “FIXTURE 4-A” Job Assembly at line 100083 using 4 —“FIXTURE A” Job Assemblies:
Modify the quantities of the following ByProducts as shown: 1 — “4/S BOX 1-1/2" DEEP”,
1 -“4/S BLANK COVER?”, and 1 — “MISC. BOX HANGER”.

Build an “OFFICE 3-A” Job Assembly at line 100084 using 1 — “FIXTURE 3-A” Job Assembly.
Replace the “4/S BOX 1-1/2” DEEP” with a “4/S BOX 2-1/8” DEEP”.

Build an “OFFICE 4-A” Job Assembly at line 100085 using 1 — “FIXTURE 4-A” Job Assembly.
Replace the “4/S BOX 1-1/2" DEEP” with a “4/S BOX 2-1/8” DEEP”.

Add 1 - “SP SP STD” Switch Assembly to the “OFFICE 3A” and “OFFICE 4A” Job Assemblies

Add 15-“5#12 1/2" EMT D/S STRAP” Branch Assemblies to “OFFICE 3A” and “OFFICE 4A” Job Assemblies
Add 4 - “DUPLEX STD” Receptacle Assemblies to “OFFICE 3A” and “OFFICE 4A” Job Assemblies

Add 65 -“3#12 1/2" EMT D/S STRAP” Branch Assemblies to “OFFICE 3A” and “OFFICE 4A” Job Assemblies

Use Labels: Base Bid Offices <none> <none> <none>
Takeoff 6 — “OFFICE 3-A” Job Assemblies by using the count button and moving off the Assembly.

Takeoff 10 — “OFFICE 4-A” Job Assemblies by entering the count and moving off the Assembly.
Takeoff 5—“OFFICE 4-A” Job Assemblies by entering the count and clicking the enter key.

155



Standard Training Manual - Electrical WA

Build Assemblies (contd.):

Modify the “FIXTURE B” Job Assembly to have the following ByProducts:
1 - “FIXTURE B” Job Item
1 - “REC CAN, SMALL INCAND?” Fixture Assembly
Modify the Use the “Control/Insert” feature to re-name the “FIXTURE C” to a “FIXTURE EM” Job Assembly.
The “FIXTURE EM” Job Assembly shall have the following ByProducts:
1-"FIXTURE EM?” Job Item
1 - “EMERGENCY LT, 2HD” Fixture Assembly
Modify the Use the “Control/Insert” feature to re-name the “FIXTURE D” to a “FIXTURE X” Job Assembly.
The “FIXTURE X” Job Assembly shall have the following ByProducts:
1 - “FIXTURE X” Job Item
1 - “EXIT LIGHT, LED NI-CAD?” Fixture Assembly
Build a “CONFERENCE ROOM” Job Assembly at line 100086 using 8 - “FIXTURE B” Job Assemblies.
The ByProducts should have 8 - “FIXTURE B” Job Assembly ByProducts plus —
Add 48 — «“3 #12 1/2" EMT D/S STRAP” Branch Assemblies to the “CONFERENCE ROOM?” Job Assembly.
Add 1 “1000W 1P DIMMER?” Switch Assembly to the “CONFERENCE ROOM?” Job Assembly.
Add 20 - “3 #12 1/2" EMT D/S STRAP” Branch Assemblies to the “CONFERENCE ROOM?” Job Assembly.
Add 4 - “DUPLEX STD” Receptacle Assemblies to the “CONFERENCE ROOM” Job Assembly.
Add 1 - “GFI STD” Receptacle Assembly to the “CONFERENCE ROOM?” Job Assembly.
Add 125 - “3 #12 1/2" EMT D/S STRAP” Branch Assemblies to the “CONFERENCE ROOM?” Job Assembly.
Build an “EMERGENCY” Job Assembly at line 100087 using 1 - “FIXTURE EM” Job Assembly.
The ByProducts should have 1 - “FIXTURE EM” Job Assembly ByProducts plus —
Add 20 —“3 #12 1/2" EMT D/S STRAP” Branch Assemblies to the “EMERGENCY” Job Assembly.
Build an “EXIT” Job Assembly at line 200088 using 1 - “FIXTURE X” Job Assembly.
The ByProducts should have 1 — “FIXTURE X” Job Assembly ByProducts plus —

Add 50 — “3 #12 1/2" EMT D/S STRAP” Branch Assemblies to the “EXIT” Job Assembly.
Use Labels: Base Bid Conf/Emerg <none> <none> <none>

Takeoff 2 - “CONFERENCE ROOM?” Job Assemblies by entering the count and clicking the enter key.
Takeoff 6 - “EMERGENCY” Job Assemblies by entering the count and clicking the enter key.
Takeoff 4 — “EXIT” Job Assemblies by entering the count and clicking the enter key.

Use the “Control/Insert” feature to re-name the panels and their ByProducts as follows. (See the “Build Panels” Workspace button on
page “Fix/Dev/House” or the “Equipment” page.)
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Modify the 100101 “PANEL 1” Assembly and its ByProduct to “PANEL MDP”.
Modify the 100102 “PANEL 2” Assembly and its ByProduct to “PANEL LP-1”.
Modify the 100103 “PANEL 3” Assembly and its ByProduct to “PANEL LP-2”.
Modify the 100104 “PANEL 4” Assembly and its ByProduct to “PANEL LP-3”.
Modify the 100105 “PANEL 5” Assembly and its ByProduct to “PANEL PP-1”.
Modify the 100106 “PANEL 6” Assembly and its ByProduct to “PANEL PP-2”.
Modify the 100107 “PANEL 7” Assembly and its ByProduct to “PANEL PP-3”,

Use the “Control/Insert” feature to re-name the feeders and their ByProducts as follows. (See the “Build Feeders” Workspace button
on page “Feeder, EMT” or any of the “Feeder” pages.)

Modify the 100201 “FEEDER 1” Assembly and its ByProduct to “FEEDER MDP-2000A”.
Modify the 100202 “FEEDER 2” Assembly and its ByProduct to “FEEDER LP1-225A”.
Modify the 100203 “FEEDER 3” Assembly and its ByProduct to “FEEDER LP2-400A”.
Modify the 100204 “FEEDER 4” Assembly and its ByProduct to “FEEDER LP3-600A”.
Modify the 100205 “FEEDER 5” Assembly and its ByProduct to “FEEDER PP1-400A”.
Modify the 100206 “FEEDER 6 Assembly and its ByProduct to “FEEDER PP2-600A”.
Modify the 100207 “FEEDER 7 Assembly and its ByProduct to “FEEDER PP3-600A”.

Modify the Main Distribution Panel and Metering Job Assembly “PANEL MDP” at Line 100101 using the “PANEL MDP”
ByProduct and a “2000 AMP MDP (SERVICE)” Assembly

Modify the quantities of the following ByProducts in the “PANEL MDP” Job Assembly as shown:

12 - “600A CIRCUIT TERM” ByProducts
8 — “400A CIRCUIT TERM” ByProducts
16 — “230A CIRCUIT TERM” ByProducts

Modify the Feeder Job Assembly “FEEDER MDP 2000A” at Line 100201 using the “FEEDER MDP 2000A” ByProduct and
adding the ByProducts from the following Assemblies

ADD 6-%“4#400 & 1#3 3" PVC UG CONSTANT" Assemblies with 6 Constants
REPLACE BYPRODUCT 6 - “3 THHN CU STRANDED” wire items with 120 Constants in the
“FEEDER MDP 2000A” Job Assembly
WITH 6 —“250 THHN CU STRANDED” wire Items with Constants of 120 in the “FEEDER MDP 2000A” Job

Assembly
Use Labels: Base Bid Service <none> <none> <none>
Takeoff 1 - “PANEL MDP” Job Assembly by entering the count and clicking the enter key.
Takeoff 125 - “FEEDER MDP 2000A” Job Assembly by entering the count and clicking the enter key.

Build Assemblies (contd.):

Modify the Job Assembly “PANEL LP-1” at Line 100102 using the existing “PANEL LP-1” ByProduct and a
“200/42 120/208V PNL 3PH MCB” Panel Assembly with ByProducts added as follows:

30 — “20A WIRE TERMINATION?” Items

Modify the Job Assembly “PANEL LP-2” at Line 100103 using the existing “PANEL LP-2” ByProduct and a
“400/36 120/208V PNL 3PH MCB” Panel Assembly with ByProducts added as follows:
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42 — “20A WIRE TERMINATION” Items

Modify the Job Assembly “PANEL LP-3” at Line 100104 using the existing “PANEL LP-3” ByProduct and a
“600/40 120/208V PNL 3PH MCB” Panel Assembly with ByProducts added as follows:

42 — “20A WIRE TERMINATION” Items

Modify the Job Assembly “PANEL PP-1” at Line 100105 using the existing “PANEL PP-1” ByProduct and a
“400/36 480V PNL 3PH MLO” Panel Assembly with ByProducts added as follows:

4 - “60A 4 WIRE TERMINATION” Assemblies
2 -“100A 4 WIRE CIRCUIT TERM” Assemblies

Modify the Job Assembly “PANEL PP-2” at Line 100106 using the existing “PANEL PP-2” ByProduct and a
“600/40 480V PNL 3PH MLO” Panel Assembly with ByProducts added as follows:

4 —“100A 4 WIRE CIRCUIT TERM” Assemblies
2 —“200A 4 WIRE CIRCUIT TERM” Assemblies

Modify the Job Assembly “PANEL PP-3” at Line 100107 using the existing “PANEL PP-3” ByProduct and a
“600/40 480V PNL 3PH MLO” Panel Assembly with ByProducts added as follows:

4 —“100A 4 WIRE CIRCUIT TERM* Assemblies
2 —“200A 4 WIRE CIRCUIT TERM” Assemblies

Modify the Feeder Job Assembly “FEEDER LP1-225A” at Line 100202 using the “FEEDER LP1-225A” ByProduct and the
ByProducts from the following Assembly.

Add 1-“4#4/0&1#4 2 1/2" EMT S/S B/MIN CONST” Feeder Assembly with Constants to the
“FEEDER LP1-225A” Job Assembly.

Modify the Feeder Job Assembly “FEEDER LP2-400A” at Line 100203 using the “FEEDER LP2-400A” ByProduct and the
ByProducts from the following Assembly.

Add 1-“4#500 &1#3 3" EMT S/S B/MIN CONST” Feeder Assembly with Constants to the
“FEEDER LP2-400A” Job Assembly.

Modify the Feeder Job Assembly “FEEDER LP3-600A” at Line 100204 using the “FEEDER LP3-600A” ByProduct and the
ByProducts from the following Assembly.

Add 2 —“4#350&1#3 2 1/2" EMT S/S B/MIN CONST” Feeder Assemblies with 2 Constants to the
“FEEDER LP3-600A” Job Assembly.

Replace 2 —“3 THHN CU STRANDED” Wire Items in the “FEEDER LP3-600A” Job Assembly
With 2 —“1 THHN CU STRANDED” Wire Items with 30 Constants in the “FEEDER LP3-600A” Job Assembly.

Modify the Feeder Job Assembly “FEEDER PP1-400A” at Line 100205 using the “FEEDER PP1-400A” ByProduct and the
ByProducts from the following Assembly.
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Add 1-“FEEDER LP2-400A” Job Assembly to the “FEEDER PP1-400A” Job Assembly and remove the
“FEEDER LP2-400A” ByProduct.

Modify the Feeder Job Assembly “FEEDER PP2-600A” at Line 100206 using the “FEEDER PP2-600A” ByProduct and the
ByProducts from the following Assembly.

Add 1-“FEEDER LP3-600A” Job Assembly to the “FEEDER PP2-600A” Job Assembly and remove the
“FEEDER LP3-600A” ByProduct.

Modify the Feeder Job Assembly “FEEDER PP3-600A” at Line 100207 using the “FEEDER PP3-600A” ByProduct and the
ByProducts from the following Assembly.

Add 1-“FEEDER LP3-600A” Job Assembly to the “FEEDER PP3-600A” Job Assembly and remove the
“FEEDER LP3-600A” ByProduct.

Use Labels: Base Bid Panels/Feeders <none> <none> <none>
Takeoff 1 — “PANEL LP1” Job Assembly by entering the count and clicking the enter key.
Takeoff 1 — “PANEL LP2” Job Assembly by entering the count and clicking the enter key.
Takeoff 1 — “PANEL LP3” Job Assembly by entering the count and clicking the enter key.
Takeoff 1 — “PANEL PP1” Job Assembly by entering the count and clicking the enter key.
Takeoff 1 — “PANEL PP2” Job Assembly by entering the count and clicking the enter key.

Takeoff 1 — “PANEL PP3” Job Assembly by entering the count and clicking the enter key.

Build Assemblies (contd.):

Takeoff 125 — “FEEDER LP1-225A” Job Assemblies by entering the count and clicking the enter key.
Takeoff 135 — “FEEDER LP2-400A” Job Assemblies by entering the count and clicking the enter key.
Takeoff 95 — “FEEDER LP3-600A” Job Assemblies by entering the count and hitting the enter key.
Takeoff 65 — “FEEDER PP1-400A” Job Assemblies by entering the count and hitting the enter key.
Takeoff 105 — “FEEDER PP2-600A” Job Assemblies by entering the count and hitting the enter key.

Takeoff 75 — “FEEDER PP3-600A” Job Assemblies by entering the count and hitting the enter key.

For Future Reference only:

Extend

Change “Summary #1” to Base Bid, the Extension Report to “Edit Price 1 & Bid Labor by Cost Code” and the Material Filter to
“<none>”, if not already done, then click the “Send to “Summary” icon.
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Change “Summary #2” to Offices, the Extension Report to “Edit Price 1 & Bid Labor by Cost Code” and the Material Filter to

“<none>", if not already done, then click the “Send to “Summary” icon.
Change “Summary #3” to Conf/Emerg, the Extension Report to “Edit Price 1 & Bid Labor by Cost Code” and the Material Filter

to “<none>”, if not already done, then click the “Send to “Summary” icon.

Change “Summary #4” to Service, the Extension Report to “Edit Price 1 & Bid Labor by Cost Code” and the Material Filter to
“<none>”, if not already done, then click the “Send to “Summary” icon.

Change “Summary #5” to Panels/Feeders, the Extension Report to “Edit Price 1 & Bid Labor by Cost Code” and the Material
Filter to “<none>”, if not already done, then click the “Send to “Summary” icon.

Bid Summary
Tax: Material 6.5%
Quotes 6.5%
Labor: Foreman 10%
Journeyman 70%
5" Apprentice  20%
Foreman 10%
Overhead: 15%
Profit: 25%
Quotes: Offices Fixtures $ 5,000.00
Conf/Emerg Fixtures $ 2,000.00
All $ 7,000.00
Service Switchgear $ 10,000.00
Panels/Feeders  Switchgear $ 5,000.00
All $ 15,000.00
SubCont: Saw Cut Unit:  $2.50 Mult: 200
Trenching Unit:  $25.00 Mult: 100
DJE: Permit/Fees Unit:  $350.00 Mult: 1
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McCormick Suites
1. Start a New Job called “McCormick Suites” and Paste the Defaults including Bid Summary.
2. Add Labels (Bold): Bid Package Sheets Column 3Column 4Column 5
1. Base Bid E-1- Power <none> <none> <none>
1. E-2-Lighting
2. E-3-Voice/Data/Fire
3. Takeoff Specifications: Wiring shall be THHN Stranded in EMT with D/S fittings (D/S STRAP) with the hash marks showing the
number of wires unless shown otherwise. Standard grade devices. Run the feeder in EMT overhead. “PANEL A” is a “400/42 480V PNL
3PH MCB”, and “PANEL B” is a “200/42 120/208V PNL 3PH MCB”. DO NOT “include” or “read” anything extra into the prints such
as grounds, etc. Do your takeoff as “squared off™. Fixtures will be (A) 2X4 TROFFER 3 LAMP, (Al) 2X4 TROFFER 3 LAMP, (B)
RECESSED CAN, SMALL INCAND, (C) REC CAN WALL WASHER, SML, and (X) EXIT LIGHT, LED NI-CAD. The dimmers are a
2000W 1P DIMMER assembly. The FACP is a 4 Zone Panel.

5. Bid Summary: E-1 - Power E-2 - Lighting E-3 —Voice/Data/Fire
Foreman 10% 10% 10%
Journeyman/Wireman 70% 70% 70%
5™ period Apprentice 20% 20% 20%
Supplier Quotes
Switchgear $1,775
Fixtures $4,010
Fire Alarm $1,200
Data Equipment $3,500
Voice Equipment $1,800
Subcontractors
Core Drill $200
Direct Job Expense
Telephone $40 $40 $40
Permits $125 $125 $125
Taxes
Materials 6.5% 6.5% 6.5%
Quotes 6.5% 6.5% 6.5%
Overhead
Material 8% 8% 8%
Labor 14% 14% 14%
Supplier Quotes 9% 9% 9%
Subcontractors 9% 9% 9%
DJE 5% 5% 5%
Profit
Material 5% 5% 5%
Labor 7% 7% 7%
Supplier Quotes 4% 4% 4%
Subcontractors 4% 4% 4%
DJE 8% 8% 8%
Mark-up Tax Yes Yes Yes

4. Extension Report “Edit Price 1 & Bid Labor by Cost Code”. Material Filter “<none>". “Send to Summary” icon

McCormick Suites (contd.)
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Addendum # 1
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Add WP GFI receptacles adjacent to the roof top units as shown.

Specifications for the Change Orders for: Job Name: Existing Job “McCormick Suites”
NOTE: Use your labels and as many assemblies as possible.
Add Labels: Bid Package  Sheets Column 3 Column 4 Column 5

(The Boldface) Base Bid E-1 Power <none> <none> <none>
CO1-Add E-2Lighting
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CO 2-Add E-3 Voice/Data/Fire
CO3-Add CO

CO4-Add
CO5-Add
CO6-Add
Change Order 1
Use Labels: Bid Package  Sheets Column 3 Column 4 Column 5
CO1-Add CO <none> <none> <none>

Add four type “C” (REC CAN WALL WASHER, SML) fixtures and a 600 Watt dimmer in place of the two 2x4 recessed
lay-in (Type A) fixtures and the SP switch.

McCormick Suites CO 2: Add conference room
Use Labels: Bid Package  Sheets Column 3 Column 4 Column 5
CO2-Add CcO <none> <none> <none>

Change Order #2 is an additional conference room on the west side between the equipment room and the existing
space

3 - “FIXTURE A” Job Assemblies

6 — “FIXTURE B” Job Assemblies

2 — “FIXTURE C” Job Assemblies

1-“SP  STD” Switch Assembly

6 — “TEL, WALL/3/4> RISER” Telephone riser Assemblies

4 — “DOUBLE DUPLEX STD” Receptacle Assemblies
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2 —-“1000W 1P DIMMER?” Dimmer Assemblies
135 -%3 #12 12" EMT D/S STRAP” Branch Assemblies
45 —“4 #12 1/2" EMT D/S STRAP” Branch Assemblies

McCormick Suites CO 3: Add 4 Tele-Power poles.

Use Labels: Bid Package  Sheets Column 3 Column 4 Column 5
CO 3-Add CcO <none> <none> <none>

Change Order #3 is four additional power poles in the existing training area.

4 — “TELE-POWER POLE” Power Pole Assemblies
85—-%“3#12 12" EMT D/S STRAP” Branch Assemblies

McCormick Suites CO 4: Add a 75 KW Generator.

Use Labels: Bid Package  Sheets Column 3 Column 4 Column 5
CO 4 - Add CcO <none> <none> <none>

Change Order #4 is a 75 KW Generator with transfer switch and circuitry.

1 - %75 KW GENERATOR?” Assembly

1-%260A AUTO-TRANSFER SW 600V 3P DT N1” Assembly

1-%“125A 600V 3PH 1 F SW” Assembly

6 —“1/2 MACHINE BOLT ANCH?” Item

6 —“1/2-13 X 2 CAP SCREW?” |tem
125 —“4#2/0 & 1#6 2" EMT S/S B/MIN CONST” Feeder Conduit Assemblies

20 — “4#2/0 & 1#6 2" EMT S/S B/MIN CONST?” Feeder Conduit Assemblies

McCormick Suites CO 5: Add exterior lighting.

Use Labels: Bid Package  Sheets Column 3 Column 4 Column 5
CO5- Add CcO <none> <none> <none>

Change Order #5 is additional exterior lighting.

1-%208/277V ALR PHOTOCONTROL 1/2'" Assembly
1-%208/277V 24HR DPST 40A TIME CLOCK” Assembly
450 — “3 #12 12" EMT D/S STRAP” Branch Assemblies
10 — “ FIXTURE D” Job Assemblies with a “FIXTURE D” Job Item and a “WALL PACK 250W” HPS” Assembly
as ByProducts

McCormick Suites CO 6: Add 500 square feet of TI.

Use Labels: Bid Package  Sheets Column 3 Column 4 Column 5
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CO 6 - Add CcoO <none> <none> <none>

500 — “TT POWER, NORMAL” Tenant Infill (Improvement) Assemblies
500 — “TT LIGHTING, NORMAL” Tenant Infill (Improvement) Assemblies
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Extend
Rename the Additional summaries to the Change Order Summaries shown below.

CO 1 - Add - Change the Extension Report to “Price 3 and NECA 3” and the Material Filter to “<none>", if not
already done, then click the “Send to “Summary” icon.

CO 2 — Add - Change the Extension Report to “Price 3 and NECA 3” and the Material Filter to “<none>”, if not
already done, then click the “Send to “Summary” icon.

CO 3- Add - Change the Extension Report to “Price 3 and NECA 3” and the Material Filter to “<none>”, if not already
done, then click the “Send to “Summary” icon.

CO 4 — Add - Change the Extension Report to “Price 3 and NECA 3” and the Material Filter to “<none>", if not
already done, then click the “Send to “Summary” icon.

CO 5 - Add - Change the Extension Report to “Price 3 and NECA 3” and the Material Filter to “<none>”, if not
already done, then click the “Send to “Summary” icon.

CO 6- Add — Change the Extension Report to “Price 3 and NECA 3” and the Material Filter to “<none>”, if not already
done, then click the “Send to “Summary” icon.

Bid Summary Data:

Distribute Labor Hours: Foreman 50%
JIMn Wir 50%

Tax: Material is taxed 6.5%
Supplier Quotes are taxed 6.5%
Labor is not taxed
Do not markup tax

Mark-ups: Materials Overhead 8% Profit 25%
Labor Overhead 14% Profit 25%

Supplier Quotes Overhead 9% Profit 25%

CO 1 Supplier Quotes: Fixture A $ 65.00
Fixture C $ 76.65

CO 2 Supplier Quotes: Fixtures $ 425.00
CO 3 Supplier Quotes: Misc. $ 300.00
CO 4 Supplier Quotes: Generator Package $ 35,000.00
CO 5 Supplier Quotes: Fixtures $ 2,500.00
CO 6 Supplier Quotes: Fixtures $ 150.00

Trade Commercial Offices

Add new Job:

NOTE: Use your labels and as many assemblies as possible.
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Job Name: Trade Commercial Offices
Date: Today’s date
Type of Job: Commercial
Elevations: Ceilings 8’ 0”  Floor to bottom of joists 12” 0”
Build Labels: Bid Package Floors Systems Column 4 Column 5
Base Bid Floor 1 Outlet &L tg. <none> <none>
Floor 2 Pnl. & Feed
Floor 3
Bldg. Serv.
Bldg. Ltg.

Fixture Schedule: (Create the following Fixture Job Assemblies using the ByProducts shown)

“FIXTURE A” — 1 “FIXTURE A” ByProduct and 1 “2X4 TROFFER 3 LAMP” Assembly.

“FIXTURE B” — 1 “FIXTURE B” ByProduct and 1 “REC CAN, SMALL INCAND” Assembly

“FIXTURE C” — 1 “FIXTURE C” ByProduct and 1 “REC CAN WALL WASHR,SML” Assembly

“FIXTURE D” — 1 “FIXTURE D” ByProduct and 1 “WALL PACK, 250W HPS “ Assembly

“FIXTURE E” — 1 “FIXTURE E” ByProduct and 1 “EMERGENCY LT, 2HD” Assembly

“FIXTURE F” — 1 “FIXTURE F” ByProduct and 1 “1X4 SURFACE 2 LAMP” Assembly.

“FIXTURE X” — Use “Control/Insert” feature to rename “FIXTURE G” Assembly to a “FIXTURE X” Assembly with
1 “FIXTURE X” ByProduct and 1 “EXIT LIGHT, LED NI-CAD” Assembly

Office types:
Build a “TYPE A OFFICE” (10°x12’) Job Assembly using the following:

3 - “FIXTURE A” Job Assemblies change the ByProducts to have 1 — 2 1/8” Deep box, 1 cover, and 1 box hanger
1-“SPSP STD” Switch Assemblies
4 - “DUPLEX STD” receptacle Assemblies
1-“TEL, WALL/3/4" RISER” Telephone Riser Assembly
85— “3 #12 1/2" EMT D/S STRAP” Branch Assemblies
15 -“4 #12 1/2" EMT D/S STRAP” Branch Assemblies

Build a “TYPE B OFFICE” (10°’x16”) Job Assembly using the following:

4 — “FIXTURE A” Job Assemblies change the ByProducts to have 1 —2 1/8” Deep box, 1 cover, and 1 box hanger
1—“SP SP STD” Switch Assemblies
6 — “DUPLEX STD” Receptacle Assemblies
2 — “TEL, WALL/3/4" RISER” Telephone Riser Assembly
155 -“3 #12 1/2" EMT D/S STRAP” Branch Assemblies
15-“4 #12 1/2" EMT D/S STRAP” Branch Assemblies
Trade Commercial Offices - Office types (contd.):
Build a “CONFERENCE ROOM” (12°x20’) Job Assembly using the following:

4 — “FIXTURE A” Job Assemblies change the ByProducts to have 2 — 2 1/8” Deep boxes, 2 covers, and 2 box hangers
6 — “FIXTURE B” Job assemblies

2 — “FIXTURE C” Job assemblies

1-%“600W 1P DIMMER” Assembly

1-%“1000W 1P DIMMER” Assembly

2-“3W STD” Switch Assemblies
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6 — “DUPLEX STD” Receptacle Assemblies
1 - “GFI STD” Receptacle Assembly
2 - “TEL, WALL/3/4" RISER” Telephone Riser Assembly
195 - “3 #12 1/2" EMT D/S STRAP” Branch Assemblies
20 —“6 #12 1/2" EMT D/S STRAP” Branch Assemblies

Build an “OPEN OFFICE AREA” (25°x60°) Job Assembly using the following:

24 — “FIXTURE A” Job Assemblies change the ByProducts to have 8 — 2 1/8” Deep boxes, 8 covers, and 8 box hangers
2 — “FIXTURE E” Job assemblies
2 — “FIXTURE X” Job assemblies
4 —“3W STD” Switch Assemblies
8 — “DUPLEX STD” Receptacle Assemblies
6 — “TEL, WALL/3/4" RISER” Telephone Riser Assembly

10 - “TELE-POWER POLE” Tele-Power Pole Assemblies

195 —“3 #12 1/2" EMT D/S STRAP” Branch Assemblies
50 —“6 #12 1/2" EMT D/S STRAP” Branch Assemblies
30 —“7#12 3/4" EMT D/S STRAP” Branch Assemblies

Build a “REST ROOM?” (6’x10°) Job Assembly using the following:

2 — “FIXTURE A” Job Assemblies change the ByProducts to have 1 - 2 1/8” Deep box, 1 cover, and 1 box hanger
1 - “FIXTURE E” Job assemblies
1-«“SP SP STD” Switch Assembly
1 - “GFI STD” Receptacle Assembly
1 - Broan “673 6" BATH FAN” Assembly (Look in HVAC - Fan/Ventilating — Broan ventilating fans).
1-%20A 3'3 W W/GRD INDOOR EQUIP CONN” Equipment Connection Assembly

30 -“3 #12 1/2" EMT D/S STRAP” Branch Assemblies

15 -4 #12 1/2" EMT D/S STRAP” Branch Assemblies

Build a “HALLWAY?” (5°x12”) Job Assembly using the following:

2 — “FIXTURE A” Job Assemblies change the ByProducts to have 2 — 2 1/8” Deep boxes, 2 covers, and 2 box hangers
1 - “FIXTURE E” Job assemblies
1 - “FIXTURE X” Job assemblies
2 - “3W STD” Switch Assemblies
1-“DUPLEX STD” Receptacle Assemblies
80 —“3 #12 1/2" EMT D/S STRAP” Branch Assemblies

Trade Commercial Offices - Office types (contd.):

Office Takeoffs: (Now that the Office assemblies are built you may take them off)
Use Labels:  Base Bid Floor 1 Outlet &L tg. <none> <none>

Floor #1 Includes:

Takeoff 9—-“TYPE A OFFICE” Job Assemblies
Takeoff 4 —“TYPE B OFFICE” Job Assemblies
Takeoff 2 —“CONFERENCE ROOM?” Job Assemblies
Takeoff 2 —“OPEN OFFICE AREA” Job Assemblies
Takeoff 4 —“REST ROOM?” Job Assemblies

Takeoff 2 - “HALLWAY?” Job Assemblies

168



Standard Training Manual - Electrical M

Use Labels:  Base Bid Floor 2 Outlet &L tg. <none> <none>
Floor #2 Includes:

Takeoff 10 — “TYPE A OFFICE” Job Assemblies
Takeoff 4 —“TYPE B OFFICE” Job Assemblies
Takeoff 2 — “CONFERENCE ROOM?” Job Assemblies
Takeoff 2 —“OPEN OFFICE AREA” Job Assemblies
Takeoff 4 —“REST ROOM?” Job Assemblies

Takeoff 2 — “HALLWAY?” Job Assemblies

Use Labels:  Base Bid Floor 3 Outlet &L tg. <none> <none>
Floor #3 Includes:

Takeoff 10 — “TYPE A OFFICE” Job Assemblies
Takeoff 4 —“TYPE B OFFICE” Job Assemblies
Takeoff 2 — “CONFERENCE ROOM?” Job Assemblies
Takeoff 2 —“OPEN OFFICE AREA” Job Assemblies
Takeoff 4 —“REST ROOM?” Job Assemblies

Takeoff 2 - “HALLWAY?” Job Assemblies
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Trade Commercial Offices - Transformers & Panels for floors:

Use the “Control/Insert” feature to re-name the panels and their ByProducts as follows. (See the “Build Panels”
Workspace button on the page “Equipment” of Workspaces.)

Modify the 100101 “PANEL 1” Assembly and its ByProduct to “PANEL LP-1E”.
Modify the 100102 “PANEL 2” Assembly and its ByProduct to “PANEL LP-1W”.
Modify the 100103 “PANEL 3” Assembly and its ByProduct to “PANEL LP-2E”.
Modify the 100104 “PANEL 4” Assembly and its ByProduct to “PANEL LP-2W”.
Modify the 100105 “PANEL 5” Assembly and its ByProduct to “PANEL LP-3E”.
Modify the 100106 “PANEL 6” Assembly and its ByProduct to “PANEL LP-3W”.
Modify the 100107 “PANEL 7 Assembly and its ByProduct to “PANEL MDP”.
Modify the 100108 “PANEL 8” Assembly and its ByProduct to “PANEL HVAC”.
Modify the 100109 “PANEL 9” Assembly and its ByProduct to “PANEL BUILDING”.

Modify the Job Assembly “PANEL LP-1E” at Line 100101 using the existing “PANEL LP-1E” ByProduct and a
%200/36 120/208V PNL 3PH MCB?” Panel Assembly with ByProducts as follows:

1-“75 KVA TRANSF 3PH 480-120/208V FLR” Transformer Assembly
30 — “20A WIRE TERMINATION” Items
1-“11/4 GRC COUPLING” Assembly

Modify the Job Assembly “PANEL LP-1W?” at Line 100102 using the existing “PANEL LP-1W” ByProduct and the
ByProducts from the Job Panel Assembly “PANEL LP-1E”. Delete the ByProduct “PANEL LP-1E” from this
Assembly.

Modify the Job Assembly “PANEL LP-2E” at Line 100103 using the existing “PANEL LP-2E” ByProduct and the
ByProducts from the Job Panel Assembly “PANEL LP-1E”. Delete the ByProduct “PANEL LP-1E” from this
Assembly.

Modify the Job Assembly “PANEL LP-2W?” at Line 100104 using the existing “PANEL LP-2W” ByProduct and the
ByProducts from the Job Panel Assembly “PANEL LP-1E”. Delete the ByProduct “PANEL LP-1E” from this
Assembly.

Modify the Job Assembly “PANEL LP-3E” at Line 100105 using the existing “PANEL LP-3E” ByProduct and the
ByProducts from the Job Panel Assembly “PANEL LP-1E”. Delete the ByProduct “PANEL LP-1E” from this
Assembly.

Modify the Job Assembly “PANEL LP-3W” at Line 100106 using the existing “PANEL LP-3W” ByProduct and the
ByProducts from the Job Panel Assembly “PANEL LP-1E”. Delete the ByProduct “PANEL LP-1E” from this
Assembly.

Trade Commercial Offices - Transformer/Panel Takeoffs:
Use Labels: Base Bid Floor 1 Pnl. & Feed <none> <none>

Takeoff 1 — “PANEL LP-1E” Job Assembly
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Takeoff 1 — “PANEL LP-1W” Job Assembly

Use Labels: Base Bid Floor 2 Pnl. & Feed <none> <none>

Takeoff 1 — “PANEL LP-2E” Job Assembly
Takeoff 1 — “PANEL LP-2W” Job Assembly

Use Labels: Base Bid Floor 3 Pnl. & Feed <none> <none>

Takeoff 1 — “PANEL LP-3E” Job Assembly
Takeoff 1 — “PANEL LP-3W” Job Assembly

Building Service:

Modify the Main Distribution Panel and Metering Job Assembly “PANEL MDP” at Line 100107 using the “PANEL
MDP” ByProduct and a “2000 AMP MDP (SERVICE)” Assembly.

Modify the quantities of the following ByProducts in the “PANEL MDP” Job Assembly as shown:

3 - “60A WIRE TERMINATION” ByProducts
24 — “100A CIRCUIT TERM?” ByProducts
12 — “230A CIRCUIT TERM” ByProducts
48 — “400A CIRCUIT TERM” ByProducts

Use the “Control/Insert” feature to re-name the feeders and their ByProducts as follows. (See the “Build Feeders”
Workspace button on page “Feeder, EMT, Constants, Strap/Conc” of Workspaces.)

Modify the 100201 “FEEDER 1” Assembly and its ByProduct to “FEEDER MDP-2000A”.

Modify the 100202 “FEEDER 2” Assembly and its ByProduct to “FLOOR 1 EAST FEEDER”.
Modify the 100203 “FEEDER 3” Assembly and its ByProduct to “FLOOR 1 WEST FEEDER”.
Modify the 100204 “FEEDER 4 Assembly and its ByProduct to “FLOOR 2 EAST FEEDER”.
Modify the 100205 “FEEDER 5” Assembly and its ByProduct to “FLOOR 2 WEST FEEDER”.
Modify the 100206 “FEEDER 6 Assembly and its ByProduct to “FLOOR 3 EAST FEEDER”.
Modify the 100207 “FEEDER 7 Assembly and its ByProduct to “FLOOR 3 WEST FEEDER”.
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Trade Commercial Offices - Building Service — (contd.):

Modify the Job Assembly “PANEL HVAC” at Line 100108 using the existing “PANEL HVAC” ByProduct and the
ByProducts from the following Items and Assemblies.

1-%400/28 480V PNL 3PH MLO” Panel Board Assembly
6 —“60A 3 WIRE TERMINATION” Assemblies
20 — “4#500 &1#3 3" EMT S/S B/MIN CONST* Feeder with Constants Assemblies

Modify the Job Assembly “PANEL BUILDING” at Line 100109 using the existing “PANEL BUILDING” ByProduct
and the ByProducts from the following Items and Assemblies.

1 -“45 KVA TRANSF 3PH 600-120/208V FLR” Transformer Assembly
1-%100/24 120/208V PNL 3PH MCB” Panel Board Assembly

8 —“20A 4 WIRE TERMINATION” Assemblies

1 - %1 GRC COUPLING” Assembly

Modify the Feeder Job Assembly “FEEDER MDP 2000A” at Line 100201 using the “FEEDER MDP 2000A”
ByProduct and the ByProducts from the following Items and Assemblies.

1 —-%24X36 TRENCH/BACKFILL” Assemblies
6 —“4#400 & 1 #3 PVC UG CONSTANT” Assemblies with 6 Constants
REPLACE BYPRODUCT 6 —“3 THHN CU STRANDED?” wire items with 120 Constants in
the “FEEDER MDP 2000A” Job Assembly
WITH 6 — %250 THHN CU STRANDED?” wire items with 120 Constants in the
“FEEDER MDP 2000A” Job Assembly
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Trade Commercial Offices - Transformer Feeders:

Modify the Feeder Job Assembly “FLOOR 1 EAST FEEDER” at Line 100202 using the “FLOOR 1 EAST FEEDER”
ByProduct and the ByProducts from the following Assemblies.

1-—“4#2 &1#6 1 1/4" EMT S/S BC/MIN CONST” Feeder with Constants Assembly

Modify the Feeder Job Assembly “FLOOR 1 WEST FEEDER” at Line 100203 using the “FLOOR 1 WEST
FEEDER” ByProduct and the ByProducts from the following Assemblies.

1—“4#2 &1#6 1 1/4" EMT S/S BC/MIN CONST” Feeder with Constants Assembly

Modify the Feeder Job Assembly “FLOOR 2 EAST FEEDER” at Line 100204 using the “FLOOR 2 EAST FEEDER”
ByProduct and the ByProducts from the following Assemblies.

1-“4#2 &1#6 1 1/4" EMT S/S BC/MIN CONST” Feeder with Constants Assembly

Modify the Feeder Job Assembly “FLOOR 2 WEST FEEDER” at Line 100205 using the “FLOOR 2 WEST
FEEDER” ByProduct and the ByProducts from the following Assemblies.

1-“4#2 &1#6 1 1/4" EMT S/S BC/MIN CONST” Feeder with Constants Assembly

Modify the Feeder Job Assembly “FLOOR 3 EAST FEEDER” at Line 100206 using the “FLOOR 3 EAST FEEDER”
ByProduct and the ByProducts from the following Assemblies.

1—“4#2 &1#6 1 1/4" EMT S/S BC/MIN CONST” Feeder with Constants Assembly

Modify the Feeder Job Assembly “FLOOR 3 WEST FEEDER” at Line 100207 using the “FLOOR 3 WEST
FEEDER” ByProduct and the ByProducts from the following Assemblies.

1—“4#2 &1#6 1 1/4" EMT S/S BC/MIN CONST” Feeder with Constants Assembly
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Trade Commercial Offices - Building Transformer/Feeder Takeoffs:

Use Labels:  Base Bid Bldg. Serv. Pnl. & Feed <none> <none>
Takeoff 1 - “PANEL MDP” Panel Job Assembly
Takeoff 1-“PANEL HVAC” Panel Job Assembly
Takeoff 1-“PANEL BUILDING” Panel Job Assembly
Takeoff 120 — “FEEDER MDP 2000A” Feeder Job Assembly
Takeoff 20— “FLOOR 1 EAST FEEDER?” Feeder Job Assembly
Takeoff 150 — “FLOOR 1 WEST FEEDER?” Feeder Job Assembly
Takeoff 35 -“FLOOR 2 EAST FEEDER” Feeder Job Assembly
Takeoff 165 — “FLOOR 2 WEST FEEDER?” Feeder Job Assembly
Takeoff 45 — “FLOOR 3 EAST FEEDER?” Feeder Job Assembly
Takeoff 175 - “FLOOR 3 WEST FEEDER” Feeder Job Assembly

Building Lighting:
Build a “BUILDING STAIRS” Job Assembly for the building stairwells using the following Items and Assemblies:
6 — “FIXTURE A” Job Assemblies change the ByProducts to have 6 boxes, 6 covers, and 6 box hangers
3 - “FIXTURE E” Job Assemblies
1 - “FIXTURE X” Job Assemblies
2-“3W STD” Switch Assemblies
1-—“4W STD” Switch Assembly
3-“DUPLEX STD” Receptacle Assemblies
120 —“3 #12 1/2" EMT D/S STRAP” Branch Assemblies
120 — “5#12 1/2" EMT D/S STRAP” Branch Assemblies

Build an “EXTERIOR BUILDING LIGHTING” Job Assembly for the Exterior Building Lighting using the following
Assemblies:
14 — “FIXTURE D” Job Assemblies
350 — “3 #12 1/2" EMT D/S STRAP” Branch Assemblies

Build an “EQUIPMENT ROOM?” Job Assembly for the Building Equipment Room using the following Assemblies:
6 — “FIXTURE F” Job Assemblies
1-“SP SP STD” Switch Assemblies
2 - “DUPLEX STD” Receptacle Assemblies
110 - “3 #12 1/2" EMT D/S STRAP” Branch Assemblies

174



Standard Training Manual - Electrical M

Trade Commercial Offices - Building Lighting Takeoffs:
Use Labels: Base Bid Bldg. Ltg. Outlet & Ltg. <none> <none>

Takeoff 2 - “BUILDING STAIRS” Job Assemblies
Takeoff 1 - “EXTERIOR BUILDING LIGHTING” Job Assembly
Takeoff 1 - “EQUIPMENT ROOM?” Job Assembly

Trade Commercial Offices - Extension Data:
Extensions:

Zero Price & Labor — Use Labels > Base Bid All All <none> <none>
Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: Zero Price and Labor

Note: Use this report to look for zero prices and zero labor. Do not send to the Bid Summary.

Quotes — Use Labels > Base Bid All All <none> <none>
Extension Report: Item Material List ~ Material Filter: Quote

Note: Use this report to create a quotes list. Do not send to the Bid Summary.

Material List — Use Labels > Base Bid All All <none> <none>
Extension Report: Item Pull Sheet Material Filter: <None>

Note: Use this report for a material list. Do not send to the Bid Summary.

Base Bid — Use Labels > Base Bid All All <none> <none>
Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”

Floor 1 — Use Labels > Base Bid Floor 1 Outlet & Ltg. <none> <none>
Pnl. & Feed
Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”

Floor 2 — Use Labels > Base Bid Floor 2 Outlet & Ltg.  <none> <none>
Pnl. & Feed
Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”

Floor 3 — Use Labels > Base Bid Floor 3 Outlet & Ltg. <none> <none>
Pnl. & Feed
Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”

Trade Commercial Offices - Extension Data (contd):
Bldg. Service — Use Labels > Base Bid Bldg. Serv. Pnl. & Feed  <none> <none>
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Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”

Bldg. Lighting — Use Labels > Base Bid Bldg. Ltg. Outlet & Ltg. <none> <none>

Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”

Trade Commercial Offices - Bid Summary Data:

Distribute Labor Hours:
Foreman 10%
J/Mn Wir 70%
Appr5 20%

Tax:
Material is taxed at 6.5%
Supplier Quotes are taxed at 6.5%
Labor is not taxed
Do not mark up tax

Mark-ups:

Overhead 15%
Profit 25%

Supplier Quotes:

Floor 1 Switchgear $ 7,314.06 Floor 1 Fixtures $12,273.00
Floor 2 Switchgear $ 7,314.06 Floor 2 Fixtures $12,558.00
Floor 3 Switchgear $ 7,314.06 Floor 3 Fixtures $12,558.00
Building Service Switchgear $23,480.82

Building Fixtures $ 5,022.00
Base Bid Switchgear $45,423.00 Base Bid Fixtures $42,411.00
Bonding:

Tip: The “FROM” column automatically calculates the “FROM” amount based on the preceding “TO” amount, therefore
typing in the “FROM?” column of the “Bond Table” is not needed

$0.00to $100,000 @ $15.00/$1000.00 (1.5%)
$100,000.01 to $2,000,000 @ $10.00/$1000.00 (1.0%0)

Check the Bonding box on the top sheet.
Trade Commercial Offices Alternates

Diagram

Trade Commercial Offices

176



Standard Training Manual - Electrical M
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Alternates for Existing Job named “Trade Commercial Offices”.
Specifications:
NOTE: Use your labels and as many assemblies as possible.
Job Name: Use existing Job “Trade Commercial Offices”
Elevations: Ceilings 8’ 0” Floor to bottom of joists 12” 0”
Add Labels: Bid Package  Floors Systems Column 4 Column 5
(The Boldface Labels) Base Bid Floor 1 Outlet &L tg. <none> <none>
Alt. 1- Add Floor 2 Pnl. & Feed

Alt. 2 - Add Floor 3
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Alt. 3- Add  Bldg. Serv.
Bldg. Ltg.
Alt. 1 Floor 1
Alt. 1 Floor 2
Alt. 1 Floor 3
Alt. 1 Bldg. Serv.
Alt. 1 Bldg. Ltg.
Alt. 2 Floor 4
Alt. 2 Floor 5
Alt. 2 Bldg. Serv.
Alt. 2 Bldg. Ltg.
Alt. 3 Floor 4
Alt. 3 Floor 5
Alt. 3 Bldg. Serv.
Alt. 3 Bldg. Ltg.

Use the Existing Assemblies whenever possible.

Alt. 1 - ADD: Add a second building.

Alt. 1 is a second building that is an exact duplicate of the first building.

Use Labels: Bid Package  Floors Systems Column 4 Column 5
Alt.1-Add Alt. 1 Floor 1 Outlet &Ltg. <none> <none>
Alt. 1 Floor 2 Pnl. & Feed
Alt. 1 Floor 3
Alt. 1 Bldg. Serv.
Alt. 1 Bldg. Ltg.

Use “Change Labelset” to copy from the Base Bid building to the Alt. 1 building.
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Alternates for Existing Job named “Trade Commercial Offices” Continued.

Alt. 2- ADD - Add an additional two floors to the original building.
Use Labels: Alt.2-Add Alt. 2Floor 4 Outlet &Ltg. <none> <none>

Floor #4 Includes:
Takeoff 10 - “TYPE A OFFICE” Job Assemblies
Takeoff 4 —“TYPE B OFFICE” Job Assemblies
Takeoff 2 —“CONFERENCE ROOM?” Job Assemblies
Takeoff 2 -“OPEN OFFICE AREA” Job Assemblies
Takeoff 4 —“REST ROOM?” Job Assemblies
Takeoff 2 - “HALLWAY?” Job Assemblies

Use Labels: Alt. 2- Add Alt. 2Floor5 Outlet &Ltg. <none> <none>

Floor #5 Includes:
Takeoff 10 - “TYPE A OFFICE” Job Assemblies
Takeoff 4 —“TYPE B OFFICE” Job Assemblies
Takeoff 2 - “CONFERENCE ROOM?” Job Assemblies
Takeoff 2 —-“OPEN OFFICE AREA” Job Assemblies
Takeoff 4 —“REST ROOM?” Job Assemblies
Takeoff 2 - “HALLWAY?” Job Assemblies

Transformers & Panels for floors:

Use the “Control/Insert” feature to re-name the panels and their ByProducts as follows. (See the “Build Panels” Workspace
button on page “Fix/Dev/House” or the “Equipment” page.)

Modify the 100110 “PANEL 10” Assembly and its ByProduct to “PANEL LP-4E”.
Modify the 100111 “PANEL 11” Assembly and its ByProduct to “PANEL LP-4W”.
Modify the 100112 “PANEL 12” Assembly and its ByProduct to “PANEL LP-5E”.
Modify the 100113 “PANEL 13” Assembly and its ByProduct to “PANEL LP-5W”.
Modify the 100114 “PANEL 14” Assembly and its ByProduct to “ALT 2 PANEL MDP ADD 4-100A BREAKERS”.
Modify the 100115 “PANEL 15” Assembly and its ByProduct to “ALT 2 PANEL HVAC ADD 4-60A BREAKERS”.

Modify the Job Assembly “PANEL LP-4E” at Line 100110 using the existing “PANEL LP-4E” ByProduct and the
ByProducts from the Job Panel Assembly “PANEL LP-1E”. Delete the ByProduct “PANEL LP-1E” from this Assembly.

Modify the Job Assembly “PANEL LP-4W” at Line 100111 using the existing “PANEL LP-4W” ByProduct and the
ByProducts from the Job Panel Assembly “PANEL LP-1E”. Delete the ByProduct “PANEL LP-1E” from this Assembly.

Modify the Job Assembly “PANEL LP-5E” at Line 100112 using the existing “PANEL LP-5E” ByProduct and the
ByProducts from the Job Panel Assembly “PANEL LP-1E”. Delete the ByProduct “PANEL LP-1E” from this Assembly.

Modify the Job Assembly “PANEL LP-5W?” at Line 100113 using the existing “PANEL LP-5W” ByProduct and the
ByProducts from the Job Panel Assembly “PANEL LP-1E”. Delete the ByProduct “PANEL LP-1E” from this Assembly.
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Trade Commercial Offices Alt. 2- ADD - Add an additional two floors to the original building:
Transformers & Panels for floors — (contd.):

Transformer/Panel Takeoffs:
Use Labels: Alt.2-Add Alt.2Floor4 Pnl. & Feed <none> <none>

Takeoff 1 — “PANEL LP-4E” Job Assembly
Takeoff 1 — “PANEL LP-4W?” Job Assembly

Use Labels: Alt.2-Add Alt2Floor5 Pnl. & Feed <none> <none>

Takeoff 1 — “PANEL LP-5E” Job Assembly
Takeoff 1 — “PANEL LP-5W?” Job Assembly

Building Service:

Modify the Job Assembly “ALT 2 PANEL MDP ADD 4-100A BREAKERS” at Line 100114 using the existing
“ALT 2 PANEL MDP ADD 4-100A BREAKERS” ByProduct and with ByProducts added as follows:

4 —“100A 3 WIRE CIRCUIT TERM” Assemblies (3 phase, 3 wire)

Modify the Job Assembly “ALT 2 PANEL HVAC ADD 4-60A BREAKERS?” at Line 100115 using the existing
“ALT 2 PANEL HVA ADD 4-60A BREAKERS” ByProduct and with ByProducts added as follows:

4 -“60A 3 WIRE TERMINATION” Assemblies (3 phase, 3 wire)

TRANSFORMER FEEDERS:

Use the “Control/Insert” feature to re-name the feeders and their ByProducts as follows. (See the “Build Feeders”
Workspace button on page “Fix/Dev/House” or any of the “Feeder” pages.)

Modify the 100208 “FEEDER 8” Assembly and its ByProduct to “FLOOR 4 EAST FEEDER”.
Modify the 100209 “FEEDER 9” Assembly and its ByProduct to “FLOOR 4 WEST FEEDER”.
Modify the 100210 “FEEDER 10” Assembly and its ByProduct to “FLOOR 5 EAST FEEDER”.
Modify the 100211 “FEEDER 11” Assembly and its ByProduct to “FLOOR 5 WEST FEEDER”.

Modify the Feeder Job Assembly “FEEDER FLOOR 4 EAST” at Line 100208 using the “FEEDER FLOOR 4 EAST”
ByProduct and the ByProducts from the following Assemblies.

1—-“4#2 &1#6 1 1/4" EMT S/S BC/MIN CONST” Feeder with Constants Assemblies

Modify the Feeder Job Assembly “FEEDER FLOOR 4 WEST” at Line 100209 using the “FEEDER FLOOR 4
WEST” ByProduct and the ByProducts from the following Assemblies.

1-—“4#2 &1#6 1 1/4" EMT S/S BC/MIN CONST” Feeder with Constants Assemblies

Trade Commercial Offices Alt. 2- ADD - Add an additional two floors to the original building:

Modify the Feeder Job Assembly “FEEDER FLOOR 5 EAST” at Line 100210 using the “FEEDER FLOOR 5 EAST”
ByProduct and the ByProducts from the following Assemblies.
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1-—“4#2 &1#6 1 1/4" EMT S/S BC/MIN CONST” Feeder with Constants Assemblies

Modify the Feeder Job Assembly “FEEDER FLOOR 5 WEST” at Line 100211 using the “FEEDER FLOOR 5
WEST” ByProduct and the ByProducts from the following Assemblies.

1—-“4#2 &1#6 1 1/4" EMT S/S BC/MIN CONST” Feeder with Constants Assemblies

Building Service - Takeoff:
Use Labels:  Alt.2- Add  Alt. 2 Bldg. Serv. Pnl. & Feed  <none> <none>

Takeoff 1-”"MDP ALT.2 ADD BREAKERS” Job Assembly
Takeoff 1-“HVAC ALT.2 ADD BREAKERS” Job Assembly
Takeoff 55-“FLOOR 4 EAST FEEDER” Job Assembly
Takeoff 185 - “FLOOR 4 WEST FEEDER?” Job Assembly
Takeoff 70 - “FLOOR 5 EAST FEEDER?” Job Assembly
Takeoff 200 — “FLOOR 5 WEST FEEDER” Job Assembly

Building Lighting —
Build a “BLDG. LTG. FLOOR 4 & 5” Job Assemblies for the 4" and 5™ floor stairwells:

4 — “FIXTURE A” Job Assemblies change the ByProducts to have 4 boxes, 4 covers, and 4 box hangers
2 — “FIXTURE E” Job Assemblies
1 - “FIXTURE X” Job Assemblies
2 —“4W STD” Switch Assemblies
2 - “DUPLEX STD” Receptacle Assemblies
60 — “3 #12 1/2" EMT D/S STRAP” Branch Assemblies
80 — “5 #12 1/2" EMT D/S STRAP” Branch Assemblies

Building Lighting - Takeoff:
Use Labels:  Alt.2- Add  Alt. 2 Bldg. Ltg. Outlet &Ltg. <none> <none>

Takeoff 2 — “BLDG. LTG. FLOOR 4 & 5” Job Assemblies

Alt. 3 - Add: Add an additional two floors to Alt. 1 building.

Use Labels: Column 1 Column 2 Column 3 Column 4 Columnb
Alt. 3- Add  Alt. 3Floor 4 Outlet &Ltg. <none> <none>
Alt. 3Floor 5 Outlet &Ltg.
Alt. 3Floor 4 Pnl. & Feed
Alt. 3Floor 5 Pnl. & Feed
Alt. 3 Bldg. Serv.
Alt. 3 Bldg. Ltg.
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Alt. 3 is adding an additional two floors to the Alt. 1 building. Use the same specifications as in Alt. 2.

Use “Change Labelset” to Copy from the Alt. 2 to Alt. 3.
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Alternates for Existing Job named “Trade Commercial Offices” - Extension Data:

Alt. 1 Extensions:

Alt. 1 - Add
Use Labels > Alt. 1-Add  Alt. 1 All Alt. 1 All <none> <none>
Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”
Alt. 1 — Add - Floor 1:
Use Labels > Alt. 1- Add  Alt. 1 Floor 1 Outlet & Ltg. <none> <none>
Pnl. & Feed
Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”
Alt. 1 — Add - Floor 2:
Use Labels > Alt. 1- Add  Alt. 1 Floor 2 Outlet & Ltg. <none> <none>
Pnl. & Feed
Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”
Alt. 1 — Add - Floor 3:
Use Labels > Alt. 1- Add  Alt. 1 Floor 3 Outlet & Ltg. <none> <none>
Pnl. & Feed
Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”

Alt. 1 — Add - Bldg. Service:

Use Labels > Alt. 1- Add  Alt. 1 Bldg. Serv.

Extension Report: Edit Price 1 and Bid Labor by Cost Code

Pnl. & Feed

Material Filter:

<none>

<None>

<none>

Click “Send to Summary”

Alt. 1 — Add - Bldg. Lighting:
Use Labels > Alt. 1- Add

Alt. 1 Bldg. Ltg.

Extension Report: Edit Price 1 and Bid Labor by Cost Code

Outlet & Ltg.

Material Filter:

<none>

<None>

<none>

Click “Send to Summary”

Alternates for Existing Job named “Trade Commercial Offices” - Extension Data:

Alt. 2 Extensions
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Alt. 2 — Add — Total:
Use Labels > Alt. 2-Add Alt. 2 All Alt. 2 All <none> <none>

Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”

Alt. 2 — Add - Floor 4:
Use Labels > Alt. 2—-Add Alt. 2 Floor 4 Outlet & Ltg. <none> <none>
Pnl. & Feed

Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”

Alt. 2 — Add - Floor 5:
Use Labels > Alt.2-Add Alt. 2 Floor 5 Outlet & Ltg. <none> <none>
Pnl. & Feed

Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”

Alt. 2 — Add - Bldg. Service:
Use Labels > Alt.2-Add Alt. 2 Bldg. Serv. Pnl. & Feed  <none> <none>

Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”

Alt. 2 — Add - Bldg. Lighting:

Use Labels > Alt. 2-Add Alt. 2 Bldg. Ltg. Outlet & Ltg. <none> <none>

Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”

Alternates for Existing Job named “Trade Commercial Offices” - Extension Data:

Alt. 3 — Add - Extensions:

Alt. 3 — Add — Total:
Use Labels > Alt. 3—Add Alt. 3 All Alt. 3 All <none> <none>

Extension Report: Edit Price 1 and Bid Labor by Cost Code Material Filter: <None> Click “Send to Summary”
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Alt. 3 — Add - Floor 4:
Use Labels >

Alt. 3— Add Alt. 3Floor 4

Extension Report: Edit Price 1 and Bid Labor by Cost Code

Outlet & Ltg. <none>
Pnl. & Feed

Material Filter: <None>

<none>

Click “Send to Summary”

Alt. 3— Add - Floor 5:
Use Labels >

Alt. 3—Add  Alt. 3 Floor 5

Extension Report: Edit Price 1 and Bid Labor by Cost Code

Outlet & Ltg. <none>
Pnl. & Feed

Material Filter: <None>

<none>

Click “Send to Summary”

Alt. 3 — Add - Bldg. Service:
Use Labels > Alt. 3—Add  Alt. 3 Bldg. Serv.

Extension Report: Edit Price 1 and Bid Labor by Cost Code

Pnl. & Feed <none>

Material Filter: <None>

<none>

Click “Send to Summary”

Alt. 3 — Add - Bldg. Lighting:
Use Labels > Alt. 3— Add  Alt. 3 Bldg. Ltg.

Extension Report: Edit Price 1 and Bid Labor by Cost Code

Outlet & Ltg. <none>

Material Filter: <None>

<none>

Click “Send to Summary”

Alternates for Existing Job named “Trade Commercial Offices” - Bid Summary:

Bid Summary Data:

Distribute Labor Hours:

Foreman 10%

JIMn Wir 70%

Appr5  20%
Tax:

Material is taxed at 6.5%
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Supplier Quotes are taxed at 6.5%
Labor is not taxed
Do NOT markup tax

Mark-ups:

4, Overhead 15%
5. Profit 25%

Alt. 1 — Add - Supplier Quotes:

Floor 1 Switchgear $ 7,314.06 Floor 1 Fixtures  $12,273.00
Floor 2 Switchgear $ 7,314.06 Floor 2 Fixtures  $12,558.00
Floor 3 Switchgear $ 7,314.06 Floor 3 Fixtures  $12,558.00

Building Service Switchgear  $23,480.82
Building  Fixtures  $5,022.00

Alt1- Add Switchgear ~ $45,423.00 Alt. 1 - Add Fixtures  $42,411.00

Alt. 2 — Add - Supplier Quotes:

Floor 4 Switchgear $ 7,314.06 Floor 4 Fixtures $12,558.00
Floor 5 Switchgear $ 7,314.06 Floor 5 Fixtures $12,558.00
Building Service Switchgear $ 575.00

Building  Fixtures $ 565.00

Alt.2-Add  Switchgear $15,203.12 Alt. 2 — Add Fixtures  $25,681.00

Alternates for Existing Job named “Trade Commercial Offices” - Bid Summary:

Alt. 3— Add - Supplier Quotes:

Floor 4 Switchgear $ 7,314.06 Floor 4 Fixtures $12,558.00
Floor 5 Switchgear $ 7,314.06 Floor 5 Fixtures $12,558.00
Building Service Switchgear $ 575.00

Building  Fixtures $ 565.00

Alt.2—-Add  Switchgear $15,203.12 Alt. 2 — Add Fixtures  $25,681.00

Bonding:

Tip: The “FROM” column automatically calculates the “FROM” amount based on the preceding “TO” amount, therefore
typing in the “FROM?” column of the “Bond Table” is not needed
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$0.00 to  $100,000 @ $15.00/$1000.00 (1.5%)
$100,000.01 to $2,000,000 @ $10.00/$1000.00 (1.0%0)

Check the Bonding box on the top sheet for each Summary.

Job 5

1. Start a New Job called Job 5
Paste the 3 Defaults + Bid Summary
2. Create Labels for Takeoff:

Build Labels: Bid Package  Column 2 Column 3 Column 4 Column 5
Base Bid <none> <none> <none> <none>

3. Takeoff the following Assemblies:

13 SP STD
42 DUPLEX STD
950 3#12 1/2" EMT D/S STRAP

4, Extend:

Change “Summary #1” to “Base Bid” if not already done.
Change the Extension Report to “Edit Price 1 & Bid Labor by Cost Code”
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Set the Material Filter to “<none>"
Click the “Send to Summary” icon.

5. Bid Summary: Base Bid

Labor Hours

Journeyman/Wireman | 100% |
Taxes

Materials | 6.5% |
Overhead — Al | 15% |
Profit — All | 10% |
Mark-up Tax | Yes |
Job 6

1. Start a New Job called Job 6
Paste the 3 Defaults + Bid Summary
2. Create Labels for Takeoff:

Build Labels: Bid Package  Column 2 Column 3 Column 4 Column 5
Base Bid <none> <none> <none> <none>

3. Takeoff the following Assemblies:

95 DUPLEX STD

46 3W STD

12 TEL, WALL 3/4” RISER
4000 3#12 1/2" EMT DI/S STRAP

4. Extend:

Change “Summary #1” to “Base Bid” if not already done.

Change the Extension Report to “Edit Price 1 & Bid Labor by Cost Code”
Set the Material Filter to “<none>"

Click the “Send to Summary” icon.

188



Standard Training Manual - Electrical M

5. Bid Summary: Base Bid

Labor Hours

Journeyman/Wireman | 100% |
Taxes

Materials | 6.5% |
Overhead — All | 15% |
Profit — All | 10% |
Mark-up Tax | Yes |
Job 7

1. Starta New Job called Job 7
Paste the 3 Defaults + Bid Summary

2. Create Labels for Takeoff:

Build Labels: Bid Package  Column 2 Column 3 Column 4 Column 5

Base Bid <none> <none> <none> <none>
Alt1 - Add

3. Takeoff the following Assemblies:
Base Bid
220 DUPLEX STD
145 SP STD
15 TEL, WALL 3/4* RISER
5000 3#12 1/2" EMT D/S STRAP
Alt1 - Add
15 GFlI STD
18 3w STD
12 TELE-POWER POLE
4500 3#12 1/2" EMT D/S STRAP

4. Extend:
Change “Summary #1” to Base Bid, the Extension Report to “Edit Price 1 & Bid Labor by Cost Code” and the
Material Filter to “<none>”, if not already done, then click the “Send to “Summary” icon.

Change “Summary #2” to Alt 1 — Add, the Extension Report to “Edit Price 1 & Bid Labor by Cost Code” and
the Material Filter to “<none>", if not already done, then click the “Send to “Summary” icon.
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5. Bid Summary:

| Base Bid | Alt1-Add |
Labor Hours
Journeyman/Wireman | 100% | 100% |
Taxes
Materials | 6.5% | 6.5% |
Overhead — Al | 15% | 15% |
Profit — All | 25% | 25% |
Mark-up Tax | Yes | Yes |
Job 8

1. Start a New Job called Job 8

Paste the 3 Defaults + Bid Summary

2. Create Labels for Takeoff:

Build Labels: Bid Package Column 2 Column 3 Column 4 Column 5

Base Bid <none> <none> <none> <none>
CO1-Add

3. Takeoff the following Assemblies:
Base Bid
45 DUPLEX STD
15 SP STD
45 TEL, WALL 3/4“ RISER
7 TELE-POWER POLE
3500 3#12 1/2" EMT D/S STRAP
CO1-Add
18 DUPLEX STD
4 GFlI STD
5 SP STD
4 3wW STD
950 3#121/2" EMT D/S STRAP

4. Extend:

Change “Summary #1” to Base Bid, the Extension Report to “Edit Price 1 & Bid Labor by Cost Code” and the Material Filter
to “<none>", if not already done, then click the “Send to “Summary” icon.

Change “Summary #2” to CO 1 — Add — Change the Extension Report to “Price 3 and NECA 3” and the Material Filter to
“<none>", if not already done, then click the “Send to “Summary” icon.

5. Bid Summary:

| Base Bid | CO1-Add

Labor Hours
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Journeyman/Wireman 100%

Foreman 100%
Taxes

Materials | 6.5% | 6.5% |
Overhead — All [ 15% | 15% |
Profit — All | 25% | 25% |
Mark-up Tax | Yes | Yes |
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Technical Support

If you have any questions or you would like more information please contact us at:

TR

] 3 e S i

Our Website: www.mccormicksys.com
Email: msi@McCormickSys.com

Telephone: Toll Free: 1-800-444-4890
Voice: 1-480-831-8914
FAX: 1-480-820-2422 Sales/R&D
1-480-820-5243 Support

Postal Mail:  McCormick Systems Inc.
149 W. Boston St.
Chandler, Arizona 85225

Our Business Hours: Monday through Friday 6:00am to 4:00pm Arizona Time — MST (Winter), PST (Summer)
Please note: Arizona does NOT observe Daylight Savings Time.

If you are able to use the Internet from your current position, simply select one of the links above. Should you need to
update your Internet browser, here are the sites of the two most popular browsers’.

Microsoft home page: www.microsoft.com/ie * recommended

Firefox home page: www.getfirefox.com

McCormick Systems ©

192


http://www.mccormicksys.com/
mailto:msi@McCormickSys.com
http://www.microsoft.com/ie
file:///C:/Users/wolson/AppData/Local/pnordin.MCCORMICKSYS/Application%20Data/Microsoft/Word/www.getfirefox.com

